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3. Settings 

In this chapter we carry on with the preparations of design. As you have been 
introduced to display settings in the previous chapter, you are ready to learn 
about architectural settings, floor management, layer management and the 
definition of element properties. 

3.1. Architectural settings 
You can set the options necessary for architectural design in the Preferences 
Submenu within the File menu:  
 

� General: units of measurement angle and scale. 
� Construction Grid 
� Stair standard 

3.1.1. Units of measurement 
Choose File - Preferences - General panel.  
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Unit 
Specifies the measurement unit and the precision of drawing. The program 
offers the following units: mm, cm, m and inch. 
 
You can define the desired unit either by 
choosing the option or by clicking on the 
icon on the right. 
To specify precision click the pull-down 
list and choose the appropriate element: 
E.g.: choosing 0.12 means two decimal 
points of precision. 

 

Drawing-specific measurement units 
It defines the drawing-specific measurement unit and its precision. It includes 
marker properties, text properties, dimension properties and hatch dimension.  
 

���� Precision does not refer to the dimensional precision required (that can be 
set in Dimension general properties); it refers to the precision of the query. 
This is shown by the Cursor position tooltip  and by the Cursor info 
tooltip.  For further references, see Chapter 2.10.3. –Screen Properties and 
Chapter 10.1.1.3. Dimensioning - Format parameters. 

3.1.2. Angle 
You can set what angle measure to use and the direction of angles. 
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Angle 
The program offers the following angle measures: 
 

Decimal Degrees  Displays angles in decimal units (e.g.: 
30,5°) 

Deg/Min/Sec  Degrees, minutes and seconds (e.g.: 
30°30'00'') 

Grads  An engineering unit with 400 grads 
 
To choose the unit of angle click on the corresponding option or the icon on 
the right. 
 

���� The result of angle definition is not displayed when setting the dimensions 
of the element (that can be set in Dimension general properties), only when 
querying. This is shown for example by the Cursor position tooltip  and by 
the Cursor info tooltip.  For further references, see Chapter 2.10.3. –
Screen Properties and Chapter 10.1.1.3. Dimensioning - Format 
parameters. 

Direction 
You can measure angles clockwise and counter clockwise or topographically. 
Clockwise and counter clockwise directions are defined from the compass 
direction East, while topographical directions are defined counter clockwise 
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from the compass direction North. 
To specify a direction, click on Direction options or the icon on the right. 
 
Positive to left  
You can specify the direction of the X axis. By default, the X axis points to the 
right, so the program measures positive values on the right. Enable this 
option to measure positive values on the left. 

3.1.3. Scale factor 
You can assign a scale factor to the drawing. 
 
The Scale option enables you to work with a proportionally reduced drawing, 
which has all the advantages of drawing with real dimensions. With this 
command you can work with any (1: X) scale you like, while keeping the 
original dimensions of the drawing. If you change scale factor, the effect is 
displayed on line width (except True Type fonts, for which line width does not 
apply.) 
 

���� The current scale is displayed in the Drawing status line.  
It is preferable to use a scale of 1:1.The appropriate drawing scale can be 
defined at printing, e.g.: 1:100. 

3.1.4. Construction Grid 
There are numerous places in an architecture where you might want to use 
predefined grid structure to help the regular design. With this command (in 
Building - Construction Grid) you can place construction grid on drawing of 
framed buildings. 
You can define the distance of grid nodes both in X and Y directions, the 
number of vertical and horizontal lines and the value for overhanging. 
Horizontal lines are marked with letters; vertical lines are marked with 
numbers. 
Options: 
1. You can make visible the dimension lines between grid nodes in X and Y 
directions. 
2. Definition of different distances in X and Y directions (Click on the Parallel 
dist. option to open the distance input dialog)  
3. In the upcoming Horizontal and Vertical shift dialog the whole pattern can 
be duplicated by the Copy all button 
 
Later when you already placed the grid on the drawing it is possible to move 
the grid nodes separately. 
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3.1.5. Setting stair standards 
If you monitor continuously the ergonomic requirements defined by standards 
in case of stairs selected from the stair sets, it can help you in the drawing of 
stairs. You can find it in the File menu - Preferences - Stair standard dialog 
box. 
 
During the planning the program monitors continuously that part of the 
values, which represented according to the standard, the other part you can 
select optional. The program signs the exceeded limits in red colour, but it 
doesn’t forbid the creating of the stair, if it doesn’t come up to ergonomics 
requirements.  
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You can pick your Stair categories  and Rise and going  from a pull-down 
menu. Their combination defines the limits that must be met according to the 
relevant standard. 

 
 

 
 

 
 
 These are the following: 2R +G (two times riser plus going), stair width , 
Rise and Going . When drawing the stairs from the stair library, the program 
monitors the compliance with these limits; if you exceed them, it is indicated 
by red colour. 
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You can enable the monitoring of the following parameters: 
 

� headroom height above stair: it is relevant when allowing stairs through the 
ceiling slab. 

� set the walking line between 1/2 and 2/3 of the width of the stairs 
 

� Use the measurement set in the dialog window. If you switch off the option, 
the values of stair parameters will appear in cm  in the proper dialog windows.  
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3.2. Specifying properties 
Before you use any architectural element or the geometric drawing tool of the 
program, specify the properties of objects first. Use the commands in the 
Building menu, Drafting menu, and Dimension menu - Properties command 
to set the properties. You can also access these properties by right-clicking 
the icons in the Toolbox.  

Introduction 
Properties are the graphical and structural features of objects and elements. 
 
All element types have: 

� general properties, such as colour, line width, line type, layer; and 
� special properties (e.g. in the case of walls height, thickness, hatching, layer 

properties, etc.). 
 

� For a detailed description of the special properties of element types see the 
Chapter on the Detailed description of the special properties of element 
types. 
 
You can save the edited set of properties of each element type in Sets and 
store the sets in the template assigned to the project. 
 

� For detailed information on the use of the template see Chapter 4.6 on 
Managing templates. 

3.2.1. General properties 
In the Properties  dialog box you can first set the general properties of each 
element, such as colour, line width, layer, line type, and priority. 
 
You can set the colour, line type, and line width: 

� Directly , by specifying the property explicitly (e.g. the colour is red). 
 

� Indirectly , so that the element acquires its general properties from the layer 
assigned to the element. 
1. If the Layer control mode in the Modify menu is turned off , to specify the 
colour, line type, and line width you must turn on each Layer property 
separately. E.g. for colour activate the Layer option. 
 
2. If the Layer control mode in the Modify menu is turned on , among the 
fields of general properties colour, line type, and line width are greyed out and 
are non-editable. In this case the program acquires these properties from the 
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layer assigned to the element. 
 

� See Chapters 3.3.4. on Managing layers and using properties  

 Colour 
• Choose a colour from the colour palette by clicking the box of the desired 

colour. You can choose from the 256 colours of the colour palette, or any 
other colour from additional colour palettes. 

• If you do not want to change the colour, click Cancel. 
• If you want to use the colour of the layer assigned to the element, activate the 

Layer option. 

 Layer 
This specifies the current layer. By using this mode, you can assign different 
layers to each element type. You can turn layers of a drawing on and off 
when drawing. (For the sake of an unobstructed view, it is recommended that 
you store dimensions on a separate layer as it is not necessary to display it 
as you work.) 
 

• Choose the layer to be assigned to the element from the pull-down menu. 
You can select the layers in the Properties dialog box only if you have already 
created them in the Layer  dialog box. 
 

� See Chapter 3.3. on Managing  layers for a detailed description on layer 
handling. 

 Line type 
ARCHLine.XP® allows you to 
choose from predefined line types, 
or you can create your own custom 
line type. 
 

• Choose a line type from the list. 

 
 

• If you want to use the line type of the layer assigned to the element, select 
’Layer’ in the pull-down menu. 
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���� It is not possible to set the line type in the Text general properties dialog 
box. 
To set a custom line type, use the Tools menu - 2D group - Create new 
line type command. 

 Line width 
This specifies the current line width. 
The line width can be set even at a minimum of 0.01 mm , there is no upper 
limit. 
A line width of 0 defines the thinnest line of the output device (plotter, printer, 
monitor, etc.). 
 

• Enter the line width or select one of the predefined values. 
• If you want to use the line width of the layer assigned to the element, choose 

’Layer’ in the pull-down menu. 

 Priority 
This defines the priority of elements in printing. 
ARCHLine.XP® can manage 8 levels of priority (from 1 to 8). The top-most (1) 
level comes in front of all other layers in printing, while the bottom-most (8) 
level will be at the back of all other layers. 
 

• Select a priority number (1-8) from the list. 
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The hatched area has a level 5 priority, 
while the polygons representing houses 
have a level 8 priority, so the hatched area 
overlays the polygons. 
 
 

 
 
 
 
 
The hatched area has a level 8 priority; the 
polygons’ priority is higher (5), so the 
polygons are visible in the hatched area. 
 
 

3.2.2. Material properties 

 
 
For the representation of architectural drawings and for a realistic display it is 
necessary to define materials. The program applies material properties to all 
architectural elements and 3D objects. You can specify material properties in 
the Material properties dialog box. To access these properties open the 
Material dialog box first where you can handle the materials.  
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3.2.2.1. Managing materials in the Material dialog box 

 
 

You can access the Material dialog box and the Material properties dialog 
box within in several ways; you may select it from the Tools menu, or in the 
architectural elements properties dialog, 3D objects, or the Design center: 
 

� The Material dialog box appears instantly when you select Accessories - 
Material manager in the Tools menu. The dialog sh ows the previews and 
properties of the available materials. 
 

� For access via architectural elements, click the box of the material in the 
properties of the selected architectural element. 

 

 
 

� For access via 3D objects, double click the material in the Object properties  
dialog box. 
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� For access via the Design center, first choose Material in the Design center 

and select one of the available material classes. Materials then appear in the 
content window of the Design center, where by clicking one of them the 
Material properties dialog box pops up. 

3.2.2.2. Managing material classes 

You find the material classes, 
subclasses, and categories in the 
left window of the Material 
properties dialog box arranged in 
a directory format. 
 
Materials are grouped into three 
classes: 
 

� Project  
� Template 
� Program 

 
 

 

Program class 
The Program  class contains the official materials supplied by the program. 
You may create new folders (subclasses) in this directory and also new 
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categories within these folders. Once you start the program, these materials 
are always available. Official categories supplied by the program are 
displayed in grey, meaning that the material properties of these categories 
are non-editable. Obviously the properties of user-created materials placed 
here are editable. 

Project class 
The Project  class contains those materials that the user applies in a given 
project or places here. Therefore these materials vary every project. For 
example, if you render a material to an architectural element from the 
Program directory, the program automatically creates a copy of this material 
in the Project directory and will subsequently use this copy. You cannot 
create any subclasses and categories in this directory. When saving the 
project, you also save the materials of the Project class. 

Template class 
The Template  class contains those materials that the program stores 
1) as a set  of properties of various elements and 
2) when saving sets in the template . 
 
For example, if you create a new set of walls and assign its material from the 
Project or the Program class, when next saving the project this material will 
be saved as part of the project and you will be able to use it subsequently in 
the said project. If you want to use it in other projects, save the sets in the 
default template file using Save in File menu - Preferences - Template . 
 
When you start a new project the program will load the default template file 
and the Template class will contain the materials saved in the template file. 
The content of this class then is determined by the template file you currently 
use. You cannot create any subclasses and categories in this directory and 
cannot modify the materials. 
 
As a consequence of the above, when opening a project file the same 
material may have similar or different properties in the Program, the Project 
and the Template class, moreover also in any subclasses or categories of the 
Program class. 

3.2.2.3. Managing materials 

On the right side of the Material properties dialog you find those materials 
that belong to the material class or category you select on the left side. You 
can copy or move these materials from one class or category to another by 
dragging and dropping. Copying and moving are in conformity with Windows 
standards, meaning that in addition to the mouse you can use the Ctrl and 
Shift buttons in selecting and moving. Materials are displayed in different 
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ways depending on which button is active of the three views at the bottom of 
the dialog box: 

� When you click , materials are listed by their names.  

� When you click , materials are listed by their names and their texture 
images.  

� When you click , materials are listed by their names and the rendered 
(photorealistic) pictures.  
 
You find additional commands at the bottom of the dialog box: 
 

 

New category 
You can create a new material category with the New category…  command 
button. The command is active only in the Program class. 

New folder 
You can create a new material folder with the New folder…  command button. 
The command is active only in the Program class. 

Delete 
With the Delete command you can delete the selected materials, categories 
and classes. The command is not active in the Template class and in those 
categories of the Program class that are displayed in grey. 

New material 
You can create a new material in the Material properties dialog box with the 
New material  command button (the command is not active in the Template 
class and in those categories of the Program class that are displayed in 
grey).  
You can create new material with texture or with colour. 
 
To create new materials with texture do as follows: 
 

• Enter the name of the material to be created in the New name box (basically 
it is New material indicated in the box). 

• Assign a texture to the material. You can do so by clicking the grey box and 
selecting the desired .bmp or .jpg file in the Open picture dialog box then 
displayed. 
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To create new materials with colour do as follows: 
 

• Enter the name of the material to be created in the New name box (basically 
it is New material indicated in the box). 

• Switch off the Use texture file box. 
 

 
 
Click on the Replacement colour button to assign a colour to the material for 
the shaded visualization. 
 

• Close the dialog box by clicking Ok. 

Modify 
You can modify the properties of a selected material with the Modify… button 
(see description of the Material properties  dialog box). The command button 
is not active in the Template  class and in those categories of the Program 
class that are displayed in grey. 
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Copy 
You can copy an existing material with the Copy  command. Here you only 
have to specify the name of the material. The new copy will be placed to its 
own category or the project class, depending on whether the material to be 
copied is editable or not. Instead of using the command button, you can 
create copies by dragging and dropping. When you copy from one category 
to another, the program will ask you to confirm copying. 

3.2.2.4. Import / Export materials 

Import from other user 

���� If you wish to import materials created in ARCHLine.XP format from other 
users you should copy the description file (e.g. ceramic.mtr) and the 
associated folder (e.g. ceramic.tex) contain the textures to the current 
Materials folder. 

Import 
In the Material properties dialog you can load materials from the same or 
the previous program versions with the Import command button.  
 
Before importing, the program sends a warning that the imported materials 
will be displayed only until the material manager dialog box is open. Click Ok. 
Now the program imports the materials corresponding to the material file to a 
fourth class, the temporarily displayed Import  class. You may move or copy 
imported materials by dragging and dropping or using the Copy command 
button until you close the dialog box. 

Export 
You can export materials of the selected material category by using the 
Export command button. You may only export one category at a time. As a 
result of exporting, a directory containing ARCHLine.XP® type material file 
(.mtr) and the associated texture files (.bmp or .jpg picture files) is created. 
With the Export  function it is possible to transfer material categories from 
one computer to another or from one program version to another. To do so, 
follow the steps below: 
 

• Choose the material category you wish to export. You may only select one 
category at a time. 

• Click Export. 

Close and Select 
With the Close and Select buttons you can close the dialog box. The Select 
button appears only if you access the Material dialog box via the architectural 
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elements or objects, since the selected material is assigned to the 
architectural elements or objects with this command button. 

3.2.2.5. Creating materials in the Design center by  dragging 

The structure presented in the Material dialog box can be also displayed in 
the Design center. You can see the arrangement structure of materials 
(classes, subclasses, categories) in the Tree window of the Design center, 
whereas the textures that can be displayed in three different views appear in 
the Content window. The illustration below shows the Content window of the 
Design center: 
 

 
 
Once you created a category in the Material  dialog box, you may ’drag’ 
several texture images (.bmp or .jpg) in one step to the selected category with 
the drag and drop method. Do as follows: 
 

• Set the window of the Design center in such a way that the category in which 
you wish to place the new textures can be seen. For example: MyWood 

• Select the textures in the window of Windows explorer. 
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• Drag and drop the 
selected files to the 
category. Depending on 
the number and size of the 
selected files and the data 
transfer rate, the time of 
file transfer may vary. 

• After dragging the Material 
properties dialog box 
appears, where except for 
the texture, you may 
assign similar properties 
to the materials thus 
created. (It is advisable 
that you create materials 
that have the same 
properties at a time.) In 
the dialog box the texture 
image box is now empty. 

 

3.2.2.6. The Material properties dialog box 

Choose a material in the Tools menu – Accessories - Material manager  
dialog box, then click Modify or Copy. The Material properties dialog box 
then appears. 
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General 
For a photorealistic image it is necessary to define the texture. In 
ARCHLine.XP® in the general properties you can specify with what texture, 
colour, and physical features the program shall display the material. These 
will play an important role in rendering. 

Material colour 
You can see the current texture in the left box. If you do not want to assign a 
texture, click the No texture button. In the photorealistic view colour will be 
displayed instead of texture, which you may set by clicking the colour icon 
next to the texture image. 
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If you clicked the No texture  button and lost the formerly assigned texture, 
you can recover it by clicking again. 

Colour icon 
This setting has two functions: 

� As referred to above, this colour will be displayed in the photorealistic view 
when there is no texture. 

� The 3D view toolbar - Shade with material colour command uses this colour 
in the vector graphics drawing. 

� For a description of colour settings see Chapter 3.2.2.7. on RGB colour 
management. 

Material texture 
If you wish to assign a different texture, click the box displaying the texture 
and select the desired texture by opening the corresponding .bmp or .jpg file 
in the Open picture dialog box. The name of the material will automatically 
be that of the name of the opened file without the file name extension. 
 
Below the texture image you can set the size  that is the horizontal and 
vertical size, and the direction . Depending on the status of the button next to 
the horizontal and vertical size entry fields, you may maintain aspect ratio: 
 
 

 

This state of the button indicates that horizontal and vertical sizes can 
be specified separately. 

 

 

This state of the button indicates to keep relative horizontal and 
vertical sizes. Most of cases it is important to maintain the aspect 
ratio to avoid stretching the graphic out of proportion. 

 Stretch material 
It is possible to create material without horizontal and vertical sizes. In that 
case the texture is stretched to fill the destination area. 
Select the Stretch option from the list. The size fields will be grey. 
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Physical features 
You can choose the rendering mode in a pull-down menu. Depending on the 
rendering mode you select, you can set different physical features that affect 
rendering. The physical features you can specify and their definitions are the 
following: 
 

Transparency 

Determines the extent of the transparency of the 
material. 

Bump altitude 

Bump Mapping simulates the impression of a detailed 
3D surface with shading as if the surface had lots of 
small angles, rather than being completely flat. The 
height of the bumps can be adjusted using the 
Amplitude control. 

Bump softness 

This control is use to set the amount of blur that is 
applied to the 'bump map' image. 

Ambient factor 

Shows how the material reacts to ambient light. 

Diffuse factor Shows how the material reacts to diffuse light. Lights, 
Sun, camera light. 

Specular factor The specular factor controls the reflection of light 
from a "shiny" object 

Exponent Determines the sharpness of the distribution. 
Roughness Light is more radiant on a smooth surface. If 

roughness is set to a low level, radiance is 
concentrated on a small surface; if it is set high, 
radiance is distributed on the surface. 

Specular colour You can specify the specular colour in the colour 
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palette. 
Transmission 
factor 

Has the same effect as transparency in the case of 
glass. 

Mirror factor Shows how the material reflects light from the 
surrounding objects. 

Refraction This setting concerns the physical characteristics of 
glass. 

 
The rendering modes you can set are the following: 

Matte 
This reflection model ensures a dull and dim appearance. The extent of 
reflection from objects is determined by the ambient factor and the diffuse 
factor together. This model is suitable for displaying dull materials such as 
brick or textile. 

Metal 
This reflection model ensures a metallic appearance. The extent of reflection 
from objects is determined by the ambient factor and the specular factor 
together. The distribution of radiance is determined by roughness. At a low 
level of roughness the reflection of shine is sharper, and it affects a smaller 
area of the object. This model is suitable for displaying most metallic 
materials such as steel or copper. 

Phong 
This reflection model corresponds to the well-known Phong model, where 
reflection is highest in the direction opposite to the viewpoint direction. The 
extent of reflection is determined by the ambient factor, the diffuse factor, and 
the specular factor together. The sharpness of the shiny surface is 
determined by the level of the specular factor. If this level is low, transition 
from the shiny surface is smoother, but radiance is concentrated in a smaller 
area. The colour of the shiny surface can be determined by setting the 
specular colour. This model is suitable for displaying glittering or delicately 
polished materials such as ceramic or glass. 

Plastic 
This reflection model has the same shiny effect as the Phong model. The 
extent of reflection is determined by the ambient factor, the diffuse factor, and 
the specular factor together. The sharpness of the shiny surface is 
determined by roughness. At a low level of roughness the reflection of shine 
is higher and affects a smaller area of the object. The colour of the shiny 
surface can be determined by setting the specular colour. This model is 
suitable for displaying glittering or delicately polished materials such as 
plastic or varnished surface. 

Glass 
This reflection model is suitable for displaying glass-like materials that are 
characterized by both reflectivity and transparency. Secondary reflection and 
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light transmission is displayed by ray tracing. The extent of reflection is 
determined by the specular factor, the transmission factor, and additional 
lights defined by the mirror factor together. The distribution of radiance is 
determined by roughness. At a low level of roughness the reflection of shine 
is sharper, and it affects a smaller area of the object. The program applies the 
same refraction factor to lights of all wavelengths. The default value equals 
the value in the case of glass. This model best imitates glass surface. 

Mirror 
This reflection model realizes secondary reflection by means of ray tracing. 
The extent of reflection is determined by the ambient factor, the diffuse factor, 
the specular factor, and additional lights defined by the mirror factor together. 
The distribution of radiance is determined by roughness. At a low level of 
roughness the reflection of shine is sharper, and it affects a smaller area of 
the object. This model best imitates glass surface. 

Tips:  
� If you want to use specular tile lining, use the Mirror mode. 
� Use the Glass mode in the case of lamp globes: here you have to set 

transparency to a low level whereas the transmission factor should be high. 
� If the transparency level is not zero, the object in question will cast no 

shadow. If you want a glass surface to cast shadow, e.g. a lamp globe, you 
have to set transparency to zero (that is you must bring the slide to the left). 

Hatches 
A material has 2 different hatches, depending how the material is displayed. 
 
For example in the case of a brick material: 

� You have to specify the hatch on section. In the case of a brick wall we use 
45-degree lines on the section. 
 

� If this brick can be used for outer walls, hatching is also important in the 3D 
view. 
 
In the case of a brick wall, we use the standard hatch on the floor plan that is 
45-degree lines. This hatch is not the property of the material, but that of the 
wall; therefore you have to specify it in the Wall properties dialog. 
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Hatch in 3D 
When setting material properties you must also specify 3D hatching, which 
enables you to display textures in the 3D model. For this option you must 
activate the Display button. The hatch you specify here appears in the 3D 
model when you activate the Material pattern and background colour in the 

3D view toolbar -  Shadowing and shading command. 
If the Display option is deactivated, the material appears with the assigned 
colour. 

Hatch on section 
Here you can specify what hatch you would like to represent the material on 
the section. To use this option, you must activate the Display button. 
This hatch appears only on the architectural section and on the condition that 
the File menu - Preferences - General - 3D Preferences - 3D Objects- 
Section plane created with hatch  is activated. You can switch on the option 
in the Section properties dialog window too. 
To activate hatch on section, use the hidden line mode. 
 
You can specify texture pattern colour and the texture background colour at 
the bottom of layer settings. 
When the Display is on, you can select the hatch pattern of the element and 
set its properties: horizontal and vertical density of the pattern and line 
direction defined in degree. 
 

• Click the pattern icon if you want to display and select hatch pattern types. 
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You can choose from various pattern types in the dialog box by clicking either 
the pattern name or the pattern image. You can move hatch patterns to new 
categories; this way you can arrange patterns in a structure that best suits 
you. 

Copying hatch settings 

 

When clicking this button you have the option to copy hatch settings. You 
can copy the settings of Hatch on section to Hatch in 3D, and conversely. 
 

3.2.2.7. RGB colour management 

Colour is among the properties of each ARCHLine.XP element. Elements are 
represented with their colours on the screen or on the printed documents. 
Besides the colour properties of elements, colours have important role at 
materials when you represent materials with colours. In both cases the 
program uses RGB colours. 
 
Displaying various colours is not only important in presenting a photorealistic 
image of wall paints and facades, but also in the case of a coloured 3D view. 
The option of RGB colour use therefore is significant as it enables you to 
illustrate or print vector graphics drawings of various facades in true colours 
that are in realistic Ral, Sikkens or Pantone colours. 
 
Colour settings thus have two functions: 
 

� Click No texture in the Material properties dialog box to define the colour for 
the material. Now instead of the texture the colour appears in the 
photorealistic view, which you can set by clicking the colour icon next to the 
texture image. 

� The 3D view toolbar -   Shadowing and shading command uses this 
colour on the vector graphics drawing regardless of whether you defined the 
colour or texture for the material. 
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In the following example we use wall paint texture in the photorealistic view 
and yellow on the vector graphics drawing. 
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As we mentioned before, by clicking off the Use texture file button the given 
element will be displayed in the selected colour both in the coloured 3D view 
and on the photorealistic picture: 
 

 

Standard handling of colour tables 
 
Colours can be chosen from different colour tables. The handling of these 
colours became standard in ARCHLine.XP. 
 



  3 Settings 149 

 ARCHLine.XP ® 

Click on the colour icon in the 
properties dialog of any element (e.g. 
line) to access the Colour tables: 
 
The browser of the appearing Colour 
table dialog shows the name of the 
selected colour table. 

 
 

• Select the appropriate colour table. 

ARCHLine.XP ® colour table 
The ARCHLine.XP colour table appears with 256 primary colours, from which 
you can choose a colour. In the name field only names of the first 16 colours 
appear. You cannot specify names for other colours. 
 

 

AutoCAD ® Colour table 
The AutoCAD® colour table appears with 256 primary colours, from which you 
can choose a colour. You cannot specify names here. 
If you import a drawing created in AutoCAD, the drawing elements will keep 
their AutoCAD colour table settings. Here you can modify the colour of an 
element. 
If all the drawing elements have colours from AutoCAD® colour table, you 
don’t need to convert colours at file export. The exported drawing will appear 
with the same colours in AutoCAD®. 
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Custom colour table 
The standard Windows colour spectrum appears here. After selecting a 
colour you can specify its shading with a sliding arrow. 
In the name field you can specify a colour name. 
 

 

Ral, Sikkens, Panton colour tables 
Use the horizontal sliding arrow or the vertical sliding bar to browse for the 
appropriate colour group. Select the desired colour by clicking on it. The 
name of the colour appears in the Name field. 
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New material with colour 
If you create a new material by a Ral, Sikkens or Panton colour, the name of 
the colour will automatically specify the name of the material, too. You can 
modify this material name as well. 
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���� Dye producers on the market use to specify colours in RAL table. 

 

Reference  
After selecting a new colour from a colour 
table, the selected new colour is displayed 
below the old colour.  

 
 

Components 
The RGB code and the Hue, Luminosity, 
and Saturation values appear here. 

 

 

Layer 
Click the Layer button if you want to specify the colour of an element by a 
colour of a layer. The element picks up the colour property of the layer where 
the element belongs to. The colour property of the element follows the 
changes made later on the colour of its layer. 

No 
The No colour button becomes active only in the case when you wish to 
specify the background colour of a hatch. Clicking this button the hatch can 
be specified without background colour. 

New colour tables 
Different CAD applications can use numerous colour tables. Some of these 
colour tables are downloadable from the web. 
 
In ARCHLine.XP it is possible to load colour tables that follow the format of 
Adobe or AutoCAD® ColourBook. 
These files can have .acb extension in binary (Adobe) or XML (AutoCAD) file 
format. 
 

!!!! It is not possible to load protected colour tables! 
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• Copy or move the downloaded colour table in the …\Support\Colours 
subdirectory inside your program installation directory: 
 

 
 

• Restart ARCHLine.XP. 
• Open the Colour tables dialog. The program automatically loads the inserted 

colour tables. 
 

  

Query the colour of an element 
Any colour you have specified can be queried later on. 
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After you have specified a colour to an element, open the properties dialog of 
the element and click the colour button.  
The Colour table dialog appears with the appropriate colour table, showing 
the previously specified colour selected in that colour table. 
 
Under Components you can read the RGB codes and the Hue, Luminosity, 
and Saturation values. 
 
Here you can modify the colour, of course. 

3.2.3. Using sets of properties 
You can save a range of properties specified for element types in sets. 
In the course of the architectural design you need several often-used 
elements (generally used layered walls, slabs, etc.). Sets serve their 
development. 
You may save the properties set for an element under a given name and use 
these sets of properties anytime subsequently, thus accelerating and 
facilitating the work process. 
 
ARCHLine.XP® is capable of managing an infinite number of sets. When you 
start the program elements are displayed with their basic properties as set in 
the default template. The program contains predefined wall and slab sets. 
These are industrially default sets, represented with grey icon.  
The sets created by the user, represented with yellow icon.  
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Select an element type from the properties dialog box (e.g. wall) and click the 

set button displaying the current set name:  
 

���� When no set is loaded, the word  is displayed. 

 
A new dialog box appears on the right where the program lists predefined 
sets. 
You can do the following operations with sets: 
 

� Create set 
� Activate set 
� Modify, delete, rename set 
� Export 

 
� Activate set and create new element with the active set 
� Copy properties with set 

3.2.3.1. Create new set, new folder 

Once you have specified all properties of a given element in the Properties 
dialog box: 

• Click the  button. 
• Click New, and 
• Enter the name of the new set. 

 

 
 

!  The created set is just saved to the project file, and just when, if the element 
created by the set occurs in the draw. 

Creating new folder 
You can group the sets to folders. Use the New folder button for this.  
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!  We suggest grouping the new sets to folders!  

3.2.3.2. Export sets 

The created set is just saved to the project file, and just when, if the element 
created by the set occurs in the draw. During the planning is needed that you 
can use the created sets in other projects. For this you have to save the set to 
the Template file. You can make this: 
 

� with set export, then import to the template file, or  
� save directly to the template file. 

 
The main difference between the two methods is that just the selected sets 
are saved in the first case, which later can be given to the actual template file. 
In the second case every set and preferences are saved to the template file.  

Export 
After created the new sets quit from the dialog window with OK. When you 
open the Properties window again you can export the selected sets 
separately to the given .set extended set file.  
In that case, if you grouped the new sets to a given folder, it’s enough to 
select the folder, and click to the Export button. Then the whole contain of the 
folder is saved. 
 
Determine the name and access path of the set file in the appearing dialog 
window.  
 
You can add the saved set file to the actual template file with the File menu - 
Preferences - Template management - Import command . 

Save template file 
You can also save set, if you save in one step all the sets and preferences to 
the template file.  
 
To do so, use the Save option in the File menu - Preferences - Template 
management  dialog box. This command saves all sets and all draw settings 
in the project to the default template file. After saving you may use the saved 
sets and settings in a new project. 
 

� See Chapter 4.6. on Template file for further details. 
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3.2.3.3. Activate set 

You need to activate a set if when defining basic settings you do not wish to 
specify the properties of each element one by one, but in sets. You may also 
modify element properties by activating the corresponding set. 
 
You can activate a set In the Properties  dialog box 

Properties dialog box 
• Open the Properties  dialog box 
• Click Set to display the list of sets, then 
• Select the desired set from the list and click Activate 

or 
• Double click the set name 

OK Close the dialog box. 
 

���� You may use this method in setting properties or modifying elements as you 
work. 

3.2.3.4. Modify, rename, delete set 

You can modify the properties of the current set, and rename or delete the 
set. 

Modify properties 

• Open the Properties  dialog box and click Set. 
• Activate the set you wish to modify. 
• Change the properties you want to modify, then 
• Click Modify. 
• In the message box then displayed, click Yes to overwrite the selected set. 

Rename set 

• Open the Properties  dialog box and click Set. 
• Choose the desired sets from the list. 
• Click Rename. 
• Enter the new name of the set. 

OK Close the dialog box. 

Delete set 

• Open the Properties  dialog box and click Set. 
• Choose the desired sets from the list. 
• Click Delete. 
• In the message box thus displayed click Yes to delete the selected set. 
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3.2.4. Assigning cost variables 
You can freely assign data to all ARCHLine.XP® element types. By this 
method you can simply create your own ‘database’: 
 

� You can enter the required data, or 
� You can export data from the Excel  database. 

Budget calculation using the Excel spread sheet 
This function provides support for the calculation of the budget of certain 
building projects or other calculations. Essentially, in the case of floor plan 
elements you can assign the cost, unit, and factor to parameters such as 
area or volume, whereby you can obtain a combined costing spread sheet in 
Excel format. 
 
Suppose you want to calculate the material cost of wall building and you 
know the volume. In this simplified example a wall section has the following 
parameters: 
 

 
 
In an Excel spread sheet where you have an itemized list of all costs, it is 
easy to assign these data to ARCHLine.XP® elements. In the present 
example one line of the spread sheet indicates the material cost of the wall: 
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You have two options to start assigning: 
 

� In the Properties dialog box  and 
� In the Excel spread sheet by dragging 

I. Properties dialog box 
Double click the selected element (e.g. wall) on the floor plan. The 
Properties dialog box then appears. 
 

 
 
• Click the Cost variable  button. The Cost Parameters dialog box pops up. 
• Open the Excel spread sheet. 
• Select the desired line. 
• By clicking the lower edge of the line, move the cells to the dialog box with 

the drag and drop method. Now the values are entered in the cells. 
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II. From the Excel  spread sheet by dragging 

 
 
• Select the desired line in the Excel spread sheet. 
• Having selected the line click the lower edge of the line and move it to the 

wall in the drawing with the drag and drop method. Now the Import cell dialog 
box appears and the values are entered in the cells. 
 

• When two or more elements overlap and therefore selection by dragging is 
ambiguous, select the element to which you actually wish to assign the 
imported data in the dialog box displayed. Click Next. 
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From this point on the two methods are similar: 
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Here you have to assign the cell values to the variables. At first variables 
might not be assigned to the cells you want them to be associated with, as in 
the line of the Excel spread sheet the order of variables may be different. 
In this case, with the Field associations  button you can specify for each 
variable from which cell the program should load its value. In our example the 
program obtained the code from the first cell, description from the second 
cell, and value from the fourth cell. 
 
The fields are editable after loading, so for example for unit you can specify 
the volume: 
 

 

Unit 
You can specify any text for the 
unit, e.g. m3, or you can choose a 
code from the list. The Excel list will 
use this code for calculating the 
budget. 

 

 

Factor 
It only makes sense to set factors in the case of walls, slabs, roof surfaces 
and roof edge where the factor specifies the layer. Factors should be round 
numbers. 
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If you do not wish to assign the value of variables from the Excel spread 

sheet, you can enter them by inserting a new line    
 
You can also indicate several variables (line) to an element.  

 

You can delete unnecessary lines with the  button. 
 

As from now on the wall has these attributes: 
 

 
 
Similarly to the above, you can assign variables to other floor plan elements. 
By copying properties you also have the option to transfer only those 
variables of an element to another that have been assigned. 

Listing 
When you finish a plan, you can view the budget data in a separate Excel 
spread sheet. You can access this list with the Add-On – Quantity Take-Off - 
Cost estimation - Building  command. 
 
You can define for which floor plan elements you wish the program to list 
calculations: 
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The result of the list in this simplified example where we also added another 
wall: 
 

  
 

3.2.5. Cost estimation – assigning cost parameters 
With the Add-on menu – Quantity take-off – Assign cost parameter command 
it is possible to assign cost parameters to architecture elements on the floor-
plan indirectly. Indirect cost parameters are connected to the elements only 
as references, opposed to the directly assigned and stored cost parameters 
in the element properties dialog. 
 
The advantage of indirect cost parameters is the possibility of adding those in 
a large amount to a complete floor-plan without any further work on the 
drawing. 
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By clicking the Add database entry  button, the following data can be 
assigned to the selected item in the appearing dialog:  

� Code 
� Internal name  (this parameter is the reference to the selected 

item; for example the name of the elements in case of object, door, 
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window or group, or the set name of the elements in case of wall, 
slab or stair, or the name of the layer if there is no set) 

� Description  
� Material (repr) 
� Price 
� Unit: pcs, m, m2, m3 

 

 
 
With the commands (e.g. Object ) under Add-on menu – Quantity take-off – 
Cost estimation the assigned cost parameters can be represented in the 
created RTF files. 

3.2.6. Cost estimation – placing cost parameters 
With the Add-on menu – Quantity take-off – Place cost parameter command 
it is possible to place the description and code fields from the assigned cost 
parameters on the drawing. 
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3.3. Managing layers 

Getting started 
Layers are a method of managing the visual layout of a drawing. The program 
makes it possible to apply several layers at a time. With the use of layers you 
can group or separate the elements of the current project according to 
various aspects. 
The program sets the Layer 0 layer as default, but you have the possibility to 
create additional layers. On the whole the program is able to manage 1024 
layers (indexed from 0 to 1023). 
 
In ARCHLine.XP® layers have the following properties: 
 

� Visibility: on and off status 
� Background:  unlock and lock 
� Colour  
� Line type  
� Line width  

 
Layers can be turned on and off, and can be unlocked and locked. With the 
help of these commands you can easily group the elements of the different 
layers. 
 
3D views and the floor plan share a single layer structure: 
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If you create, rename or delete a layer in the default 2D window, you can view 
the changes in the 3D window, and vice versa. 
 
When specifying the general properties of element types, you can define on 
which layer you wish to place the elements of an element type. 
You can place objects with different properties (different colour, line type, line 
width, even different type, etc.) on the same layer, which due to other 
aspects, you want to handle together. 
 
If you activate  the Layer control mode in the Modify menu, when creating 
new elements the program can automatically assign the colour, line type, and 
line width of the layer on which you place the element to the general 
properties of the element. 

3.3.1. Working with layers from the dialog 

• Click the  Layer  button in the Layer bar. 
In doing so, you activate the Layer management  dialog box where you can 
specify layer properties. 
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!!!! We suggest that you use a layer distribution and assign the elements to 
different layers. In this case you can group elements on the basis of layers. 
You can turn certain layers of, or use them as background. 
 
In the following we describe the use of the Layer dialog box in details: 

Add layers 

• To create additional layers, click the  button. 
 

 
 

You can modify the properties of the new layer subsequently. 

� The pipe in front of the name of layer signs the active layer:  
See: 3.3.3. Activate layers chapter. 
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Name layers 
The program automatically names layers you create 
Layer1, Layer2, etc. 
 

• Double click Name, and enter the desired name of 
the layer. 

• Repeat the command in the case of other layers. 
 

 
When clicking Name you can arrange the names in ascending or descending 
order. 
 

���� The program maintains layer names even when you use the copy/paste 
command between different drawings. 
The name of the layer can contain maximum 48 characters; in case of 
longer name the program cuts the remaining characters.  

Delete layers 
To delete a layer: 
 

• Click the layer you wish to delete. 

• Click the  button. 
 

 !  You cannot delete the active layer! 

Filter layer list 
With the layer filter you can list: 
 

� All layers, or only 
� Used layers that are layers that contain elements. 
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Note: 

  
If you create a project in version 2011, the first 2D window becomes 
“default” ; this caption appears in the header of the window.  
 

IMPORTANT:  The new layer management is available only with projects 
created  in version 2011. 

3.3.2. Layer groups 
There is a possibility to arrange layers to groups and handle together the 
layers belonging to the same group.  
 

 

Click on the  Layer settings button in the status line. Then you activate 
the Layer Properties Management dialog window. You can find on the right 
side of the dialog panel the layer groups buttons and settings possibilities. 

Creating layer groups 
Click on the Create group button, then a new group is instituted with a default 
name. If you click with right mouse button on the name and select the 
Rename menu, you can give a unique name to the group. 



172 3.3 Managing layers 

Manual 

Add layers to a group 
Select one or more layers, then hold down the left mouse button draw them 
above a layer group, and then release the mouse button. Behind the name of 
the layer group the number of layers that are in the same group appears 
between brackets. 

Display Layer groups  
Select a layer group from the list of All layers, then on the left side of the 
dialog window only the layers belonging to the selected group appear. You 
can qualify the appearing list if you switch on the Show used layers button.  
The list of layers group contains two built in layer groups: if you select the All 
layers group, all the layers  of the given window appear, if you select the 
Used layers group then that layers will be visible from the all layers, which 
contain elements unrelated to  the position of Show used layers button.  

Transactions with Layer groups 

 
 
If you click with right mouse button on the name of a layer group, with help of 
the appearing shortcut menu you can modify the preferences of all layers at 
once: you can represent (On), or hide (Off), lock or unlock all layers in the 
given group at once. 

Delete from group 
Select a layer group from the list of Layer groups, then on the left side of the 
dialog window only the layers belonging to the same group appear. Select 
one or more layers then click on the Delete from group button. 
The given layers are deleted only from the layer group, and they are available 
if you select the All layers group. 
If you select layers from All layers and Used layers group, instead of Delete 
from group button you find the Delete button, which deletes the layers 
definitely. 
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Delete layers group 
Select a layer group then click on the Delete  button on the upper right corner 
of the dialog window. Then only the layer group will be deleted, the layers in it 
are available further if you select the All layers  group.   
 

���� The layers groups have to be determined according to windows similarly to 
the layers.  

Example: 
In the following example it is a really great help using the layers group:  

Start a new project. 
Load in a DWG file, which contains more than 30 layers. 
Create a new layer group: DWG layers. 
Click on the right side on the Used layers group. Then on the left side only the 

layers imported from DWG drawing and the used layers can be found. 
Move all layers from here to the DWG layers group. 
Start design. 
If the imported elements from DWG drawing are not needed, you can switch off 

or lock them in one step. 
 

 

3.3.3. Activate layers 
Always has to be an activate layer on the plan. The active layer is always 
turned on and unlocked, with the pipe displayed in front of its name: 

 
 
You can activate the layers:   
 

� automatically  
� in the Layer Properties Management 
� in the Layer list box 

 
The program always places the elements on the current layer. 
The method is different according to the Modify menu- Layer control mode 
turn on/off status: 

Layer control mode turned off: 
The program activates automatically the layer assigned to the element in the 
element properties window. It places the new element on this layer. Except if 
you activate a layer during the command, for example: creating line, from the 
Layer list box. 
Then the program set the elements on this layer till you close the command.  
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Layer control mode turned on: 

The program set the elements, that layer, which is activated in the Layer 
Properties Management dialog window or in Layer list box. In this case the 
program disregards the layer assigned to the element type.  

Activate in the Layer Properties Management: 
• To activate the layer click the selected layer then the 

 button. 

Activate in Layer list box: 
In the Status next to the Layer settings button you can find a list box, in which 
there are the layers with them actual status. The selected layer become 
active, this appears on the main line of the list box.  
 

 
 

���� The automatic activate, the Layer Properties Management and the Layer list 
box are synchronized to each other.  

3.3.4. Layer properties 
In ARCHLine.XP® layers have the following properties: 
 

� Visibility:  on and off status 
� Background:  unlock and lock 
� Colour  
� Line type  
� Line width  

 Layers on and off (Visibility) 
By turning layers on and off you can select the layers the elements of which 

you display in the drawing windows. The elements of turned-on layers  are 
visible and you can make reference to them. 
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Any time you can turn the layers on which have been turned off, then they 
become visible again. 
 

• To turn layers on and off click the desired layer in the list, then 
• Click the icon indicating the status of the layer next to Name field. 

 

���� You can turn off layers easily by using the Layer off command in the 
shortcut menu of the drawing elements. Only the inactive layers can be 
turned off. 

 Locking and unlocking layers (Background) 
By locking and unlocking layers you can define which layers shall be editable 
and selectable. You can lock layers containing elements that are not to be 
edited in a given planning process, these layers become background layers. 
The elements of locked layers are visible, you can make reference to them, 
but you cannot select or edit them. 
 

• To unlock or lock a layer click the desired layer in the list, then 
• Click the icon indicating the status of the layer next to Name field. 

 
You can change the status of several layers at a time: 

• With the Ctrl or Shift buttons select the desired layers from the list. 
• Click the appropriate button in the list. 

 

 
 

 !  The active layer is always turned on and unlocked. 

 

 When the layer is turned on and unlocked: 
� its elements are visible  
� you can make reference to its elements 
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� its elements are editable and selectable  
 

 When the layer is turned on and locked: 
� its elements are visible  
� you can make reference to its elements, but 
� its elements are not  editable or selectable  

 

 When the layer is turned off: 
� its elements are not  visible, therefore 
� consequently you cannot  make  reference to its elements, and 
� its elements are not  editable or selectable  

Colour 

• Click the  button next to the layer you wish to modify, and then select 
the colour of the elements on the layer from the colour palette. 

Line type 

• Click the  command next to the layer you 
wish to modify, then 

• Click the arrow next to the line type. 
• Select the line type of the elements on the layer in the pull-down menu. 

Line width 

• Click the  command next to the layer you wish to modify, then 
• Type in the desired line width, or 
• Click the arrow next to the line width and 
• Select the line width of the elements on the layer in the pull-down menu. 

 

���� See Chapter 3.3.4.on Managing layers and using properties for the use of 
layer colour, line type, and line width properties. 

3.3.5. Layer control mode 
In the ARCHLine.XP® program the Modify menu - Layer control mode 
option is turned off as default.   
When setting the general properties of element types you must specify to 
which layer you want to assign the elements of the element type in question. 
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You can place elements with different properties (different colour, line type, 
line width, even different type, etc.) on the same layer, which due to other 
aspects, you want to handle together. 
 
For example: 
When you select Layer1 in the Wall properties dialog box, it means that the 
program will place all walls created after setting with the given properties on 
Layer1. By turning a layer on or off or locking it, you can display, turn off, or 
use as background these walls together, where in the latter case you can only 
make reference to them but they are non-editable. 
 

Let’s see detailed, what’s the different between the turned on/off  option of the Layer 
control mode :  

Layer control mode - turned off 
Let’s have the Layer control mode in the Modify menu turned off : 
 

� The program set the elements to the element type assigned layer in the 
Properties dialog window. Except if during the creating command activate 
another layer from the State - Layer list box.  

� When setting the general properties of the element you can specify the 
colour, line type, and line width directly by defining the property (e.g. the 
colour is red). 

� You can specify these properties indirectly in such a way, that the element 
acquires its properties from the layer assigned to the element. In this case for 
colour, line type, and line width you must set each Layer property separately 
in the Properties dialog box. E.g. for colour activate the Layer option. 
 

 
 
Modify object properties: 
You can modify the properties of elements already existing on a layer 
similarly to the method described above. In the Modify object properties 
dialog box you can assign colour, line type, and line width separately to the 
layer or if these are already assigned, you can change them by directly 
specifying the properties. 
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Layer control mode - turned on 
Let’s have the Layer control mode in the Modify menu turned on : 
 
In case of Layer control mode:  
 

� the program set the new elements to the active layer and not to the element 
type assigned layer  

� the elements to be placed on the layer automatically acquire the layer 
properties  

 

���� To choose fast the active layers use the Status - Layer list box.   

 
So when the Layer control mode is activated, the colour, line type, and line 
width of the element will be ‛layer type’. 
 

• Click Layer in the Status bar and specify the required layers in the Layer 
management dialog box then displayed, and assign the different colour, line 
type, and line width properties to the layers. 
 

 
 

• Be the Layer2 the active layer. 
 
Since the elements placed on a layer acquire these properties from the layer, 
the program ignores the general properties set in the Properties dialog box. 
While the Layer control mode is active, you cannot set the general properties 
upon the global specification of element properties, these fields included the 
layer field are greyed out: 
 
In the following example you see the Line general properties dialog box. 
 



  3 Settings 179 

 ARCHLine.XP ® 

 
 
By double clicking the element (line) used with these properties, you can see 
in the Modify properties dialog box in that the properties of the elements are 
defined by the active layer (Layer 2) and the element is set to this layer. The 
colour, line type, and line width of the element are also ‛layer marked’. 
 

 
 
Modify properties 
When modifying the properties assigned to the layer, the elements in the 
drawing which belong to the given layer and whose properties are layer 
associated, will automatically be updated. 
 
You can also modify layer associated properties subsequently:  
If, for example, the program constructs each element of Layer1 with green 
lines, but you subsequently change the line colour of one element to blue, the 
element in question, although it is placed on a green-line layer, will be blue in 
accordance with the modification. 
 

!  The difference between the on and off status of the layer control mode is 
that if turned on, the program set the new elements to the active layer and 
not to the element type assigned layer and the elements to be placed on 
the layer automatically acquire the layer properties (colour, line type, line 
width) at once. At the same time you can assign layer properties even if the 
layer control mode is off, but only one at a time.  
There is no difference between the on and off status when modifying 
element properties. 



180 3.3 Managing layers 

Manual 

Example 1:  
• Make the Layer control mode turned on. 
• In the Layer management dialog box assign to the Dimension layer the colour 

green and a line width of 0.15. Make the layer active.  
 

 
 
• Draw a line and specify its size. 

 

 
 
You see that the dimension has acquired the properties assigned to the layer. 
Let’s see it in the Dimension general properties dialog box: 
 

• Double click dimension. 
 

 
 
The word Layer appears in the colour box in the general properties. 

• Click colour. Next to the colour palette then displayed, the  
option is activated indicating that the dimension has acquired the colour 
assigned to the layer. 
Next to the colour you see that line width is also assigned to the layer. 

• By clicking and modifying the colour box, the colour properties of the element 
are not layer associated anymore. 
 

 

3.3.6. Modify layer 
You can move certain elements from one layer to another with the Modify 
menu - Modify layer  command. 
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• In the dialog box displayed, choose the number of the new layer to which you 
want to assign the elements, and then click OK. 

• Select those elements you wish to move to the new layer (you may also use 
the commands in the Selection menu ). 

• Enter  Finish selection and close the command. 
 

!  As soon as the selected element is moved to a given layer, the Visibility and 
Background properties of the layer also apply to the element. Additional 
layer properties, such as colour, line type, and line width modify only those 
properties of the moved element that are layer-associated. 

3.3.7. Layer Walk tool 
Layer walk tool helps you navigating through your existing layers of one 
drawing. The key point of using Layer walk is that is makes easy to switch on 
and off visibility of layers and visualize the effect at the same time on the 
drawing itself. The layer walk list shows the names of layers and the numbers 
of elements of one layer between bracelets “()”. 
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Layer Walk tool can be found on Layer toolbar and also in the main menu in 
Modify / Layer walk. 
 

Display empty layers 
This option enables the visibility of empty layers in the layer walk list. By 
default all empty layers are invisible. 
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Using layer walk 

Select a layer 
When the layer walk list is opened you can select a layer, by clicking on its 
name. The selected layer will be highlighted and its content will be 
automatically visible in the active window. 

 
 

Select multiple layers 
To add a layer to your selection please hold down Ctrl button and click on the 
layer name. The selected layers will be highlighted and their content will be 
visible in the active window. 

 
 

Select layers between first and last selection 
You can select every layer in the layer walk list between two selected list 
elements. Click on the first one, hold down the SHIFT button on your 
keyboard and click on the last element. Every layer between the selected 
ones will be selected, including the first and last. 
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The same selection is also available by mouse only. Move over the first 
element, and hold down the left mouse button. While holding the left button 
move the mouse towards the end of the list and when you are satisfied with 
the selection release the mouse button. All elements will be selected between 
the first selections until the list element where the left mouse button was 
released. 
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3.4. Floor and building management 
In ARCHLine.XP® floors allow architects to tie the construction elements 
to a specific storey, regardless of the element's physical location.  
So, you design your building as if you were building it in reality. 
When you start a new project, a first floor is created automatically. 
Other floors have to be created by the architect. 
You can speed up drawing if you copy the objects of an existing floor to 
another floor. This is very useful when creating main walls on a number of 
floors, as their floor plans usually correspond to each other. 
 
Floors in ARCHLine.XP® are not physical boundaries but comprise a 
single logical unit. An object located on a certain floor belongs to that 
floor; however, floor properties (i.e. headroom and height) do not 
influence its geometry. This means that any object placed on the floor 
does not have to be physically within the floor boundaries but may 
overhang. This is necessary for split-level buildings. 
 
In ARCHLine.XP® one drawing may comprise a number of buildings. 
These buildings can be created: 
 

� as separate projects, which are imported to a single drawing by Import 
and Merge to current drawing, or 

� within one drawing, where you can create several buildings. 
 
Depending on the terrain, you can assign different heights above sea 
level to buildings. There is only one active building at a time; others are 
displayed with a lower colour tone.  
 
Floor properties are: number, name, height above sea level and own 
height. You can modify these at later stages. 

Example 
Let’s see an example of wall and slab arrangement in the case of two 
floors: 
 

� ground floor starts at 0 m, with a height of 3 m, 
� wall starts at 0.0, with a height of 2.7 m, 
� slab starts at 0.0 m, with a width of -0.3 m, 
� floor starts at 3 m, with a height of 3 m, 
� ceiling slab starts at a relative 0.0 m, with a width of -0.3 m. 

 



186 3.4 Floor and building management 

Manual 

 

 

 
 
 
 
 
Floor 
 
 
 
 
 
 
 
 
 
 
Ground floor 

 
This means that the slab (floor slab) is situated under the wall and 
overhangs the height of ground floor. The 0.3 m space between the top of 
the wall and the height of the floor is occupied by a slab of the same 
position and of 0.3 m width. 

Floor management 
You can manage floors from different parts of the program: 
 

� in View  with the command Floors and building : 
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� In Project Navigator:  
Choose the appropriate drawing 
to display buildings and floors in 
Project Navigator.  
You can double click to activate 
the desired floor of the selected 
building. 

 

 
 

� In the Status bar  with the Floor  icon: 
Click on the arrow to open the current floor list and select the new active 
floor. 
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Click on the button to display Edit floor levels  dialog box, where you can 
create and edit individual floors. The properties in the dialog box always 
refer to the current building. 
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Let us see the options in this dialog box: 

3.4.1. Creating floors 
If you start a new project, a 0th floor is created automatically. 
By default, floor height is 0 m and the full height is 3 m. 
 



190 3.4 Floor and building management 

Manual 

 
 
You can create new floors in several different ways, depending on the 
actual situation: 
 
Add up 
Add down 
Insert new floor  

New floor above the top-most floor 
New floor under the top-most floor, 
New floor between two floors, under the active 
one 

 
By default, any new floor will have the properties of the floor under or 
above which it has been inserted. 
 

!  When you Insert a new floor make sure that the active floor is the one 
under which you want to insert a new floor. The other two options will 
create a new floor under or over the top-most floor automatically. 
 

���� When clicking Insert new floor, a message box informs you that you 
cannot use Undo here. 
 

 

3.4.2. Activating floors 
Floors have three states: active, off and visible. 
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You can define the state of the desired floor by clicking the appropriate 
element in the pull-down menu of Floors dialog box: 
 

 

Active 
The program places the objects on the active  floor. By default, you can 
only see the objects of the active floor in the floor plan window, but by 
clicking Visible you can make the objects of another floor visible, too. 
 

���� Besides the Floors dialog box, you can activate the desired floor with 
the PAGE UP/PAGE DOWN  keys or with View  − Floors and building − 
Floor up/ Floor down . In these cases, you can switch between floors 
one by one. 
You can also activate the desired floor in the Project class of the Design 
Center by double clicking or by drag and drop, 

Off 
If you activate a floor, the previously active floor turns off. 

Visible 
When editing, you may want to refer to some points of an object which is 
not on the active floor. This option helps you with this. 
 
When a floor is visible , the selected floor will also be visible on the floor 
plan and you can refer to the objects on that level, without editing them. 
Visible objects will be displayed highlighted in grey. 
 

���� Only turned off floors can be made visible. 

 
If you do not need to display the visible floor, either choose Off  or use 
PAGE UP/PAGE DOWN  to switch between floors to activate the desired 
floor. 

3.4.3. Floor properties 
You can assign the following properties to floors: 
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� Name 
� Floor height 
� Height 

 

 

Name 
To change the name of a floor: 

• Double click the Name field to be changed, and 
• Type in the name of the floor and press Enter . 

Floor height 
Floor height refers to the starting height of the floor (floor-to-floor height). 
When you can place an object on the active floor, its height is specified 
according to the active floor’s height. 
 
To change floor height: 

• Double click the Floor height field to be changed, and 
• Type in the floor height and press Enter . 

Height 
Refers to the full height of the floor. This height defines the floor height of 
the next floor. Objects belonging to this floor do not need to be within this 
height. 
To change height: 
 

• Double click the Height  field to be changed, and 
• Type in the height and press Enter . 

 

���� You can set 0.0 as floor height. You may need to set this value in some 
cases — e.g. in the case of pseudo copies, where there is no 3D 
modelling, so there is no height extension either.  

3.4.4. Building properties 
Buildings are described by the following properties: 
 

� Height above sea level 
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� Environment level visible 
� Split levelling 

Height above sea level 
Gives the absolute height of the building compared to the sea level. This 
is important when placing the building in its environment, i.e. on the 
terrain. Modifies the 0.0 m floor height of the building with the height 
above sea level. 
 

• Type in a new value and press Enter . 

Environment level visible 
You can only place the terrain on the environment level. 
If you disable this option, the terrain placed on the drawing will not be 
visible in the floor plan and the 3D-model. If you enable this option, the 
terrain will be visible with each level.  

Split levels 
As we have mentioned before, an object placed on the floor belongs to 
that floor, though its geometry is not affected by floor properties (floor 
height and height). This means that it is not necessary for an object 
placed on the floor to be physically within floor boundaries, but it can 
overhang these boundaries. 
 
Modify floor levels − Level difference shifts the floor height of the active 
floor with the specified value. The program will place the subsequent 
architectural objects at this height. 

• Type in the value of the level difference and press Enter . 
 

���� The value of level difference is displayed on the Floor button in the 
Status bar, separated from the name of the floor by a 

hyphen: . The level difference is valid for all 
floors. 

Example: 
The living room and the dining room are on the same floor in the house, 
on the ground floor. However, there is a 1 m difference between the levels 
of these two rooms with the dining room located higher. 
 
You should place both rooms on the ground floor on the drawing, 
because they have to be displayed on the ground floor. The objects of the 
living room (e.g. walls) are placed on the 0.0 m height of the ground floor. 
The objects of the dining room are 1 m higher.  
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� In the case of the dining room objects, level difference can be defined by 

setting the height above floors to 1 m in the Properties dialog box for each 
architectural element. 

� The other solution is that we set Level difference to 1 m in the Modify floor 
levels dialog box. In this case you do not have to set height for each 
object individually. 
Please note, that if you want to place objects in the living room, you have 
to reset level difference to 0.0 m. 

 

3.4.5. Floor management 
In ARCHLine.XP, you can manage floors with the following commands: 
 

� Delete floor 
� Copy objects to other floor 
� Move objects to other floor 
� Renumber floors 
� Separate floors 

 

3.4.5.1. Deleting a floor 

To delete the selected floor: 
• Click the desired floor in the Edit floor levels  dialog box, and 
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• Click Delete . 
 
If you delete a floor, the floor height of the floors above the deleted floor 
will be reduced by the height of the deleted floor. 

3.4.5.2. Copy or move objects to other floors 

You can copy or move the selected objects with this command to one or 
more existing floors. The command can be activated only if you have 
several floors. 
 

• In the Edit floor levels dialog box, click the Copy objects to other floor  
or Move objects to other floor  button. 

• Select the objects to be copied or moved on the drawing and press Enter . 
• Select the floors you where want to copy or move the selected objects. 

Hold Ctrl and Shift to select more than one floor. If you click the name of 
the floor, you can see the current content of the selected floor in the 
drawing field. 
 

 

Making pseudo copies 
You can copy the floor plan display of objects to another floor, without 
having a 3D model for these objects. This is what we call a pseudo copy. 
The copied object is displayed as a 2D group object on the desired floor. 
This group is still connected to the original object. If you delete the object, 
the group is also deleted. 
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You can place the selected object as a 
pseudo copy. Going back to the floor 
plan, you can define the pseudo copied 
object by a rectangle profile or by a 
polygon profile. The program cuts the 
object at the boundaries of the 
rectangle or the polygon. 

 

 
You can change the properties of the object created as a pseudo copy. In 
the group, you can modify the line type of the object. This method is very 
useful when e.g. you want to mark the location of the framing beams with 
a dotted line on other floors, too. 
 

    
 

Buffer level Garage level 

3.4.5.3. Renumbering floors 

In the View menu you can renumber floors with the Floors and building 
-Renumber floors  command by giving the number of the bottom-most 
floor. 
 

• Set the new number of the bottom-most floor. 

3.4.6. Managing multiple buildings (for experienced  
users only) 
In ARCHLine.XP® one drawing can contain several buildings. You can 
create these buildings: 
 

� as separate projects, then you can place these on the same drawing by 
the Import command −Merge to current drawing option, or 
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� as new buildings within the drawing. 
 
Depending on the terrain, you can assign different heights above sea 
level to each building. There is only one active building at once; others 
are displayed with lower colour saturation. 
 

���� Buildings marked with grey (i.e. inactive buildings) will be printed in real 
colour. 

3.4.6.1. Importing buildings 

Having completed building drawings in separate projects: 
 

• Open the project in which you want to place the building. This can be a 
new project. 
Load the floor plan from another project, which is imported into the 
opened project as a new building. To do this, follow this method: 

• Select the project desired in File menu - Open project dialog. 
• In the Open project dialog box, enable Import file  and Merge to current 

drawing  options. Click Ok. 
 

 
 

• Enable Place with new origin  option in the dialog box. 
• Enable Place as new building  option. 
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���� If the floors of the building to be loaded differ from that of the building in 
the project, you cannot enable the Place as new building  option 
(greyed) and the program creates a new building automatically. 
 
Then you can find multiple buildings in the drawing.  
 

 
 
The Edit floor levels dialog box contains the properties of the current 
building. Height above sea level applies to that current building only. 
 
You can choose the building desired from the Current building  pull-down 
list. 
Building names correspond to the original floor plan file names. 
 
To change the name of the current building, click Rename  building . 
 
Click Delete building  to delete the current building. Once you accepted 
this command, you cannot undo it. 
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To activate the building, select its name. You can go on with the drawing 
of this building. The other buildings are visible, but you cannot modify 
them. 
 
In the following example you can see three buildings placed on the terrain 
at different heights above sea level. The building in the middle is active. 
The other buildings have lower colour tones. 
 

 
 
 

 

 
 

!!!! When creating your 3D-model, enable the Each building  option in the 
dialog box. The program will create a 3D model for each building. 
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3.4.6.2. Creating a new building 

You can also draw multiple buildings in one project. In this case you 
cannot load the completed building from the project file, but you draw the 
building within the project. 
This happens as follows: 
 

• Create a new project. Draw building as usual.  
• Select View menu - Floors and building - Create new buildi ng  

command. 

•  
•  
• You can take over the floor structure from the active building or you can 

define the number of floors independently. 
• Give the name of the new building. This building will be active, although 

at this point it is an empty building. 

•  
•  
• The new building is active from now on; other buildings are deactivated 

and displayed in lower colour tones. 
 

���� You can define height above sea level in the Edit floor levels dialog box, 
and you can also modify the number of floors there. 



  3 Settings 201 

 ARCHLine.XP ® 

3.4.6.3. Activating other buildings 

You can activate another building by: 
 

� Using the View menu - Floors and building - Activate another building  
command. Click the building desired. 
 
Or 

� by selecting the name of the building desired from the Current building  
pull-down list in the Edit floor levels dialog box. 

3.4.6.4. Deleting buildings 

To delete redundant buildings: 
 

� Click View menu - Floors and building - Delete building  and select the 
building to be deleted, or 

� select the name of the building to be deleted in the Current building pull-
down list in the Edit floor levels dialog box and click Delete building . 
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4. File management 

4.1. Introduction 
In ARCHLine.XP® you can manage projects and standalone drawings. 

4.1.1. Project management 
Drawing management in ARCHLine.XP® is based on the project.  
In ARCHLine.XP®, the project contains the whole description of a building or 
buildings and all of the information needed to represent it in construction plan 
and three-dimensional views, sections, and printing layouts. This method 
simplifies design work, helps clear navigation among the numerous projects 
of an architect. 
All this information is stored together in one file with .pro extension. 
ARCHLine.XP® saves all your settings together with the project and allows 
you to customize them at any phase in the design process.  
Moving projects to another computer or giving it to a colleague become a 
single click. 
As you edit the building design in any view, ARCHLine.XP® follows those 
changes throughout the project. This means that the 3D model, any views of 
the model, sections, the floor plan, and the printing layouts all automatically 
update to reflect the changes.  

Project access rights  
Other users may access your projects without any limitation. This means that 
any project created by user „A” can be opened, modified, saved and copied 
by user „B”. 
 
We recommend that you use project management. 

Managing drawing files 
In this case the drawing is made up of the floor plan. You can make a 3D 
model with sectional drawings and projections. Each drawing has an ASC file 
extension. 

Disadvantages: 

• Different views assigned to a floor plan are not saved when you save floor 
plans. You have to save each drawing file individually. 

• The saved drawings are not connected to each other. 
• You cannot restore the floor plan from different views. 
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• Materials and settings created by the user are not saved in the ASC file, so 
you cannot transfer them to another computer. 

Importing and Exporting 
ARCHLine.XP® is compatible with other drawing and display programs. 
You can load drawings made with ARCHLine.XP® or earlier versions, 
AutoCAD® DXF, DWG, DWF drawings and 3D Studio or SketchUp model as 
well. 
Besides ARCHLine formats, the program supports AutoCAD® DXF, DWG and 
DWF formats, and file formats of ARCHLine.XP® Render Studio, 3D Studio, 
Cinema4D, Artlantis,  programs. 

Template file 
Creating the drawing template means setting the drawing surface and all the 
drawing tool properties. You can save personal settings as part of the 
template to speed up the drawing process. You can save the created 
templates to a template file with a SET extension. 
 
The File menu  includes the following: 

� file operations for loading and saving drawings, projects files, 
� settings, 
� print preview and printing commands. 

 

� This chapter contains commands for file operations only. 
For the description of individual settings, see chapter 2.10. Display settings 
and chapter 3.1. Architectural settings. For printing instructions, see chapter 
14. Printing. 

 

���� If you double click on .pro and .asc files in the Explorer,  ARCHLine.XP® 
starts automatically, and the selected file is loaded. 
If ARCHLine.XP®   is running, you can load any .pro and .asc or image file 
from the Explorer  by drag and drop. 

 

4.1.2. Building 
In ARCHLine.XP, the building is the highest logical unit. 
 
The building is made up of multiple floors, the architectural elements on the 
floors, and the layers that help the visualization and grouping of the elements. 
Architects can design several buildings within one ARCHLine.XP® project.  
The buildings can be drawn separately in different projects or they can be 
handled in the same project. 
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One building is active at a time while the others are visualized with a lighter 
tone. Different altitudes can be assigned to the buildings. 

 

4.1.3. Floor 
In ARCHLine.XP® the building levels are defined as floors. Structural 
elements and Component elements are associated to these floors, so that 
changes to a floor's height automatically generate changes to the linked 
objects elevation and height.  
The floor corresponds to the architectural meaning of floor. Just as in reality a 
building is built up from floors, the plan is also realized floor by floor, level by 
level. Opening a new project Floor 0 is automatically created. Any other floors 
are to be created by the architect according to the needs of the design. 
 

 

 
 
 
 
Floor 4 
 
Floor 3 
 
Floor 2 
 
Floor 1 
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4.2. Project management  

Running ARCHLine.XP ®  
We suggest you manage your drawing as a project. 
After starting ARCHLine.XP®  from the Start menu, select work with a project, 
i.e. enable the Project option. 
In this all information will be saved in one file, i.e.: filename.pro. 
 
In the first dialog box you can: 

� start a new project, 
� load any of the last 6 projects used, 
� load a project saved before. 
� or browse a project by name and folders. 

 
Select any of the following four options: 

Creating a new project 
To create a new drawing, click on the first icon in the dialog box. 
 

• Select a folder where you want to save the new project. By default, the 
program offers the path to the last project used. Project files in that folder are 
also displayed. 

• Give the name of the new project. 
 
If there is a project with the same name in the selected folder, the program 
displays a message asking if you want to overwrite the existing project.  
 

!!!! If you click Yes, you lose the project under the same name. 

Opening the last used project 
Here you can select any of the last projects. The program loads the selected 
project, including all windows, displaying them in the last saved arrangement. 
You can display the full path name or only the name of the project. The latter 
is very useful when the path name is too long and you cannot see the name. 
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���� When you use the Show full path option you can read the full path 
information from the appearing tool tip. 

Opening an existing project 
Click this button to find Open project file  dialog box, where you can select 
the desired project file. By default, the program offers the path of the last 
used project. 
 

� See chapter 4.2.3. Opening a project for the description of this command. 
 
Other commands concerning project operations are the following:  
 

 
 

4.2.1. New project 
With File menu - New project command you can start a new project or load 
an existing project. 
 

• In the dialog click OK if you want to resave the current project. 
 

If you click Quit without save, the message appears: “Are you sure to close 
the project without save?”  
 
The following dialog box pops up: 
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� The dialog box is similar to that one which comes up when starting the 
program. The difference is that this dialog box does not contain an Exit 
button, so you cannot shut down the program here. 

4.2.2. Search projects 

Introduction 
ARCHLine.XP gives an efficient helping hand to search former projects and 
drawings on the hard disks of the computer. 
You can use it simply, just determine the search position and conditions then 
you just have to select the proper one from the found projects or drawings. 
This function can be used excellently for searching former used works or their 
backup copies. 

Use search  function 
You can start the command from the Tools menu – Accessories submenu or 
using the File menu – New project – Search icon.   
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In the appearing dialog window determine, in which folder you want to search 
and give the name you are looking for, and the type of the file: 
 

Project / Drawing 
You can set what and where you are looking for. Select the proper option.  
 

Folder 
Here can be seen that access path, where the program is searching. Click on 
the Browse button, you can select another folder or driver. The searching 
happens in all subfolder too. 
 

Search for 
Here you can determine the name of the file or the part of it, which you want 
to search for. For example, if you look for the original „klimahaus.pro” file, it is 
enough to write in the „klima” search condition. After clicking on the Search 
button the program is searching files in the given path that contain the „klima” 
detail. 
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The search results appear similarly as above.  
 

Search results 
You can fine the search results. In course of searching the ARCHLine.XP® 
search not only among the saved projects according to the given conditions, 
but among the backup copies (PR$ extend files) and the automatically exist 
archives (Archive folder) as well. 
Select the proper option from the drop down list, if it is necessary. 

 
Project contents 

In this field you can select one design, which is in the selected project.  
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Preview 
It shows the preview of the selected drawing from project contents list in 
miniature form. 
 

File info 
The program represents essential information from the selected file. 
 

Open 
You can open the selected project or drawing, if you click on the Open button.  
 

���� You can interrupt searching with pressing down the ESC button. 

 

4.2.3. Opening a project 
The program loads the desired project with File menu - Open project 
command. After opening the project, each related drawing is displayed in a 
separate window. 
 

 
 
When you activate the Open project command, a dialog box appears where 
you can select which .pro file you want to open. By default, the program offers 
you the path of the last project you worked on. 
If you cannot find the desired file in the list, choose another directory. 
 

• Select the project to be opened. 
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Preview 
Enable the Preview option to display the name of the drawings related to the 
selected project in the right hand side of the dialog box. 
This helps you to clearly identify the project. 
The program displays images only if you click on the name of the drawing. 
This way you can scroll the names of the drawings within each project. 

Importing of ASCI file from another project 
If you enable this option, the program will load the selected drawing only . 
 

• Click Open , and the program asks you the following question: 
„Are you sure you want to import a file from this project?” 
 
If you click Yes, you can: 
 

� either merge the imported drawing file into the current project, and then the 
drawing is created in a new window as a part of the project, 

� or create a new project. In case of a new project, give the name and the path 
of the project. By default the program offers the path of the last used project. 

 

 

Merge into current drawing 
If the Import file option is enabled, you can add the imported drawing file to 
the active drawing of the current project by enabling Merge into current 
drawing option, so as to make it a part of the project. 
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���� Use this option if you want to place a finished drawing saved as a project 
onto the terrain. If you manage multiple buildings, you should load the 
buildings with this option. To do so, select the floor plan from project 
drawings. 
 
If you want to place the reference point of the drawing to a selected point 
instead of the global coordinate origin, press Open  and enable the Place 
with new origin option in Merge files dialog box. The reference point of the 
drawing is the (0; 0) point. 

 

!!!! You can make full use of this option if you place the first element of the 
drawing to be merged at the (0, 0) point. Then the starting point of the first 
object will be the point of reference. 

 

���� Import file option is similar to File menu - Import  command; however, you 
can only import project files here. 
 
After selecting the name of the desired project (the File import option is switch 
off) and pressing Open, click OK in the Save project dialog box. If you have 
not saved changes to the current drawing, the program asks you if you want 
to do so. 
 
If you click Exit without saving, the program asks “Are you sure you want to 
exit without saving?” 

Drag and drop files in ARCHLine.XP 
To open a project, there are other options than using a dialog box. 
You can open files by drag and drop that is by dragging and dropping files 
from Windows Explorer to ARCHLine.XP®, as it is used in Windows. You can 
use the following files: 
 
Projects, ASC drawings, DXF, DWG, DWF drawings, image files (e.g. BMP 
and JPG files), 3D Studio objects (3DS). 

Double click on filename 
If ARCHLine.XP®  is not running, double click the project file name (.pro) or 
the .asc file name in Windows Explorer to start the program; the project and 
the drawing will be loaded. 

Opening last used files 
The last used 6 projects appear on the bottom of the File menu. You can load 
any of those by selection: 
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File name rules 
Inside a project the renaming of files is not allowed, thus you can avoid 
creating name conflicts in a project. Only the changing of the pseudo name is 
possible in the Project properties dialog box. This new rule makes easier the 
handling and identifying of drawings on plot layouts, too. 
 

� The name of the first floor plan window is derived from the name of the 
project. 

� At the opening of other floor plan windows you have to define the new window 
name (e.g. 2D sections, 2D facades etc.). 

� At the opening of a 3D view window the new window name is generated 
automatically (View 1, View 2, etc.). 

� At the creation of a 3D section window the window name is generated 
automatically (Section1, Section2 etc.),  

4.2.4. Import and export files 
ARCHLine.XP® is able to import and export data from a wide variety of CAD 
software.  
 

� See the Chapter 4.5. Import/Export. 

4.2.5. Import file into a project 
Importing of files can be done in three ways: 
 

� with the File menu -Import command, 
� with the drag & drop method: for example dragging from the Windows 

Explorer. 
� File menu – Open project - Import file command 

Importing of DXF/DWG file into a project 
If we import into an active a 2D floor plan with the File menu - Import 
command, the Merge to current drawing option is the default setting. The 
same applied when you use the drag & drop method. This way the 
unnecessary increasing of the number of 2D floor plan windows can be 
avoided. 
If we import into an active 3D window, the two methods work different:  
In case of File menu - Import command the Merge to current drawing option 
is the default, the drawing will be imported to a given drawing. When you use 
the drag & drop method, the drawing will be loaded into a newly created 
window. 

� See the Chapter 4.5.2. DXF/DWG import/export. 
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Importing of ASC file into a project 
If we import into an active a 2D floor plan with the File menu - Import 
command, the Merge to current drawing option is switched off by default, 
therefore a new window will be created. In case of drag & drop method the 
drawing will be imported into a given drawing. 
If we import into an active 3D window with the File menu - Import command, 
the Merge to current drawing option is switched off by default, therefore a new 
window will be created. Also, in case of drag & drop method, a new window 
will be created and the drawing will be loaded there. 
 
If name conflict occurs at new window generation, the new window name will 
be generated by the concatenation of the original file name and the extension 
of .1. 
 

� See the Chapter 4.5.1. ASC Import. 

ASC file import from project into project 
If the drawing to be loaded is part of project, the Import command can’t be 
used. In this case, use the Open Project command, and select the Import file 
and Merge to current drawing option. 

� See the Chapter 4.2.3. Opening project – Import file option. 

4.2.6. Saving project 
When you save the project, each drawing (floor plans, facade views, 
sectional drawings and perspectives) goes into one file, with a .pro  file 
extension. 
This project file contains all the information including materials created by the 
User, object properties, architectural settings, display settings, hatch patterns 
and line types. 
Only those sets are saved in the projects that are used within it.  
The 3D database is not saved in the project by default, only upon your 
request. 
 

���� You can save your current projects with their names in the selected 
directory by File menu - Save project command, or with the Edit toolbar - 

 icon. 
 

Drawings that make up the projects are also listed in the dialog box. 
Floor plans are marked with blue, 3D drawings are marked with black, and 
plot layouts are marked with green. 
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Renaming 
Double click on the selected File name. You can overwrite the pseudo name 
of the drawing but the File name of the drawing is not changed with this. 

State 
You can change the state of any drawing. 
You can delete any selected drawing in a project or you can turn them off 
temporarily. Drawing files can have three states: active, not visible and 
drawings to be deleted from the project. 
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Active drawing:   
An active drawing is displayed on the screen and is part of the project. 

Not visible drawing:   
If you turn off the Light bulb icon, the selected drawing will be temporarily 
invisible, i.e. it will not have a window but it will remain part of the project. If 
you reload the project later on, the last saved state will be displayed, i.e. only 
the active drawings will appear. Click on the Light bulb icon in the Save 
project  or Project properties  dialog to activate the invisible drawing. 
You can also make the drawing invisible if you disable the window of the 
drawing. 

Drawing to be deleted:  
Click on the Sheet icon of any drawing to delete the drawing from the project; 
this also means that you delete the drawing from the hard disk and so it will 
not be accessible any more. 

Checkboxes 

Purge unused materials: 
The materials which are not applied on the floor plan and 3D model will 
automatically deleted from the project, if this function is switched on. As a 
consequence your project size may decrease significantly. 

Save the lines of the hatch: 
The hatch component lines which are applied on the floor plan and vector line 
section views will be saved into the project, if this function is switched on. It 
results faster loading of the project next time when you open it. As a 
consequence your project size may increase significantly. 
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!!!! Remember not to delete the floor plan unless you do it for some specific 
reason. 

Save 3D database 
� Off: 

It is switched off by default therefore the 3D database is not saved in the 
project. The 3D model can be created from the floor plan any time. 
If we use the 3D solid modeller and we do not save the object in the object 
library, we need to save the 3D model. 
In a case like this the program recognizes that the plan contains 3D elements 
which have not connection to the plan and when the project is saved the 
program offers the possibility of saving the 3D model as well. 

� On:  
If it is switched on the whole 3D database is saved. In this case the project 
size considerably increases. 

Exit the program 
When you exit the program or load another project, the program displays the 
Project properties dialog box showing the states of the drawings, and asks for 
confirmation. At this point you can cancel the deletion of the drawing. 
You can select the Quit without save option In this case you are to lose all 
changes made since the latest save. 

Making copies 
When the program saves the projects, it also saves the previous status as 
filename.pr$ . This way you can always find a copy of the previous saving. 
The next saving will overwrite the copies. 

4.2.7. Saving project as… 
You can save your project under a new name. The appearing dialog box 
corresponds to the one popping up for Save project. 
After closing the dialog box, you can define the new name and path for the 
project in Save project dialog box. 
 

� If you want to export the project to earlier version of ARCHLine.XP®: 
  
In the Save project file dialog select XP project format. You can open the 
project saved this way with the previous program version. 
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� You can load any project created with the previous versions. 

When saving the project, the following message pops up: 

  
This means that the program will not overwrite the previous file version, and 
you can save the project with a new name in ARCHLine.XP® format. 

4.2.8. Archive 
It is possible to archive drawings (.asc floor plans) of projects. 
In a pre-defined folder the application creates a subdirectory with the current 
date. Partial backups of newly created or modified projects are created here 
in subfolders named according to the project names. 
During the archiving procedure the .asc floor plans and plot layouts of 
projects will be archived here. 
This archiving option makes enable for the user to create automatic backups 
on each day of the working procedure, making easy to search back for a 
given state of the working procedure by date. 
Folders created this way are not deleted automatically. After finishing the 
work the users should ensure the deleting of unnecessary files themselves. 
 
Switching the archiving option on: 
 

• Switch the Archive option on in the File menu - Preferences - General – File 
locations dialog. (The Preferences dialog is also available by clicking on the 
measurement unit in the Command line.) 

• Specify the directory where the archived files should be saved into. By default 
this is the …\Draw\Archive subfolder in the installation directory. You can 
change this. 
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!!!! With the archiving option you cannot save projects but drawing (.asc) files! 

4.2.9. Auto save 
With auto save you can avoid data losses due to black-outs or any other 
unexpected events. 
After a definite number of drawing commands, the program saves the current 
drawing. When you restart the program after the unexpected events, the last 
used project will be loaded automatically from that folder. 

 !!!! This temporary folder will be deleted when you exit the program, so auto 
save does not substitute  the saving of the project. If you fail to save your 
drawing, and then exit the program, your entire work will be lost. 
 
You can enable Auto save under Save 
in File menu -Preferences - General - 
Other dialog box: 
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!  A very frequent auto save will slow down drawing commands because of 
increased disk usage. For this reason, it is preferable not to set a very low 
step number. 
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4.3. Project navigator 

When you save the project, each drawing (floor plans, facade views, 
sectional drawings and perspectives) goes into one file, with a .pro file 
extension. 
This project file contains all the information including materials created by the 
User, object properties, architectural settings, display settings, hatch patterns 
and line types. 
Only those sets are saved in the projects. 
The 3D database is not saved in the project by default, only upon your 
request. 
Drawings that make up the projects are listed in the Project Navigator. 
 

���� As a consequence of the new Project Navigator feature the previous 
release Project management dialog is cancelled in the ARCHLine.XP® 2010 
release. 

4.3.1. Project navigator in details 
The drawings that make up a project are 
grouped as visible and hidden drawings.  
What is the difference? The hidden 
drawings have no assigned window but 
remain part of the project when you save 
it. You can also move a drawing to the 
hidden drawings group if you click X 
button of the window as you close it. 
These visible and hidden folder contain 
the following sub groups:  
 

� 2D drawings (floor plans)  
� View (perspective and 

axonometric views, wall views) 
� Section (sections) 
� Print layout (list of print layouts) 

 
You can visualize the buildings and floors 
of the 2D drawings as well with a click on 

 sign or with a double click on the 
drawing name. 
There is also a section named zones, 
detailed in 4.3.6.  
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4.3.2. How to use the Project Navigator? 

Active drawing 
The mouse left double click makes the selected drawing to active drawing. 
When the selected drawing is in the Hidden  category it will be displayed on 
the screen and will be moved to the Visible  category. 

New drawing 
The mouse right click makes over the folder name offers to create the 
appropriate new drawing according to the folder name. 

 

2D drawing management 
Using the mouse right click over the 2D drawing name the following menu 
appears: 

  
 

� Create new  enables to create a new 2D drawing. 
� Rename  command enables to change the pseudo name of the 

drawing. You can overwrite the pseudo name of the drawing but the 
real file name of the drawing will not change. 
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� Hide.  The selected drawing will be temporarily invisible, i.e. it will 
not have a window but it will remain part of the project. The drawing 
moves to the Invisible group. 

� Properties  command opens the 2D drawing related floor 
management dialog where you can modify the current floor 
structure. 

When you chose a 2D drawing in the Hidden  folder with the mouse right click 
over the 2D drawing name the following menu appears: 

  
� Click on the Light bulb icon the Make visible  command activates the 

hidden drawing and moves to the Visible  folder. 
� Click on the Delete  command to delete the drawing from the project. This 

means that you delete the drawing from the hard disk and so it will not be 
accessible any more.  

!!!! Remember not to delete the 2D drawing (floor plan) unless you do it for 
some specific reason. 
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3D view management 
Using the mouse right click over the 2D drawing name the following menu 
appears: 
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4.3.3. Preview 
The Project Navigator encapsulates 
a preview control that displays the 
image of the selected drawing in the 
Hidden  folder. Use the mouse left 
click over the file name and the 
preview displays the image when 
available. 

 

4.3.4. Save 3D database 

 
 
This check box controls the saving of 3D database into the project. 

� Off  
It is switched off by default therefore the 3D database is not saved into the 
project. The 3D model can be created from the floor plan any time. 
If we use the 3D solid modeller and we do not save the 3D solids in the object 
library, we need to save the 3D model. 
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In a case like this the program recognizes that the plan contains 3D elements 
which have not link to the floor plan and when the project is saved the 
program offers the possibility. 

� On: 
If it is switched on the whole 3D database is saved, and the project size 
considerably increases. by saving the 3D model. 

4.3.5. Notes 
You can add notes to the project. 
 

 
 
You can submit a note with the Enter key. For the case you exit from the 
dialog by clicking the Ok button, the new message will be saved, too. The 
messages appear in the message list. Click Cancel if you want to quit without 
saving the message. 
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4.3.6. Zones 

4.3.6.1. Concept 

Zones can be defined in a building. They are groups of several rooms. You 
can use zones to represent ownership, to design heating or air conditioning 
systems, to visualise areas with different acoustic requirements, etc. 

 
Air conditioning systems 

 
 

Ownership 

4.3.7. Categories 
You classify rooms on a building in many ways. As for the ownership you can 
differentiate between tenants, if you would like to deal with air condition it is 
possible to define zones based on the required cooling and heating systems.  
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Groups and priorities 

You can sort zones into several groups, if necessary. For zone groups you 
can define high or low priorities. Priorities are taken into consideration while 
calculating zone areas and volumes. If you use zone group priorities in a 
zone category, zone areas are extended by the thickness of the surrounding 
wall and slab structures according to the following figure: 
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Colours 

Finally you can define zones and add rooms to them. In a zone category 
every room can be added to one zone. Zones can be visualised by a unique 
zone colour. 

4.3.7.1. Managing zones 

 

Project Navigator’s tree structure is extended by a 
new item: Zones. You can expand or collapse 
branches by clicking the +/- signs in front of the tree 
items. By clicking on an item you can rename it. 
 
By clicking on an item  with the right mouse button  
a Local pop menu appears and you can select a 
command in it. Below you can learn about local pop 
menus of different tree items. 
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Zones (main tree item) 

Create new category 
A new zone category is added to the tree, with a default name. You can 
rename it by clicking on its name with the left mouse button. 

Show zones with colours 
Rooms will appear with zone colours of the active zone category. 

Hide colours 
Rooms will appear as empty polygons. 
 

Zone category 

Activate 
It activates the current zone category.  Area calculation and zone colouring is 
based always on the active category. 

Create new zone group 
A new zone group is added to the tree, with a default name. You can rename 
it by clicking on its name with the left mouse button. 

Rename 
It renames the current zone category. 

Priorities and colours 
The Priorities and colours dialog appears, here you can set the colours of the 
zones and the priorities of the zone groups in the current zone category. 

Delete 
Deletes the current zone category. 
 

Uncategorized rooms 

Add rooms to this zone 
Select rooms on the floor plan and then press ENTER.  The rooms are moved 
to the uncategorized zone. 
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Zone group 

Create new zone 
A new zone is added to the tree, with a default name. You can rename it by 
clicking on its name with the left mouse button. 

Rename 
Renames the current zone group. 

Priorities and colours 
The Priorities and colours dialog appears, here you can set the colours of the 
zones and the priorities of the zone groups in the current zone category. 

Delete 
Deletes the current zone group. 

Zone 

Add rooms to this zone 
Select rooms on the floor plan and then press ENTER. The rooms are moved 
to the current zone. 

Rename 
Renames the current zone. 

Priorities and colours 
The Priorities and colours dialog appears, here you can set the colours of the 
zones and the priorities of the zone groups in the current zone category. 

Delete 
Deletes the current zone. 

Room 

Show on floor plan 
Selects the room on the floor plan. 

Rename 
Renames the current room. 
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Room properties 
Opens the Properties dialog of the current room. 

Remove from zone 
The room is moved to the uncategorized zone. 

 
 
 
 



234 4.4 Drawings  

Manual 

4.4. Drawings 
As you may see in the Introduction, the program allows you to manage 
individual drawings. In this case the drawing is made up of the floor plan. You 
can create a 3D model from the floor plan with several projections and cross 
sections. Each file has an ASC extension. In this case the different views 
connected to the floor plan are not saved when saving the floor plan. 
You have to save each drawing file individually and these files will not be 
connected to each other. You cannot recover the floor plan from views. 
Materials and settings created by the user will not be saved in the ASC file, 
so you cannot transfer them to another computer. 

Note: 
If you insist on using ASC files, we recommend you the following method, to 
be able to manage views in the ASC file, too: 
 
When you finish the front view, the cross section and the pre-set perspective 
etc., by using Edit menu - Copy or Paste  commands, copy e.g. the cross 
section from the cross section window to the floor plan to any floor not used 
for floor plan drawing, e.g. to Floor -1. The drawing created this way will lose 
its connection to the 3D model. If you modify anything on the floor plan that 
will not be followed by changes on the cross section on Floor 1 i.e. this will be 
a 2D drawing that you can modify, calibrate and label as you like. This way 
you can keep different views of different floors and save them into a single 
ASC file. You can transfer this single ASC file to another computer. 
 

���� You can also convert views and sectional drawings into 2D drawings in 
projects. 

 
Commands for managing drawings: 
 

 
… 
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4.4.1. New project or drawing 
This command allows you to create a new drawing or to load an existing 
drawing. 
If you have not saved changes of the current drawing, the program will ask 
you if you want to save the drawing. 

 
• Enable the Drawing  option in the dialog box. The last specified status will be 

active. 
 

In the dialog box you can: 
 

� Create a new drawing, or 
� Open any of the last drawings, or 
� Open an existing drawing. 

 

���� You can start a new floor plan with the  New icon of the Edit  toolbar, 
and then you have to give the name of the new floor plan window. 
 

� The use of this dialog box corresponds to that of the New project dialog box. 
For a detailed description, see chapter 4.2. Project management. 

4.4.2. Opening drawings 
If you activate the Open drawing command, a dialog box appears, where you 
can select the drawing you want to open. The program automatically offers 
the path of the last used drawing. 
 
In drawing mode the next rules are applied for opening a drawing: 

� Each file keeps its name and location, 
� Renaming of files are not allowed, 
� A drawing can be loaded only once, 
� File name on the window title bar appears with its short path name. 

 
You can open multiple floor plans at one time. Please note, that the 3D 
models of different drawings will be displayed in the same 3D window. 

� The use of this dialog box is similar to that of the Open project dialog box; for 
a detailed description, see chapter 4.2. Project management. 

 

���� You can also open a drawing with File menu - Import command. Select 
.ASC for file type. 
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4.4.3. Saving drawings 
With this command, you can save the current drawing under its name to the 
selected library. 

Exit 
When exiting the program or loading a project, the program asks if you want 
to save drawing files. 
If you click No, you will lose all changes made since the last saving. 
 

Creating backup copies 
When the program saves the drawing, it also 
creates a backup of the previous version with 
the name filename.as$ . This way you can 
always find the copy of the previous saving. 
Backup copies are always overwritten by the 
next saving. 

  

4.4.4. Save drawing as… 
With Save as you can save the drawing under a new name. Type in the name 
of the drawing in the dialog box and give a new path if necessary. 
 
As a file format you can set: 

� ASC: saves the drawing in ARCHLine.XP®  format, whether or not you have 
saved the floor plan or the content of the 3D window 

� 3AS: saves the 3D model. 

Compatibility with the previous version 
ARCHLine.XP® 2010 is compatible with ARCHLine.XP® 2009, 2008, 2007. 
This means that you cannot read new drawings with the previous version. 
 
You can save the drawing as the drawing format of the ARCHLine.XP® 
version that is in ASCII mode, which is readable with ARCHLine.XP. You can 
also save the content of the 3D window as .3as format of the ARCHLine.XP® 
version. 
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4.5. Import/Export 
ARCHLine.XP® is compatible with other design and display programs. 

Import 
The drawings to be loaded can be the next files: 
 
.asc drawings created with ARCHLine.XP® and a 

previous version 
.dxf AutoCAD® DXF format 
.dwg AutoCAD® DWG binary format 
.dwf AutoDesk Design Web format 
.skp SketchUp file format 
.3ds 3D Studio format 
obj Wavefront format 
.hou drawings created with ARCHLine® 4.x versions 
.drw drawings created with ARCHLine® 4.x versions 

Export 
In case of export, the program supports ARCHLine.XP® and previous 
versions and the next formats: 
 
.dwg AutoCAD® binary format 
.dwg AutoCAD® 2010 binary format 
.dwf AutoDesk Design Web format 
.dxf AutoCAD® DXF format 
.skp SketchUp file format 
.3ds 3D Studio format 
.dxf AutoCAD® 3D DXF format 
.dwg AutoCAD® 3D DWG format 
.asc ARCHLine.XP® drawing 
.3as ARCHLine.XP® 3D model 
.emf Windows metafile format 
.tgf ARCHLine.XP® Render Studio 
.c4d Cinema 4D 
.atl Artlantis rendering 
.wrl Virtual Reality Language 

Importing SketchUp Files 
ARCHLine.XP comes with the reader for SketchUp (.skp) file format.  
You will find it in the File menu - Import - , SketchUp menu point. 
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You can change the size of the SketchUp files are imported by using the New 
general import dialog Scale option before you place the SketchUp object into 
the 3D window. 
 
The program is compatible with AutoCAD® 2010 and SketchUp 8 formats. 

4.5.1. ASC Import 
Besides allowing file transfer from other applications, the Import command is 
very useful when you want to merge a drawing saved as ASC into an existing 
drawing. This happens very often when you place a building on a terrain. To 
do so, enable Merge to current drawing option. 
If the drawing to be merged is the part of a project, you cannot use Import. In 
this case, you have to use Open project, and choose Import file and Merge to 
current drawing options. 
 
Importing of files can be done in three ways: 
 

� with the drag & drop method: for example dragging from the Windows 
Explorer. 

� with the File menu –Import command, 
� with the File menu – Open project - Import file command 

Importing of ASC file into a project –using drag & drop method 
If we import into an active a 2D floor plan using the drag & drop method the 
drawing will be imported into a given drawing. 
If we import into an active 3D window with the drag & drop method, a new 
window will be created and the drawing will be loaded there. 

Importing of ASC file into a project – using File m enu –Import 
command 

Import allows you to merge the imported drawing to the current drawing or 
place that into a new window. 
 
If we import into an active a 2D floor plan/3D window with the File menu - 
Import command, the Merge to current drawing option is switched off by 
default, therefore a new window will be created. In case of drag & drop 
method the drawing will be imported into a given drawing. 
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• Select drawing file format: .asc 
• Select the drawing you want to open. 

Preview 
Enable this option to display the selected drawing in the dialog box in an 
optimized size.  

Merging to current drawing 
Enable the option to merge the imported drawing file to the current drawing; 
the imported file will be part of the current drawing. 
Disable the option to display the drawing in a separate window. 

Keeping original layers 
If you enable Keep original layers, the program loads the drawing while 
keeping the layers of the drawing. Disable the option to place each element 
on the current layer. 

ASC file import from project into project 
If the drawing to be loaded is part of project, the Import command can’t be 
used. In this case, use the Open Project command, and select the Import file 
and Merge to current drawing option. 

� See the Chapter 4.2.3. Opening project – Import file option. 
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4.5.2. DXF/DWG import/export 
DXF/DWG file format allows you to exchange your drawings with other CAD 
users. You can export or import even DWF (Design Web Format) files as 
well. You can quickly select the file format you wish to save your work in. 

4.5.2.1. DXF/DWG import 

Importing of files can be done in two ways: 
 

� with the drag & drop method: for example dragging from the Windows 
Explorer. 

� with the File menu –Import command, 

Importing using drag & drop method 
If we import into an active a 2D floor plan with the drag & drop method, the 
drawing will be imported to a given drawing. This way the unnecessary 
increasing of the number of 2D floor plan windows can be avoided. 
If we import into an active 3D window, the drawing will be loaded into a newly 
created window. 

Importing using File menu –Import command 
If we import into an active a 2D floor plan / 3D window with the File menu – 
Import command, the Merge to current drawing option is the default setting. 
This way the unnecessary increasing of the number of 2D floor plan windows 
can be avoided. 
 
The program is capable to process the latest DXF, DWG and DWF file 
formats and to load these files into your own project either as part of your 
project or as external references. 

� See chapter 11.13. External Reference. 
 
If a DXF/DWG file is imported and the file is placed in a new window, the 
floors are not available in this window. This way the number of real floor plan 
windows is not increased when a DXF/DWG file is imported. Architectural 
elements cannot be placed in this window, of course. 
If the goal is to place the DXF/DWG drawing as a base and build the model 
on it, when the file is imported, switch on the Merge to current drawing option. 
The drawing will be placed in the real floor plan window, the design can be 
continued. 
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� See the Chapter 4.5.1. Importing of ASC file into a project – using File menu 
–Import command. 

 
At DXF/DWG drawing import you can choose the following settings in the 
dialog. With these settings you can make the display of the imported drawing 
correct and fast. 
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Disable gradient hatch creation 
Importing of gradient hatches can slow down the displaying of the imported 
drawings in ARCHLine.XP® . To avoid this problem, it is possible to have all 
gradient hatches displayed as solid hatches. 
 
 
 
 

���� Gradient hatch is 
analogous to the Shade 
option in ARCHLine.XP®. 
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Explode dimensions 
With this option you can load the dimensioning exploded, so these will be 
handled as general drawing elements instead of real dimensions. The 
advantage is that the look will be identical with the AutoCAD® display. The 
drawback is that you lose the dimensioning properties. 

Explode dimensions with user arrow 
The look of dimensioning with user-defined arrows in ARCHLine.XP® is not 
the same as in the original AutoCAD® drawing. That’s why you have the 
possibility to explode these dimensioning. The advantages and drawbacks 
are the same as it was described above.  

Use line weight display setting 
In the File menu - Preferences - General - Other dialog there is a Line width 
ON switch. By selecting this option, lines will be displayed with their own 
thickness, otherwise all lines will be displayed with zero (the thinnest) 
thickness. 
 
In AutoCAD® drawings you can also apply the line weight settings. 
At file import it is possible to take over this setting. With this setting you will 
overwrite the Line width ON option found in the File menu - Preferences - 
General - Other dialog, and this option will be applied to the whole project. 
For this you have to select the Use line weight display setting option, so the 
program will use the AutoCAD® setting. 
 

���� If we have imported several of drawings into the project, the settings applied 
in the last drawing will be in force in the whole project, of course. 

Colour table handling 
A higher level of colour table handling is available in the imported drawings, 
too. 
The program is able to recognize the original AutoCAD® colours of the 
elements in the imported drawings, which can be modified later in the specific 
colour table. When you export a drawing like this, there is no need to convert 
the colours because the drawing uses the same AutoCAD® colour table. 
 

� See chapter Colour handling. 

Import 3D points / lines / arcs / circles 
By selecting this option, the points / lines / circles / arcs are created in the 3D.  
In this way the visualization measure up to the AutoCAD®  
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Extension of DWG import  
The AutoCAD DWG files can contain 3D surfaces, which are created by 
drawing out lines, arches, and polygons in 3D, by determining the so-called 
Thickness of the elements. 
You can also create such surfaces in the ARCHLine.XP® (see in 3D 
extension of line nature elements chapter), and the program can import the 
AutoCAD DWG files containing these elements. 
 

����  The AutoCAD creates a surface from the straight lines that it draws out 
the line into the space perpendicularly to that plane, on which it was 
designed. 

 

4.5.2.2. Export 

If you wish to send your work to your colleagues who use other CAD systems, 
for example, this is the simplest method you can use.  
 
In File menu - Export specify a file name and file type. 
 
If you select any of the dwg or dxf file formats, you can customize the export 
settings in the appearing dialog. 
 

 
 
The following options are available: 
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Explode 
You can export objects to other CAD programs in an exploded format (with 
lines). Select the objects you want to explode: walls, opening dimensions, all 
dimensions, texts and hatches. 
 
The aim of this function is the following: 
To offer the option to print drawings in AutoCAD® where the printed drawing 
will correspond 100% to that printed from ARCHLine.XP®. In this case, for 
example, it will not be a problem if certain fonts are missing from the other 
computer. 

Wall components 
You can explode walls in such a way that their main constituents (contour 
lines, hatches, doors, windows and opening dimensions) are placed on 
separate layers. 
 
The aim of this function: 
You can continue drawings in AutoCAD® using the groupings applied on the 
layers. 
Example: create a Wall contour line layer and use this layer for wall contours. 

File version 
You can choose from the released AutoCAD® versions. The exported file will 
be compatible with the selected AutoCAD® version. This way the exported file 
can be used by users with previous AutoCAD® versions. 

Scale 
You can rescale your drawing by setting a scale. 
 
The aim of this function: 
You can export your units of measurement to AutoCAD®. 
AutoCAD® will use mm in the exported drawing, so dimensioning will also use 
mm. You can define your units of measurement in ARCHLine.XP, e.g. if you 
set m, dimensions defined so far will be displayed in meters. This way 
dimensions in AutoCAD® will be given in m and mm (the program will display 
the values set in ARCHLine.XP® multiplied by 1000). To solve this problem, 
make sure to type 0.001 in the Scale factor field. 

Convert multiline texts 
AutoCAD® can use one-line and multiple-line texts. When exporting, you can 
define whether you want to export ARCHLine.XP®’s multiple-line text as 
multiple one-line texts or as a single multiple-line text. 
Experience shows that it is advisable to use multiple one-line texts. 
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Exporting buildings 
In the case of multiple buildings, you can define which building to export. With 
the building to be exported, you can also export the terrain of the plan. If you 
select the All building option, the terrain will also be exported to the 
AutoCAD® file. 

Export as 3D model 
You can specify whether you would like to export the plan view or the 3D 
model of the selected item. This way you can create plan view what contains 
special 3D elements 

 

Others 
Using these options you can enhance the appearance of your drawing 
elements in other CAD applications. 

� Export dimension measured value as text : the measured values of a 
dimension will be exported as fix values. This means that the dimension value 
of an element in AutoCAD® will not change automatically if you modify its 
size, for example. 

� Ignore invisible layers and its items : invisible layers and the elements 
belonging to these layers will be ignored during the export. 

� Export group IDs as attribute : the ID numbers of groups will be exported as 
block attributes (you can see them among the block attributes). 
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� Create log and audit files : during the export of a drawing two additional files 
can be created; a log file with the <filename>.log file name format and an 
audit file with the <filename>.aud file name format. The both files may include 
useful information for ARCHLine.XP® developers. Send these files along with 
the original end exported drawings to your local distributor if you find some 
errors in the exported file. 
 
Other export settings are available in the File menu - Preferences - Dxf and 
dwg export settings dialog. 
 

 
 
The following options are available: 

Export of hatches 
You can define hatch conversion rules between ARCHLine.XP® and 
AutoCAD® hatches. You can 

� add new rule by clicking the New button, 
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� delete a selected rule by clicking the Delete button, 
� modify a hatch pattern in the by clicking the  button, 
� modify a pattern proxy mode by clicking the  button. You can select either 

the Export as solid or the Explode options. Both selections will ignore the 
hatch conversion and only the ARCHLine hatch patterns will be exported in 
exploded or solid state. If you export exploded ARCHLine hatch patterns, the 
size of your exported file may increase substantially. 

Export of the patterns which are not in the list  
Because of the differences between CAD applications you may not find the 
proper rule for a hatch conversion or you simply do not want to create rules 
one by one. 
In that case you can export ARCHLine style hatches. 

� as exploded elements (Explode) 
� as solids (Export as solid) 
� as a hatch with the selected hatch pattern (Select a pattern). With this 

selection you can also specify the scale and rotation of the selected pattern. 
 

 

Dimension arrowhead export settings: 
Similar to the hatch conversion rules you can define conversion rules 
between ARCHLine and AutoCAD® arrowheads. You can add new rule to the 
list by the New button, delete a selected rule by the Delete button, or change 
an existing conversion rule by the  buttons. 

4.5.2.3. Settings: line type, font and dimensioning  arrow 
assignments 

• By clicking on the Settings button you can make assignments between 
AutoCAD® and ARCHLine.XP® for special AutoCAD® line types, fonts (true 
type fonts not found in Windows by default) and dimensioning arrows. The 
assignments are saved and you can use them afterwards. 

 

���� You can reach these settings through the File menu - Preferences - DXF 
and DWG import settings command. 
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���� The user’s assignments are stored in the _dxfass.xml file in the Support 
subdirectory of the installation folder. 
 
In all the three cases you can find the list of AutoCAD® elements in the 
column on the left, while the columns on the right side include the assigned 
ARCHLine.XP® elements. 

Modify 

• Click the arrow beside the ARCHLine element. 
• Select the appropriate element from the list. 

New 

• Click the New button. The program adds a new ARCHLine element to the end 
of the list. You can modify this element. 

• Specify the AutoCAD® element that belongs to the new assignment. 

Delete 

• Select the row you want to delete, and then click on the Delete button. 
 



250 4.5 Import/Export  

Manual 

In the imported file there can be line types, fonts or dimensioning arrows 
which are not listed in the table. After the file import: 
 

� These line types will appear as user-defined line types in ARCHLine. 
 

� The program tries to 
use the same font 
type as the original. If 
it is not found, the 
program asks for a 
substitution. 

 
� After specifying the 

font substitutions in 
this dialog you can 
save it into the font 
assignment list. 

  
 

� To the arrows not listed in the assignments, the program assigns the default 
dimensioning arrow. 
 

���� The Explode dimensions and the Explode dimensions with user arrow 
settings will override the arrow assignments, of course. 

4.5.2.4. AutoCAD ® style hatches 

In case of importing AutoCAD® drawings, default AutoCAD® style hatches are 
recognized automatically and handled differently from ARCHLine style 
hatches. This means that scaling and rotating are the only possibilities for 
AutoCAD® style hatches, similarly as users can do it in AutoCAD®. 
 

ARCHLine style hatch settings AutoCAD ® style hatch settings 
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AutoCAD® style patterns data are stored in the acpatterns.xml file. This file 
can be found in the Support subdirectory of the program installation. 

4.5.2.5. AutoCAD ® style hatch selection 

For the selection of an AutoCAD® style hatch: 
 

• Click the Pattern  icon in the Hatch properties dialog. 
• In the appearing window select the AutoCAD® style hatches option. 
• Double click on the required hatch. 
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• After that it is enough to select from the list in the Hatch properties dialog: 
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4.5.2.6. Merge to built-in patterns 

There are two categories of AutoCAD® style hatches. 
 

� AutoCAD® style hatches coming from the default program installation files are 
handled as Built-in category. 

� The user-defined AutoCAD® style hatches coming from the DXF/DWG import 
are put automatically into the Project category. In the Hatch parameters 
dialog these hatches are displayed with the same pattern and different 
names. 
 

 
 

Hatches in the Project category can be used only in the actual project 
(similarly to the new project materials). In a new project those will not appear 
automatically, therefore you have the possibility to move hatches from the 
Project  category to the Built-in category by clicking the Merge to built-in 
patterns  button. 
 

 
 

• Select pattern names from the Project category and click the right arrow 
button. 

• Click Ok to move the selected Project patterns to Built-in patterns. Later you 
can use these hatch patterns in any other project. 
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4.5.2.7. Limitation – maximum number of lines 

In the File menu - Preferences - General - AutoCAD® style hatches dialog you 
can set a limit for the maximum number of segment in a hatch. If any hatch 
on the drawing requires more segments than this limit, the drawing of hatches 
will stop when the limit is reached. By this the memory usage can be limited. 
This is handled analogous to AutoCAD®. 
 

 

4.5.2.8. Extension of DWG import  

The AutoCAD DWG files can contain 3D surfaces, which are created by 
drawing out lines, arches, and polygons in 3D, by determining the so-called 
Thickness of the elements. 
You can also create such surfaces in the ARCHLine.XP® 2009 (see in 3D 
extension of line nature elements chapter), and the program can import the 
AutoCAD DWG files containing these elements. 
 

����  The AutoCAD creates a surface from the straight lines that it draws out 
the line into the space perpendicularly to that plane, on which it was 
designed. 
 

4.5.3. 3DS Import 
ARCHLine.XP® program supports the using of objects given in 3DS (3D 
Studio) format.  
The objects imported in this way keep the materials assigned originally, too. 
You can import in three different ways: 
 

� With File menu – Import command 
� Dragging onto the drawing area by drag and drop 
� Dragging into the Design Center by drag and drop 

File menu - Import 
• Import any .3ds format object with the File menu - Import command. After 

clicking the Open button, the following panel pops up: 
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• Select the scaling and sizes you want to apply when importing the object. 

Click OK. 

Open 
If the object is not appropriate, here you can open another one. 

Choose object library 
In the Choose library dialog the program offers to save the object into the 
appropriate .oli library in the Design Center. After that the object can be used 
as an architectural element like any ARCHLine.XP® object saved into the 
library before.  
 
After selecting the library the 3D Model Decimation dialog box appears, by 
which you can reduce the number of polygon faces along with the size of the 
object. The size reduction often goes with the quality decreasing together, 
therefore we recommend the No decimation option and to go on.  
 

� See the Chapter 4.5.3.1. Optimizing 3D models when importing - Decimation 

Place 
The element is created as a 3D solid in the 3D window. In this case we 
recommend saving the 3D solid into the object library with the Building – 
Object – Define custom object command. The element saved in this way can 
be used as an architectural element thereafter. 

Dragging onto the drawing area by drag and drop 
You can drag and drop the object directly from the file manager. If you drag 
and drop the object onto the drawing area of the program, the above 3DS 
Import scaling dialog box appears.  
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Dragging into the Design Center by drag and drop 
If you drag and drop the object into the Design center, the program offers to 
save it to the appropriate oli directory displayed in the Choose library dialog 
box. 

4.5.3.1. Optimizing 3D models when importing - Deci mation 

Object management in the program is slow if the face number of detailed 3D 
objects is so high that it adversely affects the computing and space load of 
the program. In most cases rendering quality will not decline with the 
significant decrease of face number. In such cases, it is preferable to work 
with the optimized object instead of the original one. Optimization is 
performed by an algorithm rejecting faces least affecting the shape and the 
program will work with this algorithm speeding its operation. 
 
Optimizing is allowed in the case of importing 3D Studio drawings and 
dwg/dxf format drawings containing 3D objects. 
When importing 3D objects, the 3D Model Decimation  dialog box will 
appear, where you can decide about the scale, i.e. scale factor (scaling rate), 
which defines the rate of decrease in the original face number. 

� See the Chapter 4.5.3. 3DS Import. 
 
A significant difference as regards the face limit you can set in Preferences 
(File - Preferences - General - 3D preferences menu) is that in the case of 
face limitation the amount of information concerning the model will not be 
reduced, whereas the scaling of the 3D model will cause the shrinking of 
information about the model. 
 
In the 3D Model Decimation  dialog box you can select any of the following 
three options: 
 

� No decimation: the program will not optimize the model. You should select 
this option when working with simple objects, because this option keeps the 
original information content. 

� Intervals: in the case of interval decimation, you can define the decimation 
rate in accordance with the original face number of the object. 

� Simple:  in the case of simple decimation, the program decimates the model 
with one rate, regardless of the original face number of the object. 
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Decimation with intervals 

  

As a default, you can see those Max polygons, i.e. polygon number interval 
limits which the program will use. The program assesses the lowest Max 
polygon value, which exceeds or equals the polygon number of the imported 
3D object. Decimation will be performed with the rate associated with this 
number. If none of the Max polygons satisfies this criterion, the program will 
use the decimation rate defined for Other. You can edit intervals as follows: 
 

• If you want to edit an existing interval, double click on the Min polygons or the 
Ratio value and modify those values. 

• If you want to delete an existing interval, click on the line of that interval then 
click Delete. 
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• If you want to add a new interval, first type in the polygon number value and 
decimation value in the corresponding entry fields then click on the New 
button. 

• To reset default intervals, click on the Default button. 
• Close the dialog box by clicking Ok to start decimation. 

Simple decimation 

  

Enter the Min polygons data. If the polygon number of the imported object is 
smaller than or equals this value, the program will not decimate during the 
import, regardless of the decimation value. 

• Set the rate of Decimation. You can specify the exact value in the entry field 
or you can use the slide. In this case the program applies the rate of face 
number of the imported object estimated in terms of polygons. 

• Click the Ok button to close the dialog box and to start decimation. 

Example 
The following imported model had 47672 faces before decimation: 
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If we exclude 75% of the faces that is we specify a decimation rate of 0.25, 
the model in question will be simplified to a great extent, but at the same time 
computing will be easier and the shape of the model on the rendered picture 
will be equally visible. 

 

!!!!  If you don’t use the decimation, the program hides the common edge 
of those neighbouring triangles, which normal vector is the same. So 
unnecessary lines don’t cut up the surface of the object. The result appears in 
the vector graphics 3D dialog window at hidden lines, or on the rendering 
picture. The disadvantage of the method is that the object remains large.  

4.5.4. Online collection 
The Online Collection gives you the possibility to share and download objects 
or groups, even projects with the ARCHLine.XP community. 
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4.5.4.1. Export 

You can export Objects, Doors, Windows, Groups, Lamps or even projects if 
you open the File menu / Export / Collection dialog. 
 

 
 

� Click on the icon of proper button to start uploading a certain item 
� In the next step you can browse for an item, depending on your 

choice. 
� Finally, your selection starts to be uploaded to a temporary storage 

space and the Collection page will open. 
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� Please Log in, an follow the online instructions to finalize your 
upload. 

 
If you do not have a login access, please register,  or contact your 
distributor. 

 

4.5.4.2. Import 

You can import ARCHLine.XP Collection items, uploaded by other users.  
 
To reach this feature, please open File menu / Import / Collection. 
 

 
 
� Please choose an item type to start connecting to ARCHLine.XP 

Connection website. 
� Depending on your choice a webpage will open, where you can browse in 

different categories and items, uploaded by other users. 
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4.6. Managing templates 
The program uses templates during creating the plans. 
Template is a collection of predefined sets and preferences that can be used 
during the design work. 
 
When starting the program, the default template is automatically loaded. A 
part of the used sets are protected, others can be modified by the user and 
new ones can be created as well. 
By saving, new template can be created with .SET extend. You can set the 
new template as default in the File menu – Preferences – Template 
management dialog box. 
So starting new projects, the new sets are always available.  
 
(Some sets of the program are not saved in the template but the system 
configuration (registry) stores them. These sets are valid with any template, 
too.) 
 

4.6.1. The drawing template 
The management of your drawing template comprises the settings of the 
drawing surface and the overall properties of your drawing tools. You can 
save individual settings as part of the drawing template, which can facilitate 
and speed up the drawing process. 
 
The drawing template comprises the following: 
 

� display settings (grid, snap, cursor and … settings), 
� architectural settings concerning the drawing area (units of measurement, 

angles, ... , scale), 
� general and special properties of each geometric and architectural element, 

including cross-sectional view, 
� the sets made from elements features. From these sets are just saved to the 

project, which are used by the project,  
� hatch patterns and line types, 
� textures created by users, 
� shortcut keys. 

 
When saving the project, the drawing template will also be saved to the 
project; this drawing template will only be valid for that actual project, and the 
new project will not have the pre-set drawing template. That is why saving 
templates are necessary. 
 
You can save templates you create to the template file with a SET extension. 
Template files will be saved in the ARCHLine.XP2008/Support directory 
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under the name Template_eng_xml.set. The Template_eng_xml.set.def file 
contains the sets, which are delivered by the program. 

4.6.2. Setting your drawing template 
You have the choice of drawing in the same template every time you launch 
ARCHLine.XP®. 
 

• Start your new drawing with the File menu - New project command. 
• Define your display and architectural settings concerning the drawing area in 

the File menu - Preferences - General dialog box. 
• Using the relevant commands of the Properties menu, set the properties of 

the different graphical elements. 
• Create sets to facilitate the management of the different element properties. 

 
When the project is saved, the sets used in the project are saved in the 
project. New projects will not have these sets. 
 

� See Chapter 3.2.3. on Using sets of properties. 

4.6.3. Template file 
ARCHLine.XP® stores the template file in two file formats. 
 

� .def extend: this file contains the default preferences. The default sets saved 
in the Template file appear with grey icon in the elements properties window. 
You can’t modify or delete these sets. 

 
� .set extend: contains the added sets. This contains the default sets and the 

sets created by user. The sets created by the user are yellow in the dialog 
window.  

4.6.4. Saving templates 
When you have set all properties you need for drawing, save these properties 
as drawing template in the template file. 
You can select which default template file you wish to use in the File menu - 
Preferences - Template  dialog box, and save your drawing settings to this 
file. 
 
When you start a new project, it will contain the drawing template you saved. 
 

• Select the File menu - Preferences - Template function: 
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In the upper field you can see the name of the current template file displayed 
with grey characters:  
Template_eng_xml.set. 

Saving the template 
• Click on the Save button. The program will save the values set to the current 

template file. When restarting the program or starting a new project, this 
template file will be loaded with the values saved. 
 
The Save command changes just the content of .set file, the content of .def 
file (with default settings) remains unchanged.  

Saving as 
Create your own template file. 
 
If you want to store different drawings in different templates, you can save 
multiple template files. 
You can use this method in the following cases: different templates for 
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reconstructions and new buildings, multiple clients, approval and construction 
drawings. 
 

!!!! It is advisable to save your own drawing template in your own template file 
instead of the default file! 
 

• Click on the Save as  button. 
• In the dialog box popping up, type in the name of the template file. 

The program will use these settings at restart or when starting a new project 
only if you load your template file by clicking the Open  button. 
 
The save, like command result two new files: .def, .set 
 

!!!! The name of the template file cannot be longer than 50 characters.  

Selecting 
When you have created your template files, you may select any of them. 
From that moment on, the Save and Open  commands will refer to the 
selected file. 
 

• Click on the Select  button. 
• Select the desired template file in the dialog box popping up. 

Opening 
If you used invalid settings and have not saved the template file, you can 
reload the original template file. The name of the current template file is 
displayed in the grey field. 
You can load any of the saved templates if you want. If you created multiple 
templates, you have to load the appropriate template before you start 
drawing; otherwise the program will start with the settings saved in the 
Template_eng.set file. 
The opened template file will be the default template, so if you open a new 
project, this template file will be loaded.  
 

• Click on the Open  button. 
The program will load the template file marked with grey. 

 

!!!! Only those sets are saved in the project that is used by the project. It means 
that if you create a new set and that set is not used in the project, do not 
forget to save the template file, otherwise the new set will be lost. 
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Import 
In the elements properties window you can export the sets to a .set extended 
file.  
In the Template file management dialog window with the help of Import button 
you can add the added sets to the template file with .set extend.   
The import sets overwrite the actual sets.  

Export 
There is a possibility to export from the template file just the sets, 
preferences, shortcuts of the selected elements to a .set extended file. So 
you can add these preferences to the actual template file of ARCHLine.XP® 
program, which is on another computer, using the before mentioned Import 
button.  
 

• Add the name of the file. 
• Choose that groups, which sets’, preferences’ you would like to export.  

4.6.5. Template import wizard 

Import from former versions 
You can load the template files from ARCHLine.XP® former versions  
 

� With the Open  button (after it was selected). The program handles this file as 
a default template file. This means, that icons of sets will be grey.  
Or: 
 

� with the help of Template import wizard : 
After you have installed ARCHLine.XP® the Template import wizard appears 
by the first start. 
You have a possibility here to load automatically the template files, keyboard 
shortcuts, user objects used in ARCHLine.XP® former version to the actual 
program version.  
 
If you didn’t make this by first start, then use in File menu - Preferences - 
Template management dialog window the Template import wizard button. 
 

• Select the former program version (You can select from former program 
versions are installed on the computer).  

• Mark the Template file, Keyboard shortcuts or the Object libraries option, to 
import the proper elements to the actual version.  
 
Then the program looks for the former version automatically, and it’s  
 

� actual template file bind to the selected .set extension user template file,  
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� overwrite the keyboard shortcuts, 
� it saves the .oli files, made by user, to the ARCHLine.XP® oli folder, according 

to the selection. 
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4.7. Directory settings 

 
 
You can modify your default directory settings in the File menu - Preferences 
- General - File location dialog box in the case of the following directories: 

� Project default path 
 
It is useful to change directory settings when you work in a network, as this 
way other users can see the same materials and objects and they may save 
their drawings to the same folder. 
 

���� If you set the Project directory, the program will offer the last used directory 
when opening a new project. 
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4.8. Environment package 
 

The Environment Package allows you to move sets and settings, materials, 
objects, and many more between multiple computers to use the same 
environment everywhere. 

 
Just follow the typical configuration of packing and move in, or select Custom 
settings and adjust the contents of the package based on the actual needs. 
Using Environment Package 
 

4.8.1. Create package 

4.8.1.1. Create package – Typical settings 

You can pack the environment components into a single package and move 
to another machine. You can unpack the environment file on the second 
computer to have the same settings on it. 
 
When you click on the Create package button the following dialog will appear 
where you have to options to create an environment package file: Typical & 
Custom. 
 

 
 
When you choose typical the command collects all components and 
packages it into one file. This setting is the recommended for most of the 
users. Click on the next button to step to the next page, where you can define 
the path for the created file. 
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4.8.1.2. Create package – Custom settings 

When you choose Custom you can select the components to compress into 
the package. This option is recommended for those advanced users who are 
experienced in ARCHLine.XP settings and want to customize the package 
content. 
 

 
You can tick the option next to the files and settings which you would like to 
copy into the environment file. The following list is for your information to help 
choosing from the options. 
 

Set files 
If you enable the Set files option, the software will make a copy of the 
template file into the environment package. 
 

Registry settings 
If you enable the Registry settings option, the software will make a copy of 
the user settings stored in the Windows registry, into the environment 
package. 
 

Oli files 
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If you enable the Oli files option, the software will make a copy of the user 
created OLI files into the environment package. Oli files can be created 
multiple ways by the users (directly and indirectly), for example by 
downloading objects from Google 3D Warehouse.  
 

User created line types 
If you enable the User created line types  option, the software will make a 
copy of the user created line types into the environment package. 
 

User created hatches 
If you enable the User created line hatches  option, the software will make a 
copy of the user created hatches into the environment package. 
 

Pen Colour file 
If you enable the Pen Colour file  option, the software will make a copy of 
the ARCHLine.XP Colour – plotter pen assignment file into the environment 
package.  

 
User created materials 

If you enable the User created materials  option, the software will make a 
copy of the User created materials  into the environment package.  
 

XML files 
If you enable the XML files  option, the software will make a copy of the XML 
files  saved in the \ProgramData\Cadline\ARCHlineXP2011\Support folder 
into the environment package.  
 

Cabinet configuration files 
If you enable this option, the software will make a copy of the locally created 
cabinet configurations into the environment package file. These 
configuration files help you edit the cabinets by their original detailed 
settings, not only as an object. 
 

Command aliases 
If you enable this option, the software will make a copy of the locally 
modified ARCHLine.PGP alias configuration file. 
 

City images/locations 
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If you enable this option, the software will make a copy of the city images 
and locations that you can change in the Sun settings dialog. 

User created light types 
If you enable this option, the software will make a copy of the user created 
light. A user light can be created in the Light manager. 
 

User created toolbars 
If you enable this option, the software will make a copy of the user created 
toolbars. User created toolbars can be made by the Tools / Customize / 
Toolbars command. 

 
If you tick an option off in the list, the corresponding setting or file won’t be 
compressed into the environment file. When finished, please press the Next 
button. The program collects the necessary data and shows the following 
page. 
 

 
Press Commence and the software starts to create the environment package 
file. This can take long depending on the settings you enabled and the speed 
of the computer. 
 

 
While processing you will see the Please wait… text at the right bottom 
corner of the dialog. Please be patient until the final page appears. 
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Click on Show in directory to open the folder of the finished environment 
package in Windows Explorer. 
 
Click on the Information button to open the environment package information 
screen. 
 
Click on Done, to close the Environment Package dialog. 

4.8.2. Unpacking 

4.8.2.1. Unpacking – Typical settings 

You can unpack the content of a previously assembled single environment 
package into another computer. 
 
Click on the Browse button to find and open the environment package file. 
After opening it, you will see the name and path of the selected environment 
file. Click on Next to go to the next page.  

 
 
In the following page you can choose from the typical and custom settings to 
unpack the environment package. Click on Typical to unpack all the content 
from the package to this computer. 
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You will see the following page where you can start unpacking the file. 

 
 
Click on Commence to start the process and unpack all the settings and files 
that can be found in the environment package. 
 

 
While processing you will see the Please wait… text at the right bottom 
corner of the dialog. Please be patient until the final page appears. 
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You can close the dialog by clicking on the Restart ARCHLine.XP button 
which reminds you that after closing the dialog you should restart the 
software, before working with the new settings. 
 
Please do not forget to restart ARCHLine.XP after closing the wizard! It can 
lead to serious errors if you do not restart the software after unpacking the 
environment file! 
 

4.8.2.2. Unpacking – Custom settings 

You can unpack the content of a previously assembled single environment 
package into another computer. 
 
Click on the Browse button to find and open the environment package file. 
After opening it, you will see the name and path of the selected environment 
file. Click on Next to go to the next page.  

 
 
In the following page you can choose from the typical and custom settings to 
unpack the environment package. Click on Custom to control which part of 
the content you would like to unpack from the package to this computer. This 
feature is recommended only for advanced users. 
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When you choose Custom you can select the components to extract from the 
package. 
 

 
 
On the left side of the dialog you can find the settings that are compressed 
into the package file. If you do not see an expected option, it means that you 
might forget to pack it into the file when the package was created.  
 
If you would like to learn more about the options in the Custom settings 
please read through the corresponding part in chapter Create package – 
Custom.  
 
Click on Next to step to the following page.  
 

 
 
Please press Commence to start the package import. 
 

 
While processing you will see the Please wait… text at the right bottom 
corner of the dialog. Please be patient until the final page appears. 
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You can close the dialog by clicking on the Restart ARCHLine.XP button 
which reminds you that after closing the dialog you should restart the 
software, before working with the new settings. 
 

Do not forget to restart ARCHLine.XP after closing the 
wizard as it can lead to serious errors if you do n ot 
restart the software after unpacking the environmen t 
file! 
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5. Data entry 

You can define data (numeric and alphanumeric values, points and vectors) 
by using 
 

� the keyboard, 
� toolbar icons, or 
� pop-up menus. 

 
This way you can easily specify values and use special points and vectors, 
which greatly simplifies the drawing process. 
In the following we will look at how to define points and vectors. 

Defining points 
You can define the value of a point the following ways: 

 
� by typing X and Y global or local coordinates 
� by moving the cursor in the preferred direction and typing the length 
� by clicking on the drawing area 
� with snap grid 
� by using special points 
� by fixing coordinates, distance or vector. 

Defining vectors 
The vector of the drawing can also be defined in various ways: 
 

� with snap angle 
� by pressing SHIFT 
� HV indicator cursor 
� with arrows 
� with the Reference toolbar. 

5.1. Defining coordinates 
 
In ARCHLine.XP® , coordinates can be specified either globally, when the 
program calculates values in relation to the origin of the drawing, or relatively, 
when values are calculated in relation to the last point. 
 
This can be set in the Status bar. 
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Global coordinate input 
 

Coordinates, values are calculated in 
relation to the origin of the drawing. 
 
 

 
Relative coordinate input 
 

Coordinates, values are calculated in 
relation to the last point. 
 

 
If you press any key, the command line or input field on the drawing area 
comes up automatically depend on the File menu - Preferences - General - 
Shortcut icon menu - Enable Dynamic input option.  

� See the chapter 2.2.1. Defining values. 
 

• Enter the X and Y coordinate values, following each other, separated with a 
space: 

 or  
• Click Enter to close it.  

 

!!!! Starting the project we suggest you to switch on the Global coordinate 
input  and to place the first point of the drawing in the 0, 0. Later switch on 
the Relative coordinate input . In practice this simplifies notably to specify 
further points. 

 

Coordinate field 
Coordinate values can be attained from the coordinate fields in the drawing 
status line. 

 

 
 

In case of global input ( ), the field displays the 
absolute X and Y coordinates of the cursor. 
 

In case of relative input ( ), the field displays the DX and DY values of the 
cursor in relation to the last point. 
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5.1.1. Defining points with snap grid 
 
Snap grid is of great help when defining points. It locks the cursor into 
alignment with the grid points. 
 
You can enable this option with the Tools menu - Snap command. 
 

� See grid settings in detail in chapter 2.10 Screen settings. 

5.1.2. Defining points by using special points 
ARCHLine.XP® offers many possibilities to specify points in a simple way. 

Defining a special point with Reference commands: 

� See in detail in chapter 2.9.5 Reference toolbar. 
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5.2. Defining angle 

5.2.1. Direction by triangle 

Simple survey 
In the example below we demonstrate a very simple method for surveying. 
This method is not so complex like the survey module of ARCHLine.XP® but 
you can quickly define irregular rooms with a help of it. (As it is known, in the 
survey module the program uses a room-based surveying method, by which 
the walls with uneven thickness are come into existence.) 

The method is the following: 
Starting from the corner point, 
measure 1 meter distance on the two 
adjacent walls. Using the constructed 
triangle gained from the measured 
data, the direction of the second wall 
relative to the first can be defined by 
the program. With this you can avoid 
the measuring of angles. On the figure 
the value of a is 1 m, b is the 
measured hypotenuse. 
 
Following this method it is easy to 
create the floor plan below: 
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• Draw the first wall. 
• When you get to point B, choose 

Direction by triangle command on the 
reference toolbar 

• The program asks for point A, which is 
located on the wall 1 m far from point 
B. Move the cursor downside along the 
wall ant type 1 m. At this point you 
have got the point A. 

• In the appearing dialog enter the 
length of hypotenuse b. 

 

 

 
 

• The direction of the second wall becomes fixed because of the triangle. Enter 
the length of the second wall. 
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5.2.2. Defining direction with Angle snap 
Angle snap limits the placing of the second point correlated to the first one. 
The second point is gravitated to the nearest fix angle. The default angles are 
the following: 0°, 45°, 90°, 135°, 180°, 225°, 270°, and 315°. 
 
You can define the values of the 
angle snap in the File menu – 
Preferences – General – Snap Grid 
dialog box. 

� See the detailed description in 
2.10.2. Defining direction with Angle 
snap chapter. 
 

 

Angle snap 
Select this option to enable or disable angle snap. 
If you enable angle snap, the cursor can only move towards the defined 
directions. This is a very strong control and can be used only in special 
cases. We recommend that you disable this option. 
When you define Length or press the Shift button, the program finds the 
default angles even if the Angle snap option is disabled. 

Ortho snap 
Using the Tools menu - Ortho command you can switch on the ortho snap. In 
this case you can move the cursor into horizontal and vertical direction.  
If the Angle snap and the ortho snap are switched on the program prefers the 
ortho snap. 

Using angle snap with disabled snap option 
When you have specified the first point of an element: 

• Move the cursor to the desired direction. 
• The program is waiting for you to specify length or distance. 

Enter the appropriate values. 
• The second point snaps to the nearest special angle. 
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Example: 
To draw a 3,05 m long horizontal 
line: 

• Specify the starting point. 
• Move the cursor near the 

horizontal direction. 
• Enter the value: 3.05. 

 
 

5.2.3. Direction control by using the Shift button 
You can also enable Angle snap  by pressing the Shift button. If you press 
the Shift button continuously, the cursor moves towards the nearest 
predefined direction. After defining a direction, you can carry on with the 
command you want to apply. 
The Shift button is most frequently used to reinforce vertical or horizontal 
directions. 
You can combine Shift with cursor snap. With the help of the last three icons 
of the Reference toolbar, you can define which reference direction of the 
selected reference point to intersect the locked direction to specify a new 
point. 

 

�  Reference direction perpendicular 

�  Reference direction horizontal 

�  Reference direction vertical 
 

���� If you do not use the icons, the reference direction will be defined by the 
actual status of the icon last used. Perpendicular is the default direction. 
These icons can also be used when the direction is not controlled by Shift, 
but specifying direction is contained in the command e.g. modifying the 
length of a simple wall. 

5.2.4. Defining direction with the HV cursor 
The HV indicator cursor can also show horizontal or vertical direction. You 
can enable the cursor in the File menu − Preferences − General − Other 
dialog box. 
The HV indicator cursor appears when you select a point and move the 
cursor in horizontal or vertical direction. (In this case, recognizing a special 
point also means selection.) 
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5.2.5. Defining direction with arrows 
You can define in which direction to create an element with the arrow  keys of 
the keyboard. 
In this case the arrow keys substitute the direction definition of the polar 
coordinate. 
 

 

• Press any arrow button to define drawing 
direction . 

• Specify the length  of the element to be 
created. 
 
The program creates the element of the 
specified length in the direction defined 
by the arrow. 

5.2.6. Defining direction with Reference toolbar 
You can use the Reference toolbar icons if you have to specify an angle 
different from the default directions. 
You can define directions with an angle, you can use the angle of an existing 
element or you can lock a direction. 
 

� For description see Chapter 5.1.3 Defining points by fixing coordinates, 
distance or vectors.  
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5.3. AutoCAD ® compatible coordinate input 

The comma as separator 
Opposed to the conventions in ARCHLine.XP® 2007 you can use the comma 
as separator for coordinate inputs. For this you have to switch off the Comma 
(,) in Decimal point allowed option in the File menu - Preferences - General - 
Other dialog.  
 

 
 
For example if you want to draw a line from point X=0; Y=0 to point X=3; Y=4, 
it is enough to do the followings: 

• Start the line drawing command. 
• Type 0,0 and press Enter to specify the coordinates of the start point of the 

line. 
• Type 3,4 and press Enter to specify the coordinates of the end point of the 

line. 
 

���� By switching off the option the comma (,) is interpreted as a separator 
instead of a decimal point. Use the dot (.) character for decimal point. 
 
You can specify relative or global coordinates.  

Set the Global / Relative coordinate  icon in the status bar to  global.  
With this setting the coordinate input works as follow: 

Absolute coordinate input 
In case of absolute coordinate input the syntax is the following:  
X,Y ENTER  
In that case the global origin is taken into consideration and the coordinate 
input is relative to this point. 
 
The symbol of the global origin on the floor plan is represented as follows:  
 

 

Relative coordinate input 
In case of relative coordinate input the syntax is the following:  
@X,Y ENTER  
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In that case the last specified point is taken into consideration and the 
coordinate input is relative to this point. 
 
Use this possibility if it is easier to specify a point relative to previous point 
than specifying the global coordinates.  
 

���� If the Global / Relative coordinate  icon is set to  relative, it is enough 
to use the X, Y ENTER syntax for the coordinate input. 

Polar coordinate input 
Often you know only the angle and length values. In that case use the polar 
coordinate input. It can be very helpful if you wish to draw a line with a length 
of 2.53 m and an angle of 32°. You can specify abso lute or relative polar 
coordinates as well. 

Absolute polar coordinate input 
In case of absolute polar coordinate input the syntax is the following: 
numR<numFi, where 
numR is the distance from the global origin, 
numFi is the angle. 
  

���� Use this input method when you know the distance and angle relative to the 
global origin. 

Relative polar coordinate input 
In case of relative polar coordinate input the syntax is the following: 
@numDr<numFi , where 
numDr is the distance from the previously specified point, 
numFi is the angle.  
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6. Views 

6.1. Setting view 
When you draw it is very important to be able to change the view of the 
windows you are using. Changing View can be e.g. increasing or decreasing 
the apparent size of elements in the drawing, moving views of drawings or 
refreshing drawings. 
In the 3D window you can set the view of the model; you can set named 
views, axonometric or perspective. 
You can also set how to display elements in 3D. You can set named views, 
wireframe model, hidden lines, shaded or colour modes. 
 

���� You can restore and display an architectural element displayed in the 3D 
window with the Show on floor plan command. 

6.1.1. View toolbar 

� See the detailed description in 2.9.6. 

6.1.2. Enlarging with View menu - Zoom 
With the View menu - Zoom  commands and the Zoom all in all windows 
command you can increase or decrease the view. 
Zoom contains the following commands:  
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� You can also activate these commands from View toolbar. For description, 
see the previous chapter: 6.1.1. View toolbar. 

6.1.2.1. Zoom out 

Decreases the size of the drawing with the specified value. Proportions do not 
change in the window. 
 

• Define the view box by its two opposite corners. 

6.1.2.2. Zoom all in all windows (F10) 

The command modifies the zoom scale so that the whole drawing (all visible 
elements) would be placed within the window. The same is done in each 
window. 
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6.2. Building 3D models 
The program offers several possibilities to create a 3D model of the designed 
building. You can display all elements of the model on every floor, or just 
certain floors or selected elements or a selected part of the model. 
The command can be activated from: 
 

� the View menu - 2D -> 3D  submenu. 

� the Status bar -  Build 3D model  icon, and 
� the F3, Alt +F3 , and Alt + T  keyboard shortcuts. 

 
When you create new 3D models, the program opens a new 3D view window 
to display the 3D model of the floor plan. 
 
The model is shown in the Show hidden element display mode. This means 
that every element is displayed with hidden lines, but the elements do not 
hide the edges of other elements. You can change settings with the 3D 
toolbar icons. 
The 3D view follows the changes made on the original drawing. 

6.2.1. 2D -> 3D 
The menu contains the following commands to create and display a 3D 
model: 
 

 
 

���� The commands don’t modify the element itself, only the 3D appearance of 
it. 
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6.2.1.1. Building 3D view - by classes 

 
To display the Build 3D model  dialog box, go to the View menu - 2D -> 3D - 

By classes  command, or click on the  Build 3D model  icon in the 
Status bar . 
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Elements 
• Select the element types to display in 3D or click the box on top to select all 

elements. 

Floors 
• Select an option: 

 

Active floor 
The program only displays the active floors of the building. 

All floors 
All floors are displayed. 

Select floor 
For more complex buildings with a number of floors it is not enough to use the 
Active floor or All floors options to create the proper details of the 3D model. 
The Select floor option enables more varieties in the 3D model 
representation: 
 

• The Select floors dialog appears. 
• Select the floors from you wish to include in the 3D model generation. Use 

the SHIFT or CTRL keys for multiple selections. 
• Click Ok to close the dialog. 
• To change the floor selection, select either the Active floor or All floors option 

first, and then select the Select floors option again. 

All buildings 
Enable this option if you have more than one building in the drawing and you 
want to display all of them in 3D. If this option is disabled, the program only 
displays the active building. 
 

� Read about managing multiple buildings in Chapter 3.4. Floor management. 
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Settings 

With laminate 

• Enable this option if you want to display the layers of the walls. 

Slab beams 

• Enable this option if you want to display the beams of slabs.  

Wall - slab - roof cutting 
With this option you can fit: 
 

� wall to slab, 
� slab to roof, 
� wall to roof. 

 
If you enable this option, the program automatically cuts the walls higher than 
the roof where they intersect it. To do this, you have to enable the cut option 

in roof properties.  

Similarly, slabs overhanging the roof,  and walls reaching beyond the 

slab are cut. To do this, you have to enable the Slab cut option in the 
Slab general properties dialog box. 
 
Off  On 

  

Keep 3D of this project 
If you enable this option, the program creates a new 3D model only for the 
selected element types, while keeping the contents of the previous 3D 
display. 
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Delete entire 3D model 

If you disable the Keep 3D of this project option, the Delete entire 3D model 
option comes up. If you enable this option, it deletes the entire 3D model and 
creates a new one. 

Create tiles 
Enable this option to display the tiles that belong to layers of the wall or the 
slab. After enabling this option you can create tiles with zero or real width. If 
you use zero width, it significantly speeds up the display. 
 

Resolution 
With resolution you can set the smoothness of arched surfaces. The higher 
the resolution is, the smoother the arched surfaces are. However, high 
resolution can greatly slow down the speed of display. 
If you select high resolution, you can set the precise resolution value. 

 
 

Low Medium High  
 
OK Closes the dialog box. 

6.2.1.2. By selection (F3) 

Displays the selected elements in 3D. 
 

• Select the elements you want to display in 3D:  
Enter  Completes the selection. 

6.2.1.3. By rectangle (Alt + F3) 

A rectangle-based block cuts the three-dimensional model; the outside parts 
are discarded and the rest is displayed. This command only selects and cuts 
elements on the active floor. 
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• Define the view box by its two opposite corners. 

 

6.2.1.4. By rectangle - on all floors (Alt + T) 

A rectangle-based block cuts the three-dimensional model; the outside parts 
are discarded and the rest is displayed. 

• Define the view box by its two opposite corners. 

6.2.1.5. By polygon 

A polygon-based block cuts the three-dimensional model; the outside parts 
are discarded and the rest is displayed. This command only selects and cuts 
elements on the active floor. 
 

• Define the points of the polygon. 

� If you need help to draw a polygon, read the description of Polylines   

 in Chapter 11.2.2. Commands for drawing lines. 

6.2.1.6. By polygon - on all floors 

A polygon-based block cuts the three-dimensional model; the outside parts 
are discarded and the rest is displayed. This command only selects and cuts 
elements on the active floor. 
 

• Define the points of the polygon. 
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6.2.1.7. Outside the profile 

A profile-based block cuts the three-
dimensional model; the outside parts are 
discarded and the rest is displayed. This 
command only selects and cuts elements 
on the active floor. 

• Select the POPMENU keyword in the 
command line and define the type of profile 
in the Profile definition menu. 

 

6.2.1.8. 2D floor plan to 3D 

Using this command you can represent your 2D floor plan in the 3D model 
space as well.  
The components of the floor plan − simple vector entities like lines, polygons, 
arcs, dimensions − are visible together with your 3D model. This way you can 
visualize the imported source data, such as DXF and DWG files or imported 
sketches together with the newly created building model containing walls, 
windows, doors, columns and other objects 
 
This example shows a part of an imported DWG drawing, and the newly 
created 3D model  
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 � 

. 

6.2.2. Creating 3D models with keyboard shortcuts 
You can also create 3D models with keyboard shortcuts. These are 
summarized in the following table: 
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Alt + T 
Creates a rectangle, which cuts the model. The part of the 3D 
model which is enclosed in the rectangle becomes visible in the 
3D view. The program displays the elements of all floors. 

Alt + F3 

Creates a rectangle, which cuts the model. The part of the 3D 
model which is enclosed in the rectangle becomes visible in the 
3D view. The program only displays the elements of the active 
floor. 

F3 

Select an element and press the F3 button. The 3D model of 
the selected element appears,  
or 
if nothing is selected, press the F3 button. Select the elements 
on the floor plan you want to display. The program only displays 
the elements of the active floor. 

 

If you select an element and click the Build 3D model  
icon in the Status bar, the program only displays the selected 
elements in 3D. 
In this case the program does not activate the Build 3D model 
dialog box, but applies the previous settings. 

6.2.3. View menu − Refresh 3D 
This command enables to refresh the 3D model. A tick marks if the command 
is enabled. 
If you set on, every modification of the floor plan becomes visible in the 3D 
view.  
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6.3. 3D views 
After creating the model, you can display it in different views. When a 3D 
window is active, to set views you can use: 
the View menu −−−− View Properties −−−− Define View  dialog box, or 

� the last six icons of the 3D view toolbar   for the 
main views: right side view, front view, top view, axonometric view, back view, 
left side view or 
 

� the elements of the 3D view  shortcut menu, which comes up if you right-click 
the header of a 3D window. The commands of the shortcut menu are the 
same as the commands in the View  dialog box. 
 
When you apply these views, the contents of the open window are not 
deleted; the selected view appears in the actual representation mode and 
with optimal zoom. 
While working you can use different views at the same time in different 3D 
windows. 

6.3.1. View menu - View Properties – Define View  
You can choose from the following views in the dialog box: 
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Add new 
With this command you can save the current 3D projection and assign a new 
name to it. This new view is added to the list of default view options so later 
you can select this view from the list too. 
This command is useful mainly when you save different perspective 
projections.  

Delete new 
You can delete a 3D projection that you previously added to the list.  

6.3.1.1. Original 

Restores the original view and deletes all relative view transformations from 
the current window. 

6.3.1.2. Perpendicular projections 

These are the following:  
Top view, front view, left and right view, bottom and back view. 

6.3.1.3. Work plane on surface 

You can define the view with a plane surface of a selected object. It means 
that the view is the plane surface defined by the object’s surface area. 
The normal vector of the object surface aims at the viewer.  
In this case the origin of the local 3D coordinate system is the perpendicular 
projection of the global origin on the work plane. 
 

• Select the desired surface, or 
if it is not clear which surface to select, first click on the Select Solid  and click 
a certain surface of the desired solid. 
 
ENTER Accepts the selected surface, or 
NO Select another one. 

6.3.1.4. Work plane by 3 points 

You can define a view by three points of a work plane. 
 

The first point defines the origin of the local coordinate system. The second 
and the third points define a vector, which determines the direction of the 
local x axis (its projected image is horizontal). The normal vector of the view 
is a vector perpendicular to the coordinate system that was defined by the 
three points. 
 

• Specify the origin of the view. 
• Specify a point on the positive x axis of the local coordinate system. 
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• Specify another point of the view. 

6.3.1.5. Axonometric 

Automatically creates an axonometric view. 

6.3.1.6. Dimetric 

Automatically creates a dimetric view. 
 

Axonometric Dimetric  

  

 

6.3.1.7. Current perspective 

Applies the last set perspective to the selected 3D window. 
 

� You can read about perspective in detail in Chapter 6.3.3. Perspective view. 

6.3.2. 3D view toolbar - Named views 

 
 

Right view Displays the right view of the model in the 3D window. 

 
 

Front view Displays the front view of the model in the 3D window. 

 
 

Top view Displays the top view of the model in the 3D window. 

 
 

Axonometric Displays the axonometric view of the model in the 3D 
window. 

 
 

Back view Displays the back view of the model in the 3D window. 

 
 

Left view Displays the left view of the model in the 3D window. 
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6.3.3. Perspective view 
You can set the 3D perspective view in the main menu: View – View 
Properties – Perspective view or press the perspective view icon on the 
Navigation Bar. The view is resizable, and on the left side you can see the top 
view of the model by default. 
 

 
Also, when the project contains more than one 2D drawing, by clicking on the 
2D view icon, a pop menu will appear letting you choose the one that 
contains the proper drawing. 
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6.3.3.1. View settings - camera handling 

You can easily set the desired view by the camera, which you can find in the 
3D view in the Perspective dialog window. 
 

 

Camera tool 
The camera tool displays the camera (blue point), the point of view or subject 
(grey point), the connection of the camera and the point of view (red point) 
and the angle (green dots) with different colour of markers. You can move the 
markers easily with the “Drag and drop” method.  
The following camera handlings can be implemented using the 
aforementioned markers: 

Viewpoint setting 
You can set your viewpoint by moving the camera’s marker. The viewpoint 
always looks at the point of view or subject. The Viewpoint and the Point of 
view together set the view direction. 

Point of view setting 
You can set the point of view or subject by moving the correct marker. The 
viewpoint always points to the subject. The Viewpoint and the Point of view 
together set the view direction. 

Angle setting 
You can set the field of view of the camera by moving the corresponding 
markers. 

Camera handling (dolly) 
You can move the camera by moving the camera-marker. In this case the 
viewpoint will move with same extent and direction as the camera. Therefore 
we call this style of camera handling as dolly, also used to call in the film 
production, where the camera is moved by a cart. 
Thus the direction of the camera view is remain, only the spatial position 
changes. 
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6.3.3.2. Custom view handling 

It is possible to save the individually set views. With this feature you can save 
your favourite viewpoints and recall them precisely any time. 

Saved views list 
You can check your custom viewpoints in the Saved views list. 

 

Add view 
New views can be added to the Saved views List by using the Add view 
button. A new view will be added to the View List, which can be renamed 
anytime by clicking on it. 

Delete view 
You can delete a view from the Saved views List with the Delete View button. 
Warning! The deletion of the selected view will happen immediately and 
cannot be undone. 

View properties 
You can edit the settings of the currently selected view by using the View 
Properties button. You can change the name and angle and set the details of 
the Camera and Object Position, which is updated and saved into the 
selected view automatically by pressing the OK button. 
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Switch between Views 
You can switch between previously saved Views by clicking on the name of the 
appropriate View. This previously saved View will be activated and will be displayed 
in the 3D View window when you press the OK button. 

6.3.4. Define view by two points 
Defines the perspective view by observer and observed points  
Before: 
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After: 

 

6.3.5. Navigation in 3D 
You can navigate in the model with the following tools. 
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� Definition of the origin of rotation 
� Rotation 
� Zooming 
� Shifting 

6.3.5.1. Definition of the origin of rotation 

The origin of rotation can be defined differently in axonometric and 
perspective views. 

Axonometric 
The origin of rotation is specified by the origin of a small co-ordinate system. 
The origin of rotation can be changed by the relocation of this co-ordinate 
system. 

• Click the Navigation bar - New rotation centre icon. 
• Specify the new origin of rotation. 

Perspective 
In perspective view the origin of rotation is the observed point. You can 
modify this many ways, for example in the Perspective settings dialog. 

6.3.5.2. Rotation 

You can rotate the model around the origin of rotation with: 
 

� Shift + mouse wheel button pressed 
� Arrows on keyboard 
� Navigation bar 

6.3.5.3. Zooming 

You can zoom the model with: 
 

� Scrolling the mouse scroll 
� Shift + mouse right button pressed 
� Double click with the scroll button will zoom all 
� Navigation bar 

 
In perspective view, zooming means the modification of the distance between 
view point and observed point. 

6.3.5.4. Shifting 

You can shift the model with: 
 

� Mouse middle button pressed 
� Navigation bar 
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6.3.6. Background image 
You can load a background image in the 3D Image window. This will not 
necessarily affect the rendered image. Background image for rendering can 
be set differently. 
 

• Click the View menu – View Properties – Background image command. 
• Select the background image in the appearing dialog. The image size 

information appears below the image file path information. The background 
image always fills the Image window, independently from its size. 

• Use the Delete button to remove the background image from the window. 

 
 

6.3.7. 3D window graphics settings 
3D window graphic settings are the following: 
 

� Render settings 
� Shadow 
� Sunlight 
� Camera 
� Visual effects 
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�  
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6.3.7.1. Render settings 

Render type 
With the options found here you can set the rendering type used for the 
representation of the model. 
 

 
 

Wireframe 
In wireframe representation each edge of the model is visible. 

���� You can also display a wireframe model with the 3D view toolbar  
Wireframe model  icon. 

Hidden line 
In hidden line representation the program displays only the edges of the 
model that can be seen from the current view. The program doesn’t display 
the hidden lines in the background. 

 

���� You can also display hidden-line removal with the 3D view toolbar  
Hidden lines  icon. 
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Shaded 
Shaded means that the surfaces of the model are represented with the colour 
properties specified for the used materials. Only the surfaces that can be 
seen from the specific view are displayed. 

Material colour (With wireframe) 
This representation is the combination of Shaded and Hidden line rendering 
types. 

  
 

Textured 
Textured representation means that the surfaces of the model are displayed 
with the texture properties specified for the used materials (if the texture 
property is not specified for a material then the material colour is used 
instead). Only the surfaces that can be seen from the specific view are 
displayed. 

Textured (With wireframe) 
This representation is the combination of Textured and Hidden lines 
rendering types. 

  
 

X-ray 
The X-ray rendering type is similar to the Textured (with wireframe). The 
difference is that non-transparent surfaces become transparent and therefore 
the structure of the model can be overviewed in unique and spectacularly 
way, similarly to an X-ray photo. 
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X-ray transparency (%) 
When X-ray is selected from the Render type options, you can specify the 
amount of transparency. You can specify a value between 0% and 100%. 

Texture shading 
You can change the strength of the texture shading effect. 

Dynamic section transparency 
You can change the transparency of the dynamic section plane in the 3D 
model window. 

Approximation lines 
For the representation of arc surfaces you can switch on the displaying of 
approximation lines. 

Transparency 
Using this option you can make the edges behind surfaces with transparent 
materials visible. 
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Lights 
You can set the visibility of light sources in the 3D model. You can choose 
from the following options: Off, Light solid only, Light effects only and Light 
solid and light effect. This option doesn’t control whether the lights are on or 
off but their visibility only in the 3D model windows. 

6.3.7.2. Shadow 

Show shadows 

 

Always 
The shadows will appear continuously. Choose this option only with proper 
computer configuration; otherwise the moving of the model will slow down 
considerably. 

Except while moving 
With this option selected the shadow will appear only when the model is 
staying. 

Never 
With this option the model will appear without shadow. 
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6.3.7.3. Sunlight 

Enable sunlight 
With this option you can enable or disable the sunlight effects in the 3D 
content window.  

Ambient factor 
It shows how the materials react to ambient light depending on the sunlight. 

Diffuse factor 
It shows how the materials react to diffuse light depending on the sunlight. 

Specular factor 
The intensity of shine is important primarily in case of arc surfaces, 
depending on the sunlight. The colour of shining of the material with specular 
factor property can be specified here. 

6.3.7.4. Camera 

Walk speed 
It is called walking when we move in the model with the move keys. The 
speed of walking can be specified here. The measure of this is meter/second. 

Run speed 
It is running when we move in the model with the move keys, while the ’run’ 
key is pressed and hold. The speed of running can be specified here. The 
measure of this is meter/second. 

Enable camera light 
With this option the camera light can be switched off and on.  
It is recommended to use this option switched on. 

Ambient factor 
It shows how the materials react to ambient light depending on the camera 
light. 

Diffuse factor 
It shows how the materials react to diffuse light depending on the camera 
light. 
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Specular factor 
The intensity of shine, depending on the camera light is important primarily in 
case of arc surfaces. The colour of shining of the material with specular factor 
property can be specified here. 

6.3.7.5. Visual effects 

Properties that can be set in the Visual effects group are equal with the ones 
we have already mentioned in chapter Visual effects settings in the 2D 
window, completed with Hardware mesh handling and Texture quality. 

Antialiasing cursor 
You can enable cursor antialiasing, which results smoother cursor lines. 
Cursor lines appear in many cases during the drawing process, for example 
when drawing a line, a wall or other item. 

Antialiasing 
Antialiasing can make the lines of the 2D or 3D content smoother. It has the 
following options: 

Off 
Only in 2D 
Only in 3D 
in 2D and 3D 

With these options you can turn on or off antialiasing in the corresponding 2D 
and 3D content windows. 

Hardware vertex processing 
Hardware vertex processing can be used with video cards with large memory. 
In case of hardware vertex processing the whole model is stored in the 
memory of the video card and therefore the result of this is a much faster 
work. 

Texture optimization 
Using this setting, the program will apply antialiasing only to the visible 
content of a window, while the appearance of the content outside the window 
(which is not visible) is simplified substantially. 

FPS limit 
FPS stands for frames per second or images/second. When the program 
detects that it is not possible to keep the limit value, it starts to simplify the 
representation of the content by texture optimization. 
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Model optimization 
When a given (%) change has been made in the project, the program checks 
whether the FPS limit can be kept or not. If no, then it switches on the texture 
optimization automatically to increase the speed. 

Texture quality 
Here you can specify the representation quality of the materials used by the 
model in 3D windows. Depending on the selected option the program may 
override the original texture resolution and represents the materials of the 
model with poorer quality than the original. 
The following options are available: 
 
Low 
Medium 
High 
Maximum 

Example 

  
 

Low   Medium 
 

  
 

High  Maximum 
 

  

6.3.8. Shadows 
When you have a hidden-line or coloured or textured model, you can display 
shadows. 

� In case of 3D Image window, the Shadow output depends on its property. 
See chapter 13.3.4. Shadowing or shading in the 3D Image window.  
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Shadowing - Light direction 
Two types of shadowing are distinguished in architectural design: 

Sun shadow 
In this case the position of the sun is defined by azimuth and zenith values. 
The position of the sun is the same as the value set in the Sun settings dialog 
box. 
Click on Set to specify values. 

Elevation shadow 

In the case of elevation shadow,  the sunray comes from a very distant point 
and reaches the building in an angle that you define. Usually this angle is 45° 
or 135°, depending on whether the light comes from left or right.  
Click on OK to specify values. 
 

 
 
You can define the light source vector 
with its angle formed with the XY plane 
(1) and with the angle formed with the 
current work plane (2). 
 
Technical shadow is mainly displayed in 
the main views. 
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In these two front views you can observe the difference between the technical 
shadow and the sun shadow: 
 

 
Elevation shadow Sun shadow 

 
The models are displayed in hidden-line mode. In both cases contour lines 
and hatches indicate the shadow, but shading is not added to the models. 

Shadow on vector graphics 3D view 
Besides light direction, you can specify how to display the shadow: 
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The shadow can be displayed with contour lines or with contour lines and 
hatches. Click on the icon to set hatch properties. 
 
If you choose without shadow, no shadows appear on the model, so you can 
set a shaded image. 
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In the previous figure the shadow is made up of contour lines and hatches. 
Let’s compare it with the next figure, where we only displayed the contour of 
the shadow.  

 
 Shadow without hatches 

Position of the contour line 
Once you decide whether you want the shadow with contour lines or with 
contour lines and hatching, you can define on which layer to apply the 
contour lines. This way you can separate the lines from the model. The 
contour line is always black. 
In the hatch general properties dialog box you can specify on which layer to 
apply hatching. 
 

 

Shading 
In this dialog box you can set the parameters for shading a model. The model 
can be displayed in hidden-line mode, with material colour or hatched with 
texture pattern. 
 

 

No (Hidden lines) 
Displays the model in hidden-line mode. 
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Material colour 
 
You can display the model with the colours assigned to the materials. If you 
turn off the shadow (Without shadow) option, you get a shaded image without 
shadow. The colour is the same as the one assigned to the texture in the 
Material properties dialog box. 
 

 

 
With material colour, without shadow 
 
If you click on the Types to colour  button, you can give, that on which 
elements apply the program the colouring. So for example, you can switch off 
the colouring of objects, which is very time-consuming in the vector graphics 
3D window.  

With texture pattern and background colour 
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You can display the model filled 
up with the hatch assigned to 
the materials and shaded with 
the background colour of the 
hatching. If you turn off the 
shadow, you get a hatched 
image without shadow. 
The colour is the same as the 
hatch background colour 
assigned to the texture in the 
Material properties dialog box. 

 

 
With texture pattern and background colour 
 

���� You can also display the shaded model with the 3D view toolbar  
Hidden lines with hatch  icon, which creates the shaded model or the 
model hatched with texture pattern depending on the values set. 

Transparency 
You can set whether the glass surfaces are transparent in the vector graphics 
image or not. 
 

 
 
Let’s see some examples for technical shadow with different settings: 
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Shadow contour + Material colour  Shadow contour wi th hatches + Material 

colour 
 

  
Shadow contour + Texture  Shadow contour with hatch ing + Texture  
pattern  pattern 

 

���� To disable Hidden lines with the hatch command press the 3D view toolbar 

 Hidden lines  icon. 

Face limit 
When you want to display a 3D model you can define the number of 
displayed surfaces. If there are too many surfaces, the number of the 
displayed surfaces can be decreased, so the display of the model can be 
optimized. 
 

 
 
In brackets you can see the number of the model’s surfaces. We set the 
initial limit to 30000. 
If the model has more surfaces, the difference is ignored. 
The algorithm is the following: 
in static cases (3D model, rendering), the program examines the size and the 
distance of the surfaces. It ignores certain surfaces on the basis of the result 
of this multiplication. This means that nearer, bigger surfaces remain, the 
smaller, further surfaces are ignored. 
In dynamic cases (OpenGL, DirectX) the program only examines the size of 
the surface. 
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���� You can enable Face limit in the File - Preferences - General - 3D 
preferences dialog box. 

6.3.9. Heliodon  
Heliodon is a tool that creates the appropriate geometrical relationship 
between an architectural scale model and a representation of the sun. By 
allowing adjustment for solar declination (season), the earth's rotation (time of 
day), and site location (latitude) a Heliodon can simulate sunlight penetration 
and shading for any combination of site location and time. The result is a 
useful representation of solar patterns for clear sky conditions. 
Heliodon provides an effective tool for the visualization and calculation of 
solar effects at the window, building, or site scale. 

Heliodon tools 
You can activate the Heliodon tool on the Sun Setting Toolbar in a 3D 
window.  

 
The program displays the Heliodon in the centre of the active 3D window. You 
can switch off the Heliodon with another click on the Sun setting toolbar or 
with a simple left click on any point of the 3D window except the Heliodon 
markers. 

 
Heliodon tool 

 
The Heliodon represents the sun position with its azimuth and zenith angle. 

Azimuth 
An azimuth is an angular measurement in a spherical coordinate system. The 
vector from an observer (origin) to a point of interest is projected 
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perpendicularly onto a reference plane; the angle between the projected 
vector and the reference vector on the reference plane is called the azimuth. 
See more in http://en.wikipedia.org/wiki/Azimuth 
 
You can move the azimuth with the blue dot markers on the Heliodon’s flat 
surface with mouse left click. The model illumination follows the changes and 
you can see how the building would look at various light conditions. 

  
Azimuth movement 

Zenith 
The zenith is the point in the sky that appears directly above the observer. It 
helps to describe the location of the Sun  
See more in http://en.wikipedia.org/wiki/Zenith  
 
You can move the zenith with the small sun marker above the Heliodon’s 
vertical half-circle with mouse left click. The model illumination follows the 
changes and you can see how the building would look at various light 
conditions. 
 

  
Zenith movement 

Concentric rings 
Two rings represent the North and its perpendicular direction with dotted blue 
lines. When the designer sets up the right North direction the rings follows the 
changes. The N (North) sign displays the North direction. 
The other ring represents the East-West axis. 
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6.3.10. Sun settings 
You can open the Sun settings dialog from the View - View Properties 
submenu. 
In the dialog box you can set the position of the sun, depending on the 
geographical position, the date and time. 
If you set a value, it appears in the Perspective dialog box. The rendered 
image is created on the basis of these values. 
ARCHLine.XP®  automatically displays the longitude and latitude of the 
selected town, as well as the zenith and azimuth values. 
The dialog box contains pictures of the towns. 
 

 

Location 
If you select a town from the pull-down menu, the picture and the longitude 
and latitude values of the town appear. 
You can add new locations to the list with Add  by entering the name, the 
longitude and latitude values of the town. You can also attach a picture. 
To delete a location from the list press Delete. 

Date 
You can set the day and month of the 
desired sun position. 

 

Time 
After setting the date, you can set the time of the Sun’s position. 
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If the time you set is during the night, i.e. the sun is under the horizon, the 
model turns grey to indicate night. At sunrise the model regains full colour. 

North 
You can define North direction in 
relation to the horizontal 0 degree. You 
can set North by entering a new value 
or by moving the arm. Make sure the 
North direction set here and the North 
direction on the floor plan are the 
same. 

 

 

���� If you want to define North graphically, apply the North direction command 
in the View menu / View Properties. 
 

• OK accepts changes and closes the dialog box. 
 

You can start a photorealistic rendering with the  Rendering  icon to see 
the changes on a rendered image also. 

� You can also carry out a shadow analysis. The command can be activated 
from the Add-On - Animation submenu. You can read about Shadow analysis 
in chapter 13.3.5. 

6.3.11. North direction 
With this command you can define North graphically. 
 

• Make sure the floor plan window is active. 
• Click North direction. 

The program displays a rubber-band line starting from the middle of the 
screen. 

• Define the endpoint of the line. 
 
The direction of this line indicates North. 
 
The symbol in the bottom left corner of the floor plan window indicates North. 
If you modify the direction, the symbol follows the changes. This symbol does 
not show in print. 



  6 View 329 

 ARCHLine.XP ® 

 

���� If you want to specify North with numbers, go to the Sun position dialog box. 

6.3.12. Show/hide objects 
If an object is completely overlaid by other objects in the active 3D window 
(other objects completely surround it), so none of its edges is visible, the 
object is not visible and cannot be selected when you project the image. To 
show hidden objects (or hide them again) apply the following commands of 
the Show 3D : 
 

� Show solid 
� Hide this object 
� Hide selection 
� Show all solids 

 
You can instruct the program to search and display on the floor plan the 
architectural element contained in the 3D window: 
 

� Show on floor plan 

6.3.12.1. Show solid 

Displays only the selected solid in the active window, all the other objects 
remain hidden. 
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6.3.12.2. Hide this object 

Hides the selected solid in the active window. 
 
Hide this object modifies the view only, not the solids. 
 

 

  

Show solid 

 
 

Hide this object 

 

6.3.12.3. Hide selection 

Hides the selected solids in the active window. You can select multiple solids 
to hide. 
 
Hide selection modifies the view only, not the solids. 

6.3.12.4. Show all solids 

Displays all solids in the active window. 

6.3.12.5. Show on floor plan 

Right-click on an architectural element in the 3D window, and in the shortcut 
menu choose the Show on floor plan command. The appropriate floor 
becomes active; in the centre of the window the program displays the 
selected element on the floor plan in optimal size. This command is useful in 
case of large drawings. 

6.3.13. Walk and Fly 
You can represent the 3D content of your projects in higher quality with the 
help of the View - Walk and Fly commands. This function will help you, when 
you would like to show the different details of the model in real. 
 You can do it in that way, as you walk in the building in the reality. You can 
apply the commands excellently in course of work, because the different 
settings of perspective views and design are become simple. 
 
You can edit the different 3D elements, as if you stand in the model and work 
in the virtual space. 
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You can start the Walk and Fly commands with clicking on the View -  

Walk and  Fly icon. 
 
It works only in that case if you activate the 3D DirectX window.  

6.3.13.1. Terminology 

The difference between the Walk and Fly is the moving method in the virtual 
model.   

Walk 
In course of walk – like in the reality – the viewpoint height of the spectator 
doesn’t change. When you move in the model with the help of walk, then it 
moves the viewpoint (the camera) on a fixed horizontal plane.  

Fly 
In course of fly the viewpoint height of the spectator can change as if it flies 
the model. This function can be important, when you need higher freedom of 
movement from Walk. You can reach down and up different levels (for 
example movement on the step) owing to the freedom open space 
coordination independently from the size of the model. 
 
Because of the things just mentioned we have to talk about the camera. The 
camera is that point in the open space from where we look at the part of the 
model.  
The observed point and the camera determine together the direction in which 
the spectator looks. 
The field of view is also important, because you might need wider visual 
angle in viewing narrow spaces to see the proper part of the model. 

6.3.13.2. Handling 

You can start the Walk and Fly commands by clicking on the View -  Walk 

and  Fly icon. 
 
When you use the Walk or Fly commands, the mouse cursor is disappeared 
and you can move in the space by the help of mouse and the keyboard.  
You can change the direction of view with the mouse, while you can move in 
the space with the proper button of keyboard. It is really similar to the 
movement in the reality, because you can move and look around at the same 
time. It is easier to understand if you imagine the mouse as the head of the 
spectator, and the keyboard as the body of the spectator. 
 
You can interrupt the Walk or Fly command by: 
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� Pressing down ESC   
� Left click 
� Right click 
� Function buttons 

 

Using the mouse 
In course of using Walk and Fly functions the mouse determines the view and 
walk direction. You just have to move the mouse there is no effect of the click. 
When you draw the mouse to yourself, then the spectator will look down 
otherwise upward. The moving of mouse controls the dimension of this. If you 
would like to look right or left, move your mouse to the right or left.  
 
Start a command, move your mouse and study the effect. 

Using the keyboard 
You can use two sorts of keyboard layout to the keyboard movement. 
 
1. Layout 2. Layout Effect 
 
Cursor up W Move forward  
Cursor down S Move backward 
Cursor left A Move left 
Cursor right D Move right 
Space Page up Elevate viewpoint 
C Page down Lower viewpoint 
Shift Shift Run 
 
You can interrupt the Walk or Fly command by: 
 

� Pressing down ESC   
� Left click 
� Right click 
� Function buttons 

Move in open space 
It is practical to learn the movement in open space to move efficiently in it. 
For this you need the mouse and the keyboard at the same time. 
 

• Put one of your hands on directions button of the keyboard, and the other one 
on the mouse.  

• Start the   Walk and  Fly command.  
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• After this, hold down the Move forward button, and release it when you would 
like to stop. Move the mouse to look around. Repeat this as many times as 
you wish. 
 
You will notice that it will move to the direction you are looking at. You can 
combine the movement keys as you wish according to the simple example 
mentioned previously, so you have a possibility to complex movement in the 
open space. 
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6.3.14. Further settings of showing 3D solids  
In the File - Preferences - General - 3D preferences  dialog box you can 
manage the parameters of showing 3D solids. 
 

 

Apply to: 
Indicate whether you want to apply the settings to all windows or only to the 
active window. 
 

All windows  
The selected properties are applied in all windows. 

Active window  
The selected properties are only applied in the active windows. 

Hidden lines: 

Real  
 
Displays all solids with hidden lines, as 
seen in reality. 
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Join surfaces  
When you display the objects as seen in 
reality, Join surfaces shows or hides the 
common edges of different surfaces. 

If you activate the Join surfaces  
option, the common edges between wall 
and wall , wall and slab  or roof and roof  
are displayed in hidden-line mode, 
provided that the material of the joining 
surfaces is the same.  

 

 
Within the Join surfaces command the All architectural elements option 
means that in the case of the same material the staircase under the wall will 
be joined to the wall. 

In all other cases the edges are shown . 

 
 

Show hidden object   
It displays 3D solids individually in hidden-
line mode, i.e. as opposed to wireframe 
mode, not all edges are visible, only the 
ones hidden by other objects. 

  

Face limit 
When you want to display a 3D model you can define the number of 
displayed surfaces. If there are too many surfaces, the number of the 
displayed surfaces can be decreased, so the display of the model can be 
optimized. 
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���� Face limit can be activated on the 3D Preferences page of the File menu – 
Preferences – General  dialog. For description see Chapter 6.3.7. 
Shadowing or shading. 
 

 

Selection 
You can define on which solids to apply the selected command, e.g. Hidden-
line display . The model can be very impressive in colour display, if you show 
each object differently, i.e. you display certain parts of the model with hidden 
lines, other parts with colour. 
 

Approximation lines 
Displays the approximation lines of 
solids. 

 

Show hidden edges dashed 
Displays hidden edges with dashed lines. 
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All  
Applies the selected parameters to all 
solids. 

Visible  
Applies the selected parameters to 
visible solids. 

Selected  
Applies the selected parameters to 
the selected solids. 

 

 

Transparency 

Hatch section plane(s) 

 
 
Enable this option to display section planes with hatches. For the contour of 
section planes the program uses the line width set in the dialog box. 
 

 

Enable this option to display 
objects seen through 
transparent surfaces when 
you display the model in 
3D. By default, only doors 
and windows have 
transparent surfaces. 
 

���� 
You can make any object 
transparent if you enable 
3D menu - Modify - 
Transparency. 
If you regenerate the whole 
3D model, you lose this 
setting. 
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���� You can also activate the commands from the Edit toolbar −−−− Define 

section   dialog box. 
 

     
 

���� The hatch applied to the model is independent from the hatch applied to the 
sections. It can be done in Drawing 3D only with colour or with hatch 
corresponding to the texture, depending on the options activated in the 
Navigation bar Shadowing or shading dialog box. 
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6.4. Show 2D 
With show 2D you can hide selected elements or element type in the floor 
plan window. These elements appear in the 3D window, independent of the 
fact whether they are visible on the floor plan or not. 
Elements hidden on the floor plan do not show in print. 

6.4.1. Hide objects 
Hides the selected elements, so that these are not visible in the floor plan 
window. 
 

• Select the elements in the floor plan window you want to hide. 

6.4.2. Show classes 
Activate the options to display element classes on the floor plan, or 
tick the All  option, if you want to display all classes. Naturally, disabled 
element classes remain hidden. 
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6.5. Section 

Overview - Dynamic section drawing 
Section view is one of the most important features of computer aided 
architectural designing. 
The section view is derived from the model of the building and appears as a 
new drawing in accordance with the model. The program generates the 
section view in a new 3D window, perpendicular to the cutting plane. 
You can create as many section views of a building as you like. The section 
view dynamically follows the changes made in the model. 
 
In the section view you can select each element and you have access to the 
architectural objects. You can change objects in the section view as well as 
on the floor plan. 
Section view can be combined with vector graphics shadowing and with 
vector graphics hatching but it requires longer generation time. Vector 
graphic shadows can be calculated from the sun or from an arbitrary angle. 
 
The representation of the section line is defined by a standard that is 
acknowledged in the field of technical drawing. The section line is a dotted-
dashed line with letters (the section’s letter symbol) and with arrows at the 
ends, which show the direction of the section view.  
 
Moving, rotating or mirroring of the section line with the use of section line 
markers on the floor plan refreshes the section view automatically. 
 
The section line is visible on the view where it was created. 
There section view enables the visualization of objects crossing the section 
plane with or without material hatches and with thin or thick contour lines. 
 
In the ARCHLine.XP out of the dynamic section drawings the following 
opportunities are available to create different kind of sections: 

Static section 
If you did not work out the model in detail, the section provides a good basis 
for further editing. 
With the help of the program’s clipboard, you can copy any 3D views or 
section views to the floor plan window. The copied drawing loses its 
connection with the 3D model, therefore it can be freely edited, the view or 
section can be”dressed up”. For instance, you can specify the order of layers, 
which you have to indicate on the plan, but it was not represented on the 
model. With this option the program provides considerable freedom to the 
designer. 
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Stepped section in a 3D section window 
Section line can be created in a 3D façade view (vector graphics drawing) 
window, too, even in a stepped form. In that case the newly created section 
window will include a stepped section. 

Cutting a 3D model 
You have the possibility to cut a model with a stepped section line and display 
the result on a rendered image. This command really cut the 3D model. 

Dynamic cutting plane 
Applying the dynamic cutting plane in a 3D image window, you can represent 
the dynamic section in real time. This representation is very useful, not just 
for aiding the architectural design work, but for a spectacular representation 
of the building to the customers, too. 

6.5.1. Dynamic section 
You can generate the section of the model with the commands in the View 
menu - Section submenu.  
 

 
 
Follow the steps below to create a dynamic section: 
 

• First can set the properties of the section line, including the lower and upper 
height limits of the section.  

• Then you have to define the path of the section line and set the view 
direction.  

• The program then generates the section view of the model in accordance with 
the section line in a new section window. 
 
In the section window the program refreshes the section view when changes 
are made to the model. This can be automatic or optional.  
Any changes made to the model in the section window, e.g. deletion of a wall, 
will appear on the floor plan. 
The section window follows the section line: Moving, rotating or mirroring the 
section line on the plan view by any markers, the section view will be updated 
immediately 
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The quality of the section view depends on how detailed the model is, i.e. if 
there are multi-layered walls, slabs, whether you specified how layers are 
joined. 
 
The following rules are applied when you create a section: 
 

� When creating a 3D section view, the name of the window will be generated 
automatically (Section1, Section 2 etc.). In the Project navigator dialog you 
can rename the section window (the original name of the file that represents 
the section window will not change). 

� One 3D section window belongs to each section line. This way the connection 
of one section line to more 3D section window, which makes the section 
unidentifiable after some time, can be avoided. 

� If a 3D section window that belongs to a section line is in invisible state (you 
can check it in the Project navigator dialog) then the Create section command 
will pop up a warning message and no new 3D section window will be 
created. 

� If a visible 3D section window belongs to an existing section line then the 
section window will be refreshed by the Create command. 

� The identification of sections that have been already created in older projects 
(created by versions prior to ARCHLine.XP® 2007 Release2) is not working. 

 

6.5.1.1. Defining a section 

Activate the floor plan. To create a section, follow the steps below: 
 

• Click View menu - Section – Define section or Edit toolbar -  Define 
section icon. 

• The Section properties dialog appears. Specify the properties of the section. 
• Set the start and the end point of the section line on the floor plan. 
• Click on the side of section line where the section model is viewed from. The 

program places the arrows on that side of the section line. 
• In the appearing message window confirm the creation of the section view. 

 
A dynamic section view is created then in a new section window. 

� See chapter 6.5.1.2. Section properties settings, 6.5.1.3. Defining the section 
line, 6.5.1.4. Creating sections for the details. 
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���� Besides the appropriate setting of view properties in the 3D window (right 
view, front view etc.), the section view is also capable of creating façade 
view. In that case place the section line outside of the building and set the 
proper view direction. 

6.5.1.2. Section properties settings 

The indication of the section line is defined by a standard that is 
acknowledged in the field of technical drawing. The section line is a dotted-
dashed line, with letters (the section’s letter symbol), and with arrows at the 
ends, which show the direction of the section view. 
You can define the section properties in the dialog: 
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Line properties 
Set line properties: 
 

� the section’s letter symbol:   

� position of letter symbol:    

� visibility of letter symbol:  
� the lower/upper limit of section : you can disable this option, or you can set 

a value 
� colour of section line 
� type of section line 
� width of section line 

� width of marker line:   

Marker properties 
Set marker properties: 
 

� colour  
� line width 
� length of marker line 
� size of marker 
� type of marker 

Hatching section plane 
When you generate a section view, the program does not apply hatch 
automatically to the cutting planes, because in the case of big models it 
would take too long. If you want to apply hatching to the cross-sectional 
cutting plane, activate Section plane created with hatch option.  
You can also set the line width of the contour line applied to cross-sectional 
cutting planes. 

 

���� The Section plane created with hatch option and the hatch line thickness 
can be found in the File - Preferences - General - 3D preferences dialog 
box also. 
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Section properties – Item types for applying sectio n line width 
Using the section tool there is the possibility to set different line thickness 
based on the element type that was intersected by the section plane. 
This possibility gives you the ability to visualize main structural elements and 
other elements with different conditions.  
The setting can be found in the Section properties dialog window. 
 

 
 

 

 

 

Section symbols 
on the ends of section line you can apply different symbols instead of arrows. 
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• In the Section properties dialog select the Symbol on the ends of section line 
option. 

• Click the belonging button and select the appropriate symbol from the Section 
endings library. 

• Enter the value of the variables. For example A ‘1. 
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6.5.1.3. Defining the section line 

After closing the Section properties dialog: 
The path of the section line which will be used for creating the section of the 
model can be defined as line or polyline. 

Line section 

• Specify the two end points of the section line. 

Polyline section 

• Define section line with a chain of lines and arcs. You can break the section 
line. 

• Enter   close the section line. 
 

• To define the direction of the section view, click on the side of the section line 
from which you observe the model. The program places the markers on this 
side of the sectioning line. 
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After the definition of the section line, the program offers the creation of it. 
See 2.1.3.chapter Creating sections. 

6.5.1.4. Creating sections 

After the definition of the section line, the program offers the creation of it. 
 

 
 

� Clicking on Yes will create the section.  
� Clicking on No will leave the possibility to create the section later by the View 

menu - Section – Create section command. 
The program creates the section view of the model according to the selected 
section line  
 
The section appears in a new window (section window), which you can save 
as part of the project. The program rotates the model according to the 
direction of the section view. 
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���� The program applies hatch to the cross-sectional cutting planes depending 
on the status of the Hatch section plane option in the Section properties 
dialog box. 
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You can also create the section with the Section shortcut menu −−−− Create  
command. 

6.5.1.5. Refreshing the section view 

Refresh 3D 
This command is a switch to turn on/off the refreshing of the section. 
If you disable the refreshing of section in 3D, it becomes faster to display the 
3D model. This is the default setting. When using this setting, you can use 

View toolbar −  Hidden lines or the Section − Refresh command to update 
the model. 
 
If you add new elements to the plan, and the View menu - Refresh 3D option 
and the Section − Refresh 3D option are enabled, the program automatically 
creates a section view of these objects, too. When the Refresh 3D option is 
switched off, the newly generated element will appear without hatch. 
 

���� If a 3D section view window belongs to a section line already, the Section - 
Create command will refresh that section view. 

6.5.1.6. Modifying section line 

Existing section line properties can be modified. 

Modify properties 
• Double click on the section line. 

The Section properties dialog appears. 
• Make the desired modifications. 
• Refresh the section view. 

Changing the position 
The section window follows the section line: Moving, rotating or mirroring the 
section line on the plan view by any markers, the section view will be updated 
immediately 
 

• Click the section line on the floor plan: 
 
Markers appear on the section line. With the help of these markers the 
section line can be moved, rotated or mirrored.  
Mirroring means the changing of the viewing direction. 
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6.5.1.7. Fixed view of a section window 

The view in a 3D section can be fixed, so you can avoid the rotation of the 
section view. 
 

• Activate the 3D section window. 
• Click the Active window button in the File menu – Preferences – General – 3D 

Preferences dialog. 
• Switch on the Fixed view (Cannot rotate) option. 
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6.5.1.8. Show definition of section 

For the 3D section window you can search back the belonging section line on 
the floor plan. 
 

• Click with your mouse right button on the header of the 3D section window. 
• Select the Show definition of section command. 
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6.5.2. Static section - Copy section view content i nto a 2D 
window 
During the design work the 3D model, the 3D dynamic section and different 
views are generated. Even if the model is prepared in details, the 3D sections 
and views are not capable of using them as approval drawings (because of 
missing texts, dimensioning etc.).  
 
For this reason there is an opportunity to "unlink" the section view from the 
3D model and finishing the section drawing on approval drawing level. 
 
We recommend the followings: 
 
As soon as you finished your work with the model, copy each section views 
into separate 2D floor plan window (for example 2D Sections) on different 
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floors. For example Section A-A floor, Section B-B floor etc. You can easily 
activate the requested section view by switching between floors.   
 

���� It is not recommended to create as many 2D drawing windows as the 
number of section views! 
 
We recommend you to detail the section views in these 2D windows.  

Copying the content of section view into a 2D windo w 
• Create a new window with the Windows menu - New window 2D command: 

for example 2D Sections. 
• Make the appropriate 3D section view active. 
• Use the Edit menu - Copy to clipboard (Ctrl+C) command. 
• Select all elements in the window. Enter - close the selection. 
• Specify a reference point on the drawing. 
• Make the newly created floor plan window (2D Sections) active. 
• Use the Edit menu - Paste from clipboard (Ctrl+V) command. 
• Place the drawing in the window by mouse click or keyboard input. Enter. 
• In the Edit floor levels dialog rename floor 0 to Section A-A, for example. Add 

new floors and then rename those accordingly. 
• Repeat the previous steps and copy each section view on the appropriate 

floor. 
 

• After this, detail the sections. You can add text and dimensions and additional 
lines, groups or hatches to finish up your drawing. 
 
There are major differences between 2D section 3D section view windows: 
 

� The 3D section window follows the changes in the model automatically; it is 
connected to the floor plan. 

� The connection between the 2D section window and the 3D model is lost; 
changes on the floor plan are not followed. It includes only 2D drawing 
elements (line, arch, hatch…); therefore you can edit it freely. 

 

���� The same method is recommended when you work on facades.  Pay 
attention to the setting of the correct view in the 3D (drawing) window, and 
then start the copying to the 2D floor plan window. 
 

Recommendation: 
The number of 2D floor plan windows is not limited but it is recommended to 
work with a maximum of 3 or 4 2D drawing windows, ensuring a clear 
structure of your project. 
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� 1 floor plan window for the real floor plan; there are floor plans on different 

floors 
� 1 floor plan window for the 2D sections; there are different sections on 

different floors 
� 1 floor plan window for the 2D facades; there are different facades on 

different floors 
� 1 floor plan window for the site plan; floors are not used in that case. 

 

6.5.3. Stepped section in a 3D section window 
With the Section −−−− Create section command you can create not only floor 
plan sections, but also you can generate a stepped sectional view of a 3D 
model. You can do it as follows: 
 

• Create a section view of the model, e.g. front view in a 3D view (drawing) 
window. 

• Click  Define section. 
• Draw a section line in the 3D view window and define the direction of the 

section view. 
• Allow the program to create the section or create it later by selecting the 

section line. 
 
Then a new section window is generated similarly to the sections defined on 
the floor plan. Create the stepped section by rotating the model properly, and 

then refresh the window by clicking View toolbar −  Hidden lines icon.  
The section view is created in a new window then, but the model is not cut. 
3D image view and rendering still displays the whole model. 
 
Advantage :  
The program also preserves the stepped section of 3D model in the section 
window after you generate the model again. 
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6.5.4. Cutting a 3D model 
You also have the possibility to cut the model in the 3D view window with a 
stepped section line, and then you can show the result in a 3D OpenGL 
(image) window on a rendered image. 
 
For this you have to use the following commands: 
 

• Create a 3D view of the model in a 3D view (Image) window, for example. 
• Select View menu - Section - 3D model section command. 
• Select the Polygon option from the Profile definition tools appearing on the 

left side.  
• Draw the stepped section line with the polygon. Close the profile. 
• Click on the part of the solid, which you will keep after cutting. 
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• Rotate the model in the window and the stepped section will appear. 
 
The program cuts the model in the 3D view window. 3D image and rendering 
displays only this part of the model. The cut model remains in the 3D window 
until you give instructions for generating the whole 3D view of the model 
again. 
 
Advantage: 
As you cut the real 3Dmodel, you can also create a photorealistic picture of 
the stepped 3D section of the model. 
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6.5.5. Dynamic section plane 
Dynamic section plane command allows you to view any cross-section of the 
3D model. It slices the model with an invisible (optionally angled) plane, so 
you can only see the content of one side of it. 
 
To use the command you have to work in a 3D window (image). You can use 
this function both in axonometric and perspective views. 
 
The advantage of this function is that you can create a dynamic section 
defined by a section plane in real time. Therefore it is not just a working tool 
for the architects but a spectacular representation of the building. 
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There is the possibility to “click through” the section plane. This will let you 
edit and change elements even in a dynamic section presentation mode.  
This might be useful when you work on axonometric and you want to edit 
interior parts of your building. 

 
 

Defining a section 
Create your 3D model in a 3D Image window and activate this window. 

Click  Define section on the Edit toolbar. 
 
You will get a section like it is shown on the pictures above. 
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There are two options in the 3D Graphics settings to change the texture 
shading and the transparency of the dynamic 3D section plane. 

 

 
 
 
Markers appear in the corners of the dynamic section plane. Click on these 
markers to see the dynamic section marker menu: 
 

 
 
Move : With this command you can shift the section plane to a direction 
defined by a normal vector perpendicular to the section plane. 
 
Rotate:  With these commands the section plane can be rotated around 
horizontal and vertical axes. 



362 6.5 Section 

Manual 

 
Restore : With these commands you can restore the default position of the 
section plane. 
 
Align view:  With this command you can set the view to be parallel to the 
section plane. 
 
Inverse:  This command inverts the section. 
 
Create section : With the help of this command you can create a dynamic 
architectural section.  
 
Close:  This command closes the dynamic section tool. The section plane 
disappears and you can see the whole actual model again. 

Limitations 
Be aware of the following limitations when you work with dynamic 3D section: 
 

� Size of the generated section: the size of the generated section is 
independent from the section plane you work with. You will see the whole 
section in every case. 

� The angle of section: in every case a vertical architectural section will be 
created, independently from the tilt angle of the section plane. 

� Section line created on the floor plan: along with the section a section line will 
be created on the floor plan. The length of this section line is equal with the 
width of the dynamic section plane. The position of the section line is defined 
as the horizontal centre line of the section plane projected on the floor plan. 
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6.6. Opening and wall scale factor 
The View menu contains the following command to display the symbol of 
doors and windows on the floor plan with different scale factors: 
 

 

 
 
You can specify how walls are visualized independent from the scale factor of 
the whole drawing. 
The abovementioned independence means that e.g. you print your drawing in 
1:100 scale, while you set 1:50 for the scale of doors and windows, so these 
appear on the plan in more detail. 
In the dialog box you can set: 

• the scale factor of doors and windows, 
• how walls are hatched and visualized on the floor plan. 
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I) Scale factor of doors and windows: 
Doors and windows have a standard form of display in all scales. Whichever 
scale you apply to doors and windows, it does not affect their physical size, 
only the form of display. 
ARCHLine.XP offers 5 scale factors to display doors and windows (1:20, 
1:50, 1:100, 1:200, and 1:500).  
 

 

II) Wall display 
Walls are displayed with all their layers. 
 
 
 
Walls are displayed with the hatch applied to the displayed 
layer. 
 
 
 
Walls are displayed without layers and hatching. 
 
Independent of the hatching applied to the wall, the outside 
layer of the building’s outside walls are hatched black, as it 
is displayed in the figure. 
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6.7. Hand-sketching 
Activate the File −−−− Preferences −−−− Hand sketch style command to display 
the drawing hand-sketched. The quality of the freehand drawing depends on 
the parameters you set. 
 

 
 

���� The commands are not valid to 3D image windows. 

 

6.7.1. Assign to all 
Assigns freehand-style to the whole active drawing. 

 
 

���� To restore the previous style of the drawing, click on Assign to all  again. 

6.7.2. Assign 
Assigns freehand-style to a group of drawings. For instance, you can select 
the perspective drawing (which is a group) from other drawings on the plot 
layout, and you can assign freehand-style to it. Naturally, the floor plan is 
displayed in normal mode. 
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• Select a group to which you want to assign this style. 
• Select other groups, or 

Enter  to complete the command. 

6.7.3. Delete 
Deletes freehand-style from the selected areas of the active drawing. 
 

• Select a group to delete freehand-style from. 
• Select other such groups, or 

Enter  to complete the command. 

6.7.4. Parameters 
The display of freehand drawings depends on the parameters set in the 
dialog box. 
 

 
 
You can modify the following 
values: 
 

� the number of iterations , which 
defines line width, and 

� the divider , which defines the 
length of lines. 
 
Try different values and choose 
the one you find best. 
 

 

Default 
Sets the values back to default. 

Set as default 
The values you set become default settings. 
 

• Ok The program applies the values you set to the existing and future 
freehand drawings. 
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6.8. Magnifier tool 
Magnifier tool can be used in any design situation, when a fine mouse 
movement is needed to define a specific point. Using the Magnifier, you don’t 
have to change the actual view, because when you switch Magnifier on, you 
are able to zoom inside the magnifier borders.  
 
During the use of Magnifier tool you can start and run any other design tool. 

Using the Magnifier 
You can find the Magnifier tool at the bottom part of the interface of 
ARCHLine.XP on the Status bar or in the View menu. Click on the icon to 
switch it on/off. 
 

 
 
When you switch the Magnifier on, you can move your mouse over the active 
drawing. You can see the borders of Magnifier. 
 

 
 

Use the wheel on your mouse to zoom in inside the borders of the Magnifier. 
This way you can enlarge the area inside the borders. You can see the actual 
Magnification value at the left top corner of the Magnifier’s rectangle. 
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To exit Magnifier, please push the Magnifier icon again on the Status bar of 
ARCHLine.XP, or push the ESC key on your keyboard. 

Magnifier settings 
You can change the settings for the Magnifier tool by right-clicking on the 
Magnifier icon on the Status bar of ARCHLine.XP.  
 

 
 
You will see the following dialog. 
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Width 
You can set the width of the border of the Magnifier rectangle in pixels. 

Height 
You can set the height of the border of the Magnifier rectangle in pixels.  

Zoom speed 
You can change the magnification step, which will be used when you scroll 
the mouse wheel. 

Default zoom factor 
By setting the Default zoom factor you can define the starting value of 
Magnifier, which you will see when you activate the Magnifier tool. 

Preserve zoom factor 
By setting the Preserve zoom factor, the software will remember the last used 
zoom factor, when you exit the Magnifier. Next time when you start Magnifier 
the software will start with the preserved value, instead of the default zoom 
factor. 
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7. Selection 

General 
To apply most editing commands, it is necessary to select drawing elements. 
The set of the selected drawing elements can be expanded or restricted. 
The selected elements appear in highlighted colour. 
ARCHLine.XP® offers two methods for most editing commands: 
 

� According to the first method, you must select an element first and then 
specify the command to be executed on it. 

� When using the other method, you must specify the command first and then 
select the element the command is executed on. 
 
Choose the method that fits your needs the best. 
 
You can also select an element in different ways: 
 

� Clicking on the element with the mouse, or selecting by window (selection 
rectangle). 

� By using the Selection menu. 

7.1. Selection with the mouse 
As described in Chapter on ARCHLine.XP® Interface - 2.1 Mouse, elements 
can be selected by clicking with the left mouse button on an element, or a 
selection rectangle can be defined with the mouse. 
In the previous chapter we also described that you can apply an editing 
command in two different ways. Let’s see the first method: 

I. First choose the element then an editing command . 
When the mouse pointer is an arrow shape, the elements can be selected as 
follows. 

II. Activate an editing command then select the ele ments you want the 
command to be executed on. 

With this method you can select elements in a similar way to the previous 
method, with the following difference: The selection must be completed with 
the Enter key 
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7.1.1. Selecting one element 

• When the cursor is in arrow shape  
(press the ESC button to get it) you can 
select an element with the mouse click 
on it. 
The selected element changes the colour 
to the selection colour.  
 

 
 
Note: If there are multiple elements at a certain click point, the quick selection 
menu pops up helping to choose the proper element. 
 

 

7.1.2. Selecting more elements 
• While pressing the SHIFT button 

more elements can be added to 
the selection. 

• Clicking on an element, it is added 
to the selection. 
 

� The selected elements change 
their colour to the selection colour. 

� The elements selected at once 
only have a limited set of markers. 
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7.1.3. Rectangle selection 

When the cursor is in Arrow  shape , (that means the program is not in 
active command), there is the possibility to define a selection rectangle. If you 
click on an empty area of the drawing with the left button of the mouse, you 
can move the cursor and click again. The program selects the elements that 
are inside the rectangle. However it is not all the same which direction the 
cursor is moved.  
Define the selection rectangle with its two opposite corner points:  

• Click with the left mouse button to define the first corner point of the selection 
window. 

• Move the cursor and click to define the other corner point. 
 

If you move the cursor from  left to right , the program selects all the 
elements that are inside the rectangle. 

 
 

Moving from right to left  the program selects all the elements that are inside 
the rectangle and those also that are cut by the rectangle. 

 

 

 
You can apply editing commands to the elements selected. 
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���� The Selection window highlights the selection area with transparent colour. 
The colour depends on that you select the area from right to left (green) or 
from left to right (blue). 

7.1.4. Quick Class selection 
• Open the Toolbox. 
• Press CTRL and click with the mouse left button on an icon. The command 

selects all elements on the drawing from the given element class. Example: 
The elements that are selected can be modified together using the Property 
manager. 

 � For a detailed description of the option see the instruction 2.4 Toolbox. 
 

7.1.5. Quick selection dialog 
Quick selection dialog can be helpful in case of complex drawings when more 
elements found by a left mouse click selection operation.  It can happen that 
you have to select the desired element from a range of 5, 10 or even more 
elements.  
 
Quick selection dialog makes the overview of more elements easy by creating 
a clear, user-friendly selection list. 

How to use 
When clicking a point with left mouse button on the drawing where more 
elements found, press TAB key repeatedly for switching between elements. 
At the same time the Quick selection dialog appears by which you can 
monitor the state of selection continuously.  

 
 
The Quick selection dialog doesn’t appear when you can’t switch to another 
element (for example there is no other element nearby). 
 
Quick selection dialog shuts down by cancelling the selection. 

Quick selection list 
The list appearing in the Quick selection dialog helps to choose the desired 
element from the list of more elements. Click the quick selection list button for 
this. 
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Click the element you want to choose from the appearing list and then it will 
be selected on the drawing.  

 
 
After that you can modify the properties of the selected element in the 
appearing Property manager on the left or different operations like rotation or 
move can be executed. 

Forward button 
With the help of Forward button you can switch to the next element in the 
selection list. Its operation is the same as pressing the TAB key repeatedly. 
Click Forward button to choose the next element in the list. 
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7.2. Selection menu 

To select, you can use the  
button in the Status bar that activates the 
Selection menu.  
 
With the pop menu you can select elements in 
the drawing by using different options. The 
Selection menu can be used for pre-selection of 
elements and also for selection within an editing 
command. In the latter case selection must be 
completed with Enter. 

 

 
The Selection menu also appears when the 
program is waiting for selection, and you press 
the right mouse button. In this case it is a 
precondition that in the selection field in the File 
- Preferences - General -Right-click 
Customization dialog box instead of the Enter 
command you assign Selection menu  to right-
click. 

 

 

7.2.1. Enter 
The selection is completed with the Enter key or the Mouse right button click. 

7.2.2. Selection by window 
Options of selection by window: 

One floor - in 
The program selects all the elements on the current floor that are entirely 
within the selection window. 

One floor - out 
The program selects all the elements on the current floor that are entirely 
outside the selection window. 
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All floors - in 
The program selects all the elements on all floors that are entirely within the 
selection window. 
 

���� With this instruction it is easy to select the entire building. It is useful if you 
want the building to be placed to a definite location on the key plan or the 
terrain, or to be rotated as moved. For this transformation you can use the 

Move  instruction and “Multitrans” option. 

All floors - out 
The program selects all the elements on all floors that are entirely outside the 
selection window. 
 

• Specify a corner point of the window. 
• Specify the opposite corner point. 

7.2.3. Selection by polygon 
Options of selection by polygon: 

One floor - in 
The program selects the elements on the current floor that the selection 
polygon entirely encloses. 

One floor - out 
The program selects the elements on the current floor that are entirely 
outside the selection polygon. 

All floors - in 
The program selects the elements on all floors that the selection polygon 
entirely encloses. 

All floors - out  
The program selects the elements on all floors that are entirely outside the 
selection polygon. 
 

• Specify the first corner point of the polygon. 
• Specify the next corner points of the polygon. The polygon may also contain 

arcs. 
• Enter  Ends the selection of the corner points. 
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7.2.4. By fence 
Options of selection by fence: 

One floor 
The program selects all the elements on the current floor that intersect the 
specified fence. 

All floors 
The program selects all the elements on all floors that intersect the specified 
fence. 

• Define the fence as a series of lines, arcs with which you select the elements. 
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7.2.5. Selection by properties 

 
 
• Specify the criterion of selection. 
• Specify the operator that depends on the defined criterion. 
• Specify the value of the operator (if any). 

 

 !!!! In the case of a complex logical criterion, after specifying all criteria and 
selecting the appropriate logical operation, the dialog box must be closed 
with OK. You can continue specifying the criterion by recalling the Selection 
by properties dialog box. 
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• Specify the logical connection by selecting the appropriate option: 

Add / Or relation: 
Expands the previous selection with elements meeting the new criterion. 

Common part of selections / And relation: 
Selects only those elements that meet both the previous and the new criteria. 

Subtract 
Selects only those elements that meet the previous criteria but not the new 
ones. 
 

• Specify a new criterion and an operator that will be the new condition for 
selection. 

• OK Close the dialog box. 
• Enter  End the instruction. 

 
Doing so, you can specify the selection even on the basis of a complex 
system of conditions in the same dialog box. You can also specify the system 
of conditions in different dialog boxes one after another. 
 
Let’s see the criteria and the associated operators. 

7.2.5.1. Object type 

The program selects all elements that belong to a certain element type in the 
drawing.  
 
Operators associated with element types: 
All items Polyline OLE document 
Room Spline Truss 
Wall Circle Freeform Surface 
Column Circular arc Light 
Beam Ellipse Electrical Accessory 
Slab Elliptic arc External louvre 
Roof Dimension  
Stair Text  
Terrain Hatch  
Objects Group  
Point Raster image  
Line Room book  

 
• Select the desired element type. 
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With this option you can select e.g. all walls on a given floor. 

Selection by element type with the Ctrl key 
Another, quicker way of selection by element type is the following: 
By choosing a main icon in the Side menu and using the CTRL key, the 
program selects all the elements in the drawing that are represented by the 
icon. 
 

• Press Ctrl and click one of the main icons in the Side menu, for example: 
Wall.  The program selects all walls in the current drawing. 

7.2.5.2. Colour 

You can carry out the selection with the defined colour. 
Operators associated with colour: 
 

� Add 
Selects the elements of a specified colour. 

� Except the following values 
Selects the elements that have different colour than the defined one. 
 

• Select the colours from the colour palette, or 
Enter the colour indexes in the Value field separating them by spaces. You 
can specify more colours at a time. 
 

 

7.2.5.3. Layer 

You can carry out the selection with the defined layers. 
Operators associated with layers: 
 

� Select 
Selects all elements placed on a specified layer. 

� Except the following values 
Selects all elements that are not on the specified layer. 
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• Select the desired layer from 
the pull-down menu, or 
enter its number or name in 
the Value field. 
You can also define more 
layers at a time, separating 
them by spaces. 

  

7.2.5.4. Line type 

You can carry out selection with the defined line type. 
 

� Select 
Selects all elements of a defined line type. 

� Except the following values 
Selects the elements that have a different line type than the defined one. 
 

• Click the line type button. From 
the list displayed select the 
desired line type, or  
enter the index of the line type 
in the Value field. You can also 
define more line types at a 
time, separating them by 
spaces. 

 
 

7.2.5.5. Line width 

You can carry out selection with the defined line width. 
 

� Equal 
Selects the elements of a specified line width. 

� Not equal 
Selects the elements that have a different line width than the specified one. 

� Region 
Selects all elements the line width of which is within the specified region. 

� Out of region 
Selects all elements the line width of which is outside the specified region. 
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• When applying the Equal and Not 
equal commands, choose the 
appropriate line width from the pull-
down list of the Value field, or 
enter its value. 
You may define only one value. 

 
 

 
• When applying the Region and Out of 

region commands, enter the lower 
and upper limit of the region in the 
appearing fields. 
 

 

 

7.2.5.6. Wall width 

Selects walls of a specified width according to different criteria. 
 

• See the selection properties as 7.2.5.5. Selection by line width.  

7.2.5.7. Slab width 

Selects slabs of a specified width: 
 

• The selection unit is slab width. Otherwise see the selection properties as 
7.2.5.5. Selection by line width.  

7.2.5.8. Selection by name 

To define the name, you can also use Meta characters, for example: *. 

Selection by group name 
As a result of the selection, you get all the groups that you defined by a given 
name. 
 

• Define the desired name.  

Selection by set name 
As a result of the selection, you get all the elements the selected set name is 
assigned to. 
 

• Select the desired set name.  
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Selection by parameter name 
As a result of the selection, you get all the groups that you defined by a given 
name. 
 

• Define the desired name.  

Selection by object name 
As a result of the selection, you get all the objects, that you defined by a 
given name. 
 

• Select the desired name.  

Selection by column name 
As a result of the selection, you get all the columns, that you defined by a 
given name. 
 

• Select the desired name.  

Selection by beam name 
As a result of the selection, you get all the beams, that you defined by a given 
name. 
 

• Select the desired name.  

Selection by ID 
As a result of the selection, you get the element that you defined by a given 
unique ID. 
 

• Define the desired ID.  

Selection by Hatch Spacing 
Selects hatches of a specified width: 
 

• See the selection properties as 7.2.5.5. Selection by line width.  

Selection by Intensity 
Selects light sources of a specified Lumen value: 
 

• The selection unit is Lumen (lm). Otherwise see the selection properties as 
7.2.5.5. Selection by line width.  
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7.2.6. Last selection 
The program activates the last selection, thus the previously selected 
elements can be further edited. 
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8. Editing 

This chapter describes the editing 
commands, including: move, copy, 
rotate, mirror, scale, delete, stretch 
and offset. 
With the editing commands you 
can edit the selected elements. 
Except Undo and Redo, each 
command activates a geometrical 
transformation. 
These commands can be 
accessed: 
 

� From the Edit menu and   
 

 
 

� From the Edit toolbar or the Move toolbar menu on t he Status bar. 
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� You can also access some editing 
commands from the General Shortcut 
menu . The General Shortcut menu 
appears if you open the General menu 
option in the File - Preferences - 
General - Right click customization 
dialog box and then right-click on the 
empty drawing area. 
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8.1. General editing commands 
Let’s see the instructions in 
the Edit menu . The icons you 
can access from the toolbar 
are also displayed in front of 
the instructions. 

 

 

8.1.1. Undo - Ctrl Z 

The program stores the last 15 editing steps, thus it is possible to restore 
the previous status. Each time you click "Undo”, the command reverses the 
last operation. 
 

!  This instruction cannot be used to restore the commands in the View 
menu . 

8.1.2. Redo - Ctrl Y 

To redo a command reversed by Undo , you can use the Redo 
command. 
 

!  It is not possible to use this instruction to recover the result of commands in 
the View menu.  

8.1.3. Program clipboard 
� The program clipboard is a temporary internal memory. Part or all of a 

drawing can be placed to and removed from the memory. When turning off 
the program, the clipboard content will be lost. 

� The drawing placed to the clipboard overwrites the drawing previously placed 
there. 

� This clipboard is not equivalent to the Windows clipboard. 
� This clipboard is used for inserting graphic information within ARCHLine.XP® 

so after selecting the elements you always have to specify the reference 
point. 
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���� The program clipboard provides an effective way to copy any 3D view, 
section to a floor plan window. The drawing thus copied has no connection 
with the 3D model in the floor plan window. Consequently, editing becomes 
optional, the view and the section can be edited as required. With this 
option the program provides freedom for the designer. 

8.1.3.1. Cut - Ctrl X 

Move the selected elements to the clipboard. Erases the elements 
selected in the floor plan window. Retains the elements selected in the 3D 
window, so it has the same effect as the Copy command. 
 

• Select the elements to be moved. 
Enter  Ends the selection. 

• Specify the reference point of the selected elements. 

8.1.3.2. Copy - Ctrl C 

Copies the selected elements to the clipboard. The drawing copied to 
the program clipboard overwrites the drawing previously placed there. 
 

• Select the element you want to copy. 
Enter  Ends the selection. 

• Specify the reference points of the selected elements. 

8.1.3.3. Paste – Ctrl V 

Inserts the clipboard content by the reference point into the specified point. 

 
You can activate the command only if you have already placed elements on 
the clipboard. 
 
The element or elements can also be rotated as placed. To do so, choose the 
appropriate option: 

Options: 

Rotation angle… Specify the rotation angle in the form of a number 
Interactive rotation Specify the angle with its two sides 
Rotate and Transform Specify scaling and a rotation angle before placement 

 

���� The Ctrl + C  and the Ctrl + V  keyboard shortcuts are very useful when 
drawing in ARCHLine.XP®.  
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With the previously mentioned keyboard shortcuts it is possible to move a 
3D view to the floor plan window. The view (elevation, section, etc.) thus 
moved is no longer linked to the 3D model and becomes a 2D drawing, so it 
can be edited freely.  

8.1.4. Copy bitmap to clipboard 
When activating this command the program copies the drawing in the current 
window to the Windows clipboard in a picture file format. This way it is easy to 
insert the drawing as a picture e.g. into a Word document without exporting it 
in Metafile (.emf) format. 
 

���� In Windows use the Edit - Paste (Ctrl + V) command to paste. 
In ARCHLine.XP® uses the Edit menu Paste bitmap from Clipboard  command to 

paste the content of the Windows clipboard. 

8.1.5. Paste bitmap from clipboard 
Paste bitmap from Clipboard  command pastes the content of the Windows 
clipboard to the drawing as a picture. 

8.1.6. Snapshot 
Snapshot is a raster image that is taken in a 3D window.  
Snapshot enables you to create attractive coloured documentation of 
elevation views and floor plans. 
The Snapshot function helps you to move and calibrate a raster image into 
the 2D floor plan exactly in the right place and size.  
It is a special raster image that keeps the 3D model vertex points so you can 
precisely measure distances and angles on that 3D view raster image. 
 

 

 

Floor plan with Snapshot Wall view 
  

You can start the command from Edit menu when a 3D image window is 
active. It displays the following dialog. 
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Resolution 
The raster image resolution defines the document quality. You can choose 
as: 
 

� Same as window size 
The software captures a screen shot of your 3D active window to an image 
with the same resolution. 
 

� Custom size 
Choosing the custom size option you can select a predefined resolution from 
the drop-down list at the right, as the resolution for the image’s largest size. 
Choose a larger value to set the final result more detailed. Using larger 
values will make the project file size growing larger also. Please choose the 
size of the snapshot carefully, as you want your project not to grow too large, 
because handling larger projects could make workflow slower on some 
machines. Otherwise if you choose a small resolution, the final image may be 
pixelated which can make it less useful. Please choose from the drop-down 
list. 

Saving format 
You can choose the snapshot image’s file format from the drop-down list. 
This file format will be used during the process of the snapshot. Different file 
formats store images with different file size and quality conditions. Please 
select the desired file format. 
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Target drawing 
Select the target drawing where to insert the snapshot image. 

 

Save 
Use the Save button to save the snapshot image into an image file on your 
hard drive instead of a target drawing. Please specify the path and name of 
the file in the appearing Save as... dialog window. 

8.1.6.1. How to make a snapshot 

To create a snapshot of the 3D content you need to choose the 3D window 
that you want to use as the theme of the snapshot. (For example: a top view 
of the 3D model). 
 
As a second step you need to start Edit menu – Snapshot tool. In the 
appearing dialog window set the resolution for the snapshot image, set its 
format and please set the target drawing from the drop-down menu as well. 
When finished please press the OK button. 
 
The software will automatically create the snapshot image of the previously 
set 3D content, and it will be placed soon into the selected target drawing. 
The result of snapshot will be scaled.  
 

  
Top view of the 3D model (theme of 

the snapshot) 
 

Original 2D drawing (the drawing, 
which is set as the target) 
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Result - 2D drawing and Snapshot 
combined 

 
 

 
 

Wall elevation view snapshot tool 

This command makes a frontal view of the selected wall together with a part 
of the 3D model.  
 
You can select the wall and the visible wall side. 
The program makes visible the part of the 3D model that is inside the polygon 
limited by the wall endpoints and the visible part click point.  
 
You can edit these polygon nodes and when you press the ENTER button the 
3D partial model is created.  
 
The perpendicular view of the wall will be placed as an image onto the 
selected floor plan. 
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Here is an example of the result: 
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How to use the tool 

� Start the View menu / Section / Wall elevation view snapshot tool. 
Also you can use the Wall elevation view tool in the Documentation 
part of the left side Toolbox. 

� Choose the side where you would like to see the elevation from. 
� Edit the automatically recognized contour as you wish, if 

necessary. 
� Hit Enter 

Set the properties and click on OK. 

8.1.6.2. Snapshot and object snap 

Snapshot is able to copy and paste any 3D view into another 2D drawing in correct 
scaling, and it is also able to keep the reference points of the original 3D view. This 
will happen automatically when using the Snapshot tool.  
 
This way you can use snapshots as individual drawings too. The software will 
recognize the reference points of the snapshot, so for example you are able to place 
dimension on it. 
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Snapshot with dimensions 

 

8.1.6.3. Contour of a snapshot 

Contours of a snapshot equal to the contours of the original 3D view.  
 
This feature is great when you want to place some specific drawing or 2D group 
behind the snapshot.  
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2D group in front of a snapshot 
 

2D group behind a snapshot 
 

8.1.7. Move 
With Move you can move the selected elements, or with a complex 
transformation you can move, rotate and scale them in one step. 
With this transformation you can also copy elements. 
Transformation commands: 
 

� Move 
� Duplicate 
� Multiply 
� Multiply by matrix 

8.1.7.1. Move 

With the Edit - Move command you can carry out the following 
transformations: 
 

� You can move the selected elements, or 
� You can apply a multi transformation to the elements. To do so, click 

MULTITRANS  in the left side options menu. You can move the selected 
element by applying the move, rotate and scale transformations one after 
another. 

I) Move: 

• Select the desired elements. 
• Enter  Ends the selection. 
• Specify the reference point of the selected elements. 
• Specify the new place of the reference point. 
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II)) Multi transformation: 

If you choose MULTITRANS : 
• Select the desired elements. 

Enter  Ends the selection. 
• Specify the reference point of the selected elements. 
• Specify the new place of the reference point. The last specified point is also 

the rotation and scale centre, or 
Enter  If you do not want to move the selected element (displacement 

factor: 0). 
• Specify the rotation angle with the mouse, or 

Enter  If you do not want to move the selected element (angle: 0-
degree). 

• Specify a point with the mouse that defines the scale. The distance between 
the specified point and the scale centre of the transformation defines the 
scale factor. If the scale factor is << 1.0: the element is reduced, if the scale 
factor is >> 1.0: the element is enlarged. 
Enter  If you do not want to scale the selected element (scale 
factor: 1.0). 

Options: 

Rotation angle…  Specify the rotation angle in the form of a number 
Interactive rotation Specify the angle with its two sides 
Scaling… Specify the scale factor  
X Scale only in x direction  
Y Scale only in y direction  

8.1.7.2. Copy object 

With the Edit - Copy object  command you can carry out the following 
transformations: 
 

� You can copy the selected elements, or 
� Click REPEAT if you want to copy an element multiple times. 
� Choose MULTITRANS  in the More options menu. Thus you can move, rotate 

and scale the selected elements as moved. 

REPEAT: 

• Choose REPEAT in the More options menu. 
• Specify the number of copies. 
• Select the desired elements. 
• Enter  Ends the selection. 
• Specify the base point of displacement. 
• Specify the endpoint of displacement. 
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The program places the desired number of elements at the distance between 
the base point and the endpoint of displacement. 
 

� For a detailed description of this command see Chapter 8.1.5.1 on Move. 

8.1.7.3. Multiply 

With the Multiply -  icon in the Move toolbar menu you can place 
elements of a certain number at an equal distance from each other along the 
specified line. 
 
Suppose you want to place columns on a wall. You know the number of the 
columns and that there is an equal distance between them. However, you do 
not know exactly this distance. 
 

• Draw the wall and place the first column on it. 

• Choose the Multiply  -  command. 
• Select the element you want to multiply. Complete the selection with Enter. 
• Specify the number of copies. 
• Specify the base point of the distance you want to divide. (Specify the point of 

the first element that will touch - in the case of the last element - the endpoint 
of the distance you want to divide.) 

• Specify the other endpoint of the distance you want to divide. Before 
specifying the endpoint you can choose REPEAT in the More options menu if 
you want to change the number of copies. 

 

 

8.1.7.4. Array 

It copies a given object according to the given number of row and column.  
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• Start the Array tool.  
• Select the element, that you would like to multiply. Close the selection with 

Enter. 
• Set the starting point of the move.  
• Determine the array in the appearing dialog window. OK.  

 

 

I) Graphical 
It places a specific number of elements equidistant from each other on the 
selected grid.  
 

• Determine the place of the last element in the first row. So you can fix the 
divided distance, and also give the direction of the row.  

• Determine the place of the last element in the last row. So you can fix the 
divided distance. If the Column and row are perpendicular option is switch off, 
the given point determines the direction of columns too.  

II) Value 
It places a specific number of elements in the given distance (Shift horizontal 
and vertical) from each other on the selected grid.  
 

• Determine the direction of the matrix first row.   
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It places specific number objects in the given distance from each other in this 
direction by the line. The columns of the matrix are perpendicular to the rows.  

8.1.8. Rotate 
With this transformation you can rotate, or rotate and duplicate the selected 
elements. 
Rotate commands: 
 

� Rotate 
� Duplicate and rotate 

8.1.8.1. Rotate 

With the  Rotate icon in the Move toolbar menu you can rotate the 
selected elements. 
 

• Select the elements you want to rotate. 
• Specify the rotation angle. 
• Specify the rotation centre. 
• Enter  Completes the command. 

Options: 

Rotation angle… Specify the rotation angle in the form of a number. 
Interactive rotation Specify the angle with its two sides. 

8.1.8.2. Duplicate and rotate 

With the Duplicate and rotate  - icon in the Move toolbar menu  you can 
rotate and copy the selected elements. 
You can also make multiple copies. 

Option: 

REPEAT When making multiple copies, specify the number of 
copies. 

 

� For a detailed description of the command see Chapter 8.1.6.1 Rotate. 

8.1.9. Mirror 
Places or copies elements by applying mirror transformation. 
 
Two types of mirror transformation: 
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� Axial reflection 
� Point reflection 

 
Commands you can apply here:  

 

8.1.9.1. Mirror - Move 

With the Edit - Mirror - Move  command you can reflect the selected 
elements about a centre point or an axis. 
 

• Select the elements you want to move. 
• Enter  Ends the selection. 
• Specify the first point of the mirror axis. Ending the command with Enter, the 

program reflects the selected object about a centre point. 
• Specify the second point of the mirror axis. The program reflects the selected 

element about an axis. 

Option: 

On selected item The highlighted line is the mirror axis, and the highlighted 
point is the mirror centre. 

8.1.9.2. Mirror - Duplicate 

With the Edit -  Mirror - Duplicate  command you can mirror the selected 
elements to a centre or an axis and copy them. 
 

� For a detailed description of the command see Chapter 8.1.7.1 on Mirror - 
Move. 

8.1.10. Scale 
Enlarges or multiplies the elements. 
 
Commands that you can apply here:  
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8.1.10.1. Scale - Move 

With the Edit -  Scale - Move  command you can enlarge/reduce the 
selected elements. 
 

• Select the elements you want to enlarge. 
• Enter  accepts the selected elements. 
• Specify the scale centre. 
• With the mouse specify a point that defines the scale factor. The distance 

between the specified point and the scale centre defines the scale factor. 
This factor is indicated by the mouse pointer info tooltip. 
Choose Scaling  in the More options menu if you want to specify the scale 
factor. 
A scale factor less than 1 reduces the elements. A scale factor greater than 1 
enlarges the elements. 

Options: 

Scaling… Specify the scale factor 
X Scale only in x direction 
Y Scale only in y direction 

8.1.10.2. Scale - Duplicate 

With the Edit -  Scale - Duplicate  command you can enlarge/reduce the 
selected elements. You can also multiply the copies. 

Option: 

REPEAT When making multiple copies, specify the number of 
copies. 

 

� For a detailed description of the command see Chapter.8.1.8.1 on Scale - 
Move. 

8.1.11. Delete single (Ctrl + D) 
Deletes the selected elements in the current drawing one by one. 

 
• Start the tool. 
• Click the element you want to delete. 
• Select further elements to be deleted, or 

Enter  Ends the command. 
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!  All elements associated with the selected element are also deleted. (For 
example, if you assigned dimension to an element, when deleting the 
element, the dimension lines are also deleted.) 
 
If you delete an element in the 3D window, the Select a surface  option 
appears in the More options menu. With this keyword you can delete the 
patterns placed on the surface of the solid (2D group) 

���� You can activate the command in the following ways: 

� By clicking the Delete -  icon in the Edit toolbar, or 
� In the Shortcut menu of each element as well. In this case right-click the 

element. 
� If the mouse pointer is an arrow shape: hold the Ctrl  key and click an 

element, then the entire element is deleted (only with specific s ettings in 
File menu – Preferences – General / Marker settings  – Special shortcut) . 

� If you click an element in the drawing and press the Del key, the program 
deletes the entire element . 

8.1.12. Delete 
With the commands in the Edit - Delete menu item you can delete the 
elements or the specified part of the elements in the current drawing. 
The menu item contains the following commands: 
 

 
 

���� The Delete, Select, Delete area, Delete all instructions can be applied to all 
element types.  
The other delete instructions can only be applied to geometric elements, but 
not to architectural ones. Thus, for example, with the Delete between points 
command it is not possible to delete the part between the two intersections 
of the wall. 
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8.1.12.1. Delete between  points  

The program enables you to delete the section of an element between the 
intersections (or endpoints) nearest to the selected point. If the element does 
not have or has only one intersection with other elements, this command 
corresponds to the delete operation. 
 

• Select the element to be deleted between its nearest intersections. The 
program immediately deletes that part of the element. 

• Repeat the previous step if you want to delete further parts of the element, or 
Enter  Ends the command. 
 

���� You can activate the command in the following ways: 

� By clicking the Delete between intersections  -  icon in the Edit toolbar. 
� When the mouse pointer is an arrow shape: hold the Ctrl  and Shift  keys and 

click an element, and then the program deletes the section of the element 
that is between the intersections. 

8.1.12.2. Partial delete 

Deletes the section of the 
element between the selected 
points. 
 

• Select the base point of the 
line you want to delete: Point 1 

• Select the endpoint of the line 
you want to delete: Point 2 

• Select further lines to be 
deleted, or  
Enter  Ends the 

command. 
 

 

 

���� The Partial Delete can be applied to dimension projection lines as well.  

8.1.12.3. Delete selected 

Deletes the selected elements in the current drawing. 
 

• Select the elements to be deleted. 
Enter  Ends the selection and deletes the elements. 

• Repeat the previous step if you want to delete further elements, or 
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Enter  Ends the command. 
 

���� To select a group of elements you can apply the commands in the Status 
bar - Selection  menu. 
 

���� You can also activate the command with the Delete selected  -  icon in 
the Edit toolbar . 

8.1.12.4. Cut rectangle 

With this command you can delete elements in the following ways: 
 

� You can delete the elements or their sections that are inside a specified 
rectangle or area. 

� Before deleting you can pre-select the elements on which the deletion will be 
carried out. 
 
If an element is not entirely enclosed by the rectangle or area, only its section 
inside the rectangle or area is deleted. The contour of the selection area is 
shown by broken line. 

Deletes all elements or all sections of an element inside a specified rectangle: 

• Specify the first point of the selection window. 
• Specify the other point of the selection window. 
• Repeat the command, or 

Enter  Ends the command. 

 

Deletes all elements or all sections of an element inside a specified area: 

• Choose POLYGON in the More options menu. 
• Define the polygon within which you delete all elements or all sections of an 

element. 
• Enter  Completes the definition of the polygon, and the program executes 

the deletion. 
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Deletes all elements or element sections inside a s pecified area, but you can 
select the elements on which deletion will be carri ed out: 

• Choose PRESELECT in the More options menu. 
• Select the elements the deletion will be applied to. 
• Specify the polyline that is necessary for the deletion. 
• Enter  Completes the definition of the polyline, and the program executes 

the deletion. 
 

���� If you specified an open polyline, the program automatically connects the 
first and the last point of the polyline to create a closed polyline (polygon). 

8.1.12.5. Cut polygon 

Deletes all elements or all sections of an element inside a specified area. 
If an element is not entirely enclosed by the area, only its section inside the 
area is deleted. The contour of the selection area is shown by broken line. 
 

• Define the polygon within which you delete all elements or all sections of an 
element. 

• Enter  Completes the definition of the polygon, and the program executes 
the deletion. 

Options: 

Circle The selection area is a circle  
Parallel shifted… Before defining the polygon specify the offset value. It 

means that the area will be an area enclosed by the 
contour of the reference point enlarged or reduced by 
offsetting. 

Width… The selection area is a polyline with a specified width. 
 

Arc The next element of the polyline is an arc.  
Select an item The next element of the polyline is an existing element.  
Spline The next element of the polyline is a spline. 

 

8.1.12.6. Area 

The command deletes the elements that are entirely inside the selection 
area. The contour of the selection area is shown by broken line. After closing 
the selection area you can select the elements to be deleted one by one. 
 

• Specify the polyline necessary for deletion. 
• Enter  Completes the definition of the polyline. 
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• Select the elements the deletion will be applied to. 
• Enter  Ends the selection, 
• Enter The program executes the deletion. 

 

� For a detailed description of the options see the previous instruction, 
8.1.10.5. Cut polygon 

8.1.12.7. All 

Deletes all elements in the current drawing. 

8.1.13. Stretch 
The Edit - Stretch  command stretches the sections of an element that are 
completely inside a selection area. 
 

� If the element is a single line or a segment of a polyline, the program moves 
its endpoints only, and connects them again with a straight line. 

� The ’curves’ (circle, arc, ellipse, elliptic arc, splines) intersected by the area 
are cut at the intersection. The instruction connects the intersections with a 
straight line at the same time retaining the geometrical relations. 

� All hatchings and dimensions assigned to the element follow the changes of 
the stretched element. 

� In addition to the geometric elements the command is also valid for the wall 
and the slab. After stretching the wall connections are restored. 

 
You can specify the area in the following ways: 
 

� By selection rectangle or 
� With the Polygon  option. 
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Window 

• Specify the corner point of the window. 
• Specify the other corner point of the window. 
• Specify the start point of the offset vector. 
• Specify the endpoint of the offset vector. 

Area 

• Choose Polygon  in the More options menu. 
• Specify a chain of lines and arcs. Enter. 
• Specify the start point of the offset vector. 
• Specify the endpoint of the offset vector. 

Enter  Ends the command. 
 

� For a detailed description of the options of Polygon  see the instruction 
8.1.12.5 Delete – Cut polygon. 

8.1.14. Offset 

With the Edit -  Offset  command you can create a contour around the 
selected element at a specified distance. The contour of lines, polylines, arcs 
and splines retains its original type during the offset transformation, while 
circles are transformed into arcs, and the contour of ellipses and elliptic arcs 
into splines. 
 

• When you activate the command, the Offset  dialog box is displayed: 
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Offset type 
• Select the desired offset type by clicking the button or the icon: 

 
Offset 1  

 
Offsets the drawing of the profile 
(chain of one or more elements) at a 
specified distance from the selected 
elements. 
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Offset 2  

 
Offsets the drawing of the profile 
(chain of one or more elements) at a 
specified distance from the selected 
elements. Should the new profile 
become geometrically distorted, the 
program rounds the corners off. 

 

Select mode 
• Specify the select mode: 

 
Select one by one 
Select chain 
Opened chain 
Opened chain one by one 

Select one by one 
You must select the components of the closed chain one by one. 

Select chain 
Just select a segment of the closed chain. The program automatically starts 
searching for the chain. If the search is successful, the contour appears. 

Opened chain 
You can specify the open chain by clicking near one of its endpoints. 
You can specify a segment of the chain by selecting any part of it (except its 
endpoint). Then you can choose the chain starting from the selected element 
to the endpoint that is farther from the centre of the selected element. 

Opened chain one by one 
You can also specify the contour of the open chain by selecting the chain 
segments one after another. 

Offset distance 
Offset distance: distance of the new contour from the selected elements. 
After closing the Offset dialog box, the program asks you to specify the offset 
distance: 

• Drag the mouse pointer to the direction where you want to create the offset. 
Enter the offset value.  
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8.1.15. Trim 
With the options in the Edit menu - Trim  command, you can trim elements 
by trimming or extending them, so that their endpoints closest to the selected 
points coincide. 
Select a subcommand: 
 

 

8.1.15.1. Both objects 

Trims the two elements by trimming or extending them. Adjustment involves 
the intersection closest to your selection. 
 

• Select the first element you wish to trim. 
• Select the second element you want to trim. 

Enter  Completes the command. 

 

���� You may also activate the command with the Edit toolbar - Trim both 
elements icon. The command can be used for walls and corresponds to the 
L connection. 

8.1.15.2. First object - CTRL + F 

The command trims (or extends) the unnecessary section (missing section) of 
the first selected element compared with its intersection with the second 
element. 
Adjustment concerns the intersection nearest the selected section. 
The second selected element only helps selection and is not modified with 
this command, just as the other endpoint of the first element is left intact. 
 

• Select the element you want to trim. 
• Choose the element you want the first element to intersect with. 

Enter  Completes the command. 
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���� You may also activate the command with the Edit toolbar -  Trim first 
element icon. The command can be used for walls; it corresponds to the T 
connection. 

8.1.15.3. Multiple 

The command trims all subsequently selected elements to the first defined 
element.  
It trims or extends that section of the elements you define after the first 
selected element, which is closer to the intersection. 
The first selected element and the other endpoints of the specified elements 
are not modified with this command. 
 

• Define the element to which you wish to adjust the elements selected 
subsequently. 

• Specify the elements you want to adjust. 
Hit Enter  Completes the command. 

 

8.1.15.4. All 

Trims to the segments all elements falling between the two given bordering 
segments. This means that the elements are trimmed or extended to their 
intersection with the adjacent segments. 
 

• Select the first line to which you wish to adjust the elements. 
• Select the second reference line. 

Hit Enter  Completes the command. 
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8.1.16. Break 
Breaks the elements at a point defined with another element. Using this 
command, you can split an element in two separate parts. 
The program transforms circles into arcs, and ellipses into elliptical arcs. 
Choose a subcommand: 
 

 

8.1.16.1. Break first object 

Breaks the first selected element in two new elements at the point where it 
intersects the second (reference) element closest to selection. The command 
does not break the second element. 
 

• Choose the element you want to break. 
• Choose the element that intersects the first element. 

Hit Enter  Completes the command. 

8.1.16.2. Break both objects 

Breaks both selected elements in two new elements at their intersection 
closest to selection. 
 

• Choose the element you want to break. 
• Choose the second element you want to break. 

Hit Enter  Completes the command. 



416 8.1 General editing commands  

Manual 

8.1.16.3. By cutting edge 

You can break the selected elements with the help of an imaginary reference 
line. 
The cutting points will be at their intersections with the reference element. 
 

• Define the start point of the cutting edge. 
• Define the endpoint of the cutting edge. 
• Select the element to be break at its nearest intersection. 

Hit Enter  to end selection. 
Hit Enter  Completes the command. 

8.1.16.4. Between two objects 

By using this command, you can break the element at its two intersections 
closest to a surrounding selection. 
 

• Select the element you want to break between two intersections. 
Hit Enter  Completes the command. 

8.1.17. Lengthen 
You can modify the length, radius, endpoint and resolution of the elements 
with this command. 
Select a subcommand: 
 

 

8.1.17.1. Length by number - CTRL+N 

With this command you can alter the length of a selected element (segment, 
arc, elliptical arc) by moving its endpoint closest to selection and specifying 
the new value in the form of a number. 
 

• Select a line, arc or elliptical arc. 
The Length modification  dialog box appears displaying the current value of 
length. 
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Choose an option and define the new value. 
 

Absolute Specifies the length of the element. 
Relative Specifies by what value the length of the element should be 

increased/decreased. 
 
OK Completes the command. 

8.1.17.2. Lengthen by cursor - CTRL+L 

You can alter the length of the selected line, arc or elliptical arc by moving 
one of its endpoints to the desired place without changing its direction. With 
circles you can graphically modify the radius, whereas with ellipses the minor 
and the major axes. 
 

• Select the endpoint of the line segment, arc or elliptical arc along which you 
move the element. (The endpoint closest to selection will be moved.) 

• Define the new place of the endpoint graphically. Using the expand line 
departing from the endpoint, you can move the specified endpoint to its new 
place, or 
 

Option: 
Beam Extends the selected beam. 

 
Hit Enter  to complete the command. 
 

���� Once you select the element, you may also modify its length or radius with 
the hotspots. See the Tools -2.1.2 Clicking with the left mouse button 
Chapter. 
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8.1.17.3. Relocate endpoint 

You can modify the selected line segment, arc or elliptical arc by moving one 
of its endpoints to the desired place. 
 

• Select a line segment, arc or elliptical arc. 
• Move the endpoint closest to selection. Specify its new position. Using the 

expand line departing from the other endpoint of the element; you can move 
the selected endpoint. 
Enter  Ends the command. 

8.1.17.4. Convert spline to arcs 

With this command you can alter the resolution of arched elements. The 
value defined for resolution specifies how many linear segments a polyline 
representing circles or ellipses should consist of. 
 

• Specify the value of resolution. 
• Select the elements the resolution of which you want to modify. 

Enter Ends the command. 
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8.2. Main axis markers for 3D move 
With the effective usage of 3D technology ARCHLine.XP® makes the 
operations in the model space easy by interactive 3D cursors. 
 

 
 
When selecting a 3D element, the program shows the main axis for moving 
operations. With the help of these markers you can move the selected 
element in the space easily along the main axes. Each axis has different 
colour representation. The horizontal X axis is represented by green, the 
horizontal Y axis is represented by red, and the vertical Y axis is represented 
by blue colour. 

How to use 
Clicking one of the main axes starts the movement along the axis. You can 
set the new position by moving the mouse cursor to the desired point and 
then clicking again. 

 
You can see possible overlaps while moving the mouse 
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8.3. Specifying profile 
When applying more commands to 
create or modify elements it is necessary 
to edit profile. 
For example, profiles are used when 
specifying the contour to be cut into the 
wall or slab, when defining the slab, roof 
with a contour or when creating a terrain. 
 

� When a command is waiting for the 
specifying a profile, the Profile 
definitions  tool appears the commands 
of which can be used for specifying the 
profile. To close the Profile definitions 
tool, use the first icon, the Enter icon. 

 

 

8.3.1. Polygon 
Creates a polygon that can be used as a profile. 
 

• Specify the polygon as a chain of lines and arcs. 
Enter  Closes the polygon. 

Options: 

Arc The next element of the polyline is an arc.  
Select an item The next element of the polyline is an existing element.  
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Smooth The next element of the polyline is tangential to the 
previous element. 

8.3.2. Rectangle 
Creates a rectangle that can be used as a profile. 
 

• Specify the first corner of the rectangle. 
• Specify another point of the rectangle’s base line, or 
• Specify the corner opposite to the first corner of the rectangle. 

Options: 

Width… Creates the rectangle with a specified width. 
Define rectangle 
X/y size… 

Creates the rectangle with a specified width and height  

� See the description of the Polyline drawing commands -  General 
rectangle in Chapter 11.3.2. 

8.3.3. Rectangle HV 
Creates a rectangle that can be used as a profile. The sides of the rectangle 
are horizontal and vertical.  
 

• Specify the first corner of the rectangle.  
• Specify the opposite corner of the rectangle. 

8.3.4. Circle 
Creates a circle that can be used as a profile. 
 

• Specify the centre point of the circle, or 
use the Devise 3 points, Axis  keywords. 

8.3.5. Point of profile 
This command makes a profile from the closed polyline created in the active 
window. Just click inside the polyline and the program will search for the 
closed chain. 
 

• Specify an internal point of the profile. 

8.3.6. Point of profile and islands 
This command makes a profile from the closed polyline created in the active 
window by searching for the islands inside the closed chain. 
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• Specify an internal point of the profile. 

8.3.7. Chain one by one 
This command creates a profile from a closed polyline by selecting its 
segments one by one. 
 

• Select the sides of the profile one by one. 
Enter  Ends the selection. 

8.3.8. Make island by offset 
This command creates an island inside the specified closed chain by 
offsetting the contour with the defined offset value. 
 

• Specify the external profile. To do so, you can use the Profile definitions tool. 
• Define the offset value. If the value is negative, the program creates an island 

inside the contour. If the value is positive, the offset is produced outside, thus 
the original contour will be the island. 
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8.3.9. Editable profile 
When modifying architectural 
elements, you may need to edit the 
geometry of a formerly created 
profile. 
 

� When you use a profile editing 
command, in the Toolbar the Edit 
profile tool pops up whose commands 
can be applied for editing the profile. 
Use the first, Enter icon to close the 
Edit profile tool. 
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Add node 
Inserts a new node between the nodes closest to where you click in the 
contour. 
 

• Select the section of the profile where you wish to insert the new node. 
• Define the place of the new node in the drawing. 
• You can repeat the command, or 

Enter  Completes the insert node command. 

Move node 
Moves the selected node of the contour.  
 

• Select the node of the contour you wish to move. 
• Define the new place of the node.  
• You can repeat the command by selecting a new node, or 

Enter  Completes the move node command. 

Lengthen a part 
The program recognizes the direction of the selected section of the contour 
line. By entering the value of modification (relative length) you increase or 
decrease the length of the selected section by that value. 

Parallel shift 
You can shift the selected edge by a given distance. You may shift all edges 
of the contour line in one step. This function is useful for example, in the case 
of slabs, when the floor plan of the slab needs to be enlarged or reduced in 
all directions. 
 

• Select a section of the contour to shift. 
• Define the new place of the selected contour section. 
• Choose the next section of the contour, or 

Hit Enter  to end command. 

Option: 

ALL  Shifts all edges of the contour line. 
Only for slab editing. 

Delete node 
The command deletes the selected nodes of the contour line. The program 
deletes the node closest to your selection together with the segments setting 
out of the node. The endpoints of the deleted segments are connected by a 
new line. 
 

• Choose the nodes of the profile you wish to delete, then 
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Hit Enter  to end command. 

Delete part 
Deletes the selected section of the contour if the two adjacent sections are 
not parallel straight segments. The command lengthens the bordering 
segments of the deleted section till they intersect. 
 

• Choose the sections of the profile you wish to delete one by one, then 
Hit Enter  to complete the delete section command. 

Fillet 
Rounds off the selected or all possible corners of the profile by the defined 
radius. 
 

• Define the radius of rounding. 
• Select the corner you wish to round off. 
• You can repeat the command, or 

Hit Enter  to end the round off corner command. 

Option: 

ALL  Rounds off all possible corners. 

Arc ���� Line 
The command converts an arc contour line into a straight line. 
 

• Select the arc segments you wish to convert into straight lines. 
Enter  Completes the command. 

Line ���� Arc 
Converts a straight contour line into an arc, or modifies the radius of an 
existing arc segment. 
 

• Select the section of the contour you wish to convert into an arc or the radius 
of which you want to modify. 

• Define the arc by specifying an internal point, or 
Choose from the following keywords: 

Options: 

Diameter Value of the diameter 
Radius Value of the radius 
Perimeter Value of the perimeter (arc length) 
Arc Value of the chord height of the arc 

 
• Specify the desired value. 
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The command draws the arc nearest the cursor instead of other possible 
arcs. 
If you specify a diameter longer than the distance between the endpoints, you 
have four possible arcs to create. 
If you specify a diameter equalling the distance between the endpoints, you 
have two possible arcs to create. 
If you specify a diameter shorter than the distance between the endpoints, 
you will not be able to create an arc. 

• Select the appropriate arc. 
• You can repeat the command, or 

Hit Enter  to end command. 

Add Polygon 
You can edit the polylines and polygons in a profile with the commands under 
the Polygon command: 
 
New 
Delete 
Move 
Rotate 
Mirror 
Scale 

Undo 
Undoes the last operation when modifying the profile. 

Redo 
If you undid an operation using the Undo  command when modifying the 
profile, you can repeat it with the Redo command. 
 

!!!! The Undo and Redo commands in the Edit menu do not correspond to the 
Undo and Redo commands used when modifying the profile. 

Insert profile in drawing 
The requested or modified profile can be placed on the drawing with this 
command. 

8.3.10. Select from list 
Profiles are grouped into different categories of the profile directory. 
With this command you can choose a predefined profile from the appropriate 
category of the profile directory. 
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• Choose the desired profile category and type from the list; the shape of the 

selected profile and the list of its geometrical characteristics appear. You can 
modify the values; after modification press Redraw  to update the drawing 
area of the dialog box. 

• To place, activate the desired reference point.  
The eligible reference points are shown by small squares in the drawing area 
that can be activated by clicking. The active reference point is red while the 
others are green.  

• Use the Mirror  and Rotate  buttons for the optimal setting of the profile. 
OK Closes the dialog box. 
 
The profile directory can be extended with closed and open profiles. To do so, 
use the Building menu – Accessories – Define closed profile or Define open 
profile instructions.  

� For the description see Chapter 9.10.5 on Creating profiles. 

8.3.11. Select item 
It applies the contour of the closed element or the hatching in the drawing as 
a profile. 
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8.3.12. Surface of solid 
The profile will be the contour of one of the surfaces of the solid. 
 

• Select a surface of the solid near the edge (inside the surface). 

8.3.13. Transformed profile 
This command transforms a defined profile with the 3D transformations. You 
can apply this option when using the 3D solid modeller. 
 

• Specify the profile with the Profile definitions tool  
• Choose the desired transformation from the 3D transformations pop menu.  

8.3.14. Last value 
The selected profile is the last defined profile (if any).  

8.3.15. Select connected lines 
With this command you can select the connected lines of a profile without 
having all nodes being specified one by one. If a profile consists of more 
chains, select the single elements of the profile. 

8.3.16. Room selection 
You can select a room the contour of which you wish to use as a profile.  
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8.4. Modification 
You can modify both the properties and the geometry of the created 
elements. 

Modifying properties 
Some opportunities to modify the properties are available from the Modify 
menu. But the modification of any element is available with the Properties  
command from the Shortcut menu or in the Property manager. 

Modifying geometry  
The geometry modifying commands are available as follows: 
 

� Click on the appropriate icon in the Toolbox or the Main menu , or 
� Right click on the element from the Shortcut menu. 
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8.5. Specifying properties 
Before you create any element, you can set the properties of the element in 
the Properties dialog box. You can activate the dialog box in several ways: 
 

� With the Building menu - Properties  commands, or 
� With the Drafting menu - Properties  commands, or 
� With the Dimension menu - Properties  commands, or 
� Right-click on the icon of the element in the Toolbox  tool. 

 
Here you can specify the global properties that will be associated with all 
corresponding element types created subsequently. 
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8.6. Modifying properties 
You can modify the properties of elements already created in the following 
ways: 
 

� One by one, by selecting the desired property in the Shortcut menu - 
Properties dialog box. 

� By copying the properties of a reference element with the Modify menu - 
Copy properties command. 

� Using the Property manager , see the Chapter 2.5 
� With the Modify menu – Create similar command it is possible to create new 

elements, using the properties of an element already created.  
� In the Substitute material dialog the he selected texture can be changed to 

the desired one in all the elements in the plan. 
� You can modify the material of the elements using the Design center.  

8.6.1. Modifying the properties of certain elements  
You can modify the properties of certain elements if you: 
 

� The Property Manager visualizes the properties of the selected objects and 
modify its values  

� Right-click the element, then select Shortcut menu - Properties. 
� Select the item and click on the Properties marker. 

 
When the Properties dialog box displayed you can specify properties that will 
be assigned only to the selected element. 
 

� You can find the detailed the specification and modification of the properties 
of each element type in the corresponding chapters. 

8.6.2. Copy properties 
With the Copy properties command you may also modify the properties of 
an element group if you copy all or certain properties of a selected element to 
a group of elements. 
 
You can activate the command: 
 

� In the Modify menu, 
� Right-click the element, then selecting the Copy properties option in the 

Shortcut menu displayed, or 

�  With the Copy properties icon -  in the Edit toolbar. 
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• Activate the command, and 
• Choose an element the properties of which you wish to copy, or select the 

option corresponding to the desired element type in the command line if 
selection is ambiguous, that is when elements overlap. 

• Select the desired properties in the Properties dialog box. E.g. in the case of 
wall the following dialog box appears: 

• By clicking the checkbox in front of a property you can turn that property on 
and off. If you click the box in the heading you can turn all properties on and 
off. 
The program assigns only those properties to the selected elements that 
have been selected. 

• You can decide whether you copy the parameters (which may contain 
important data for quantity calculation) assigned to the element. 
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• Select the elements you wish to modify. 

Enter  Completes the command. 
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In case of objects you can copy properties between floors as well.  
For this please select the Go to: Lower floor  or Go to: Upper floor  keyword 
from the More options menu. 

Options: 

Go to: Lower 
floor 

The software activates the following lower floor if there is any. 

Go to: Upper 
floor 

The software activates the following upper floor if there is any. 

 

���� In case of object if the “Name” option is switched on, the objects to be 
modified will inherit the object type as well. 

8.6.3. Create similar 
You can create a new element with the properties of an existing element by 
using the Modify menu - Create similar command. 
 
You can activate the command: 
 

� In the Modify menu  or, 
� By right-clicking the element and selecting the Create Similar… option in the 

Shortcut menu displayed. 
 

• Activate the Modify menu - Create similar  command. 
• Select an element to open its property list. 

 
The program reads the properties of the selected element and enters the 
create element command. The element drawn subsequently will have the 
properties of the selected element. 
 
If for example you select a wall to read its properties, the program offers the 
Create wall  command. 

8.6.4. Lock architectural object in 3D 
With this command you can lock 3D models to architectural elements (the 
architectural elements in the Building tool from wall to object) independent of 
their 2D symbol. This way you can easily create detailed drawings, such as 
decorated walls, without displaying their details on the 2D drawing. Once you 
lock an architectural element, you may make any modification in the 2D 
drawing; its 3D view will not be altered. 
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���� We suggest that you only decorate walls and use the Lock in 3D mode 
when you have completed the construction of the building structure. In this 
case you will not have to make frequent modifications. 
 
The commands are the following: 
 

 

8.6.4.1. Lock shape 

Example: 
You can create a wall with its foundation without displaying the foundation in 
the 2D view. You can see how this command works in the following example: 
 

• Draw a wall with its foundation. To create a foundation draw a wall with the 
following parameters for example: 
wall thickness: 0.05 m, 
height: 0.6 m, 
wall material: stone-2 
 

• Select the Lock architectural element in 
3D - Lock shape  command. Choose an 
architectural element (the wall in the model), 
to which you want to attach additional 
objects and whose 3D model you wish to 
lock. 

• Select the additional objects for locking their 
3D model. 
(Select foundation.) 
Enter  Completes selection. 

 
 

���� Once you locked an architectural element’s 3D model, the 3D fixed  option 
is activated in the properties dialog box of the object. 
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The 3D view of the wall with foundation is 
now locked. From this time on you can 
delete the 2D view of the wall, its 3D view 
will not change. 
For example, if you place a window on the 
wall, the window will only be displayed on the 
2D symbol of the wall. In the 3D view the 
window will only be indicated by the 
wireframe model, as the 3D model of the 
wall has been locked. 

 
 

 

���� If you wish to display the new shape of the wall (with the window), you have 
to use the Lock architectural element in 3D - Unlock commands under 3D 
menu - Architectural element ->3D solid. 

8.6.4.2. Unlock 

With this command you can unlock the selected objects, and work with them 
as ordinary architectural elements. 
 

• Select an architectural element the 3D view of which you want to unlock. 
 

���� The 3D fixed  option is deactivated in the Properties  dialog box. 
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In this case select the wall to unlock its 
solid 3D view. The program now 
displays the wall with the inserted 
window. 
 

 
 
We suggest you that before unlocking use the 3D menu – Arch. object -> 3D 
solid command, thus the 3D model of the foundation will be saved. 
Repeat the Lock shape command for the wall and the foundation to save the 
new layout of the wall. (If you regenerate the wall without using this 
command, you will lose the foundation.) 

8.6.5. Substitute material 
With the Modify - Substitute material command you change the selected 
texture of each element of the drawing to the one you specify. This concerns 
all architectural elements of a drawing and involves all floors. 
 
When you activate the command the Material  dialog box appears. 

• Select the material category you wish to replace. Click Select . 
• In the dialog box then displayed select the new material. Click Select . 

8.6.5.1. Substitute materials using the Design cent er 

By using the Design center you can modify the material of selected elements 
in an instant without activating the Properties dialog box and browsing in the 
Select by element dialog box. 
Using the Design center you can modify the material of elements on the floor 
plan and in the 3D view in different ways. 

Modifying materials on the floor plan 

!  You can use this command for all architectural elements except doors and 
windows. 
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You find the materials 
applied in the program 
arranged in classes and 
categories in the Materials 
directory of the Design 
center. 
 

• Open the desired category, 
e.g. Program Materials 
class - Colours. The 
program displays all 
materials within that 
category. 

 
 

• Click the name/picture of the texture with the left mouse button. 
• While holding the mouse button, drag the texture on the element you wish to 

modify. 
• Once the texture is on the element, release the mouse button. 

 

 
• In the menu then displayed 

choose the option you wish. 
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Modifying materials in 3D 
The command changes the texture selected with a plane of the model to the 
material you choose in the Design center. 
 

• Select the desired material in the appropriate material category, and then 
click its name/picture with the left mouse button. 

• While holding the mouse button grab the texture over the plane to which you 
assigned the texture you wish to modify. 

• Click the requested plane. The program then selects the plane. 
 
The program automatically opens a menu and you can choose an option. 
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8.7. Explode 
Using the two additional commands in the Modify menu, you can break down 
elements to their components. 

8.7.1. Explode by selection 
You can explode compound elements (such as text, dimension, hatch, groups 
and architectural elements) into their components. 
 
Explode what element  into what elements  
Text Line, elliptical arc, spline, hatch 
Dimension Line, text 
Hatch Line 
Group Elements it contains 
Architectural elements Graphical components or subgroups 
 
You can explode elements in the following way: 

 
• Select the compound elements you wish to explode. 
• Choose the Modify menu - Explode by selection command. 
• Select the next element, or 
• Enter  Completes the command. 

Option : 

Text Explodes the selected multiline texts into multiple single-line 
texts. 

8.7.2. Explode  
• In the displayed dialog box click on a class to explode all elements in the 

selected class. 
• Click OK. 

 
The program explodes the selected elements. 


